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Rechtliche Hinweise
Warnhinweiskonzept

Dieses Handbuch enthält Hinweise, die Sie zu Ihrer persönlichen Sicherheit sowie zur Vermeidung von 
Sachschäden beachten müssen. Die Hinweise zu Ihrer persönlichen Sicherheit sind durch ein Warndreieck 
hervorgehoben, Hinweise zu alleinigen Sachschäden stehen ohne Warndreieck. Je nach Gefährdungsstufe werden 
die Warnhinweise in abnehmender Reihenfolge wie folgt dargestellt.

GEFAHR
bedeutet, dass Tod oder schwere Körperverletzung eintreten wird, wenn die entsprechenden 
Vorsichtsmaßnahmen nicht getroffen werden.

WARNUNG
bedeutet, dass Tod oder schwere Körperverletzung eintreten kann, wenn die entsprechenden 
Vorsichtsmaßnahmen nicht getroffen werden.

VORSICHT
bedeutet, dass eine leichte Körperverletzung eintreten kann, wenn die entsprechenden Vorsichtsmaßnahmen nicht 
getroffen werden.

ACHTUNG
bedeutet, dass Sachschaden eintreten kann, wenn die entsprechenden Vorsichtsmaßnahmen nicht getroffen 
werden.
Beim Auftreten mehrerer Gefährdungsstufen wird immer der Warnhinweis zur jeweils höchsten Stufe verwendet. 
Wenn in einem Warnhinweis mit dem Warndreieck vor Personenschäden gewarnt wird, dann kann im selben 
Warnhinweis zusätzlich eine Warnung vor Sachschäden angefügt sein.

Qualifiziertes Personal
Das zu dieser Dokumentation zugehörige Produkt/System darf nur von für die jeweilige Aufgabenstellung 
qualifiziertem Personal gehandhabt werden unter Beachtung der für die jeweilige Aufgabenstellung zugehörigen 
Dokumentation, insbesondere der darin enthaltenen Sicherheits- und Warnhinweise. Qualifiziertes Personal ist auf 
Grund seiner Ausbildung und Erfahrung befähigt, im Umgang mit diesen Produkten/Systemen Risiken zu erkennen 
und mögliche Gefährdungen zu vermeiden.

Bestimmungsgemäßer Gebrauch von Siemens-Produkten
Beachten Sie Folgendes:

WARNUNG
Siemens-Produkte dürfen nur für die im Katalog und in der zugehörigen technischen Dokumentation vorgesehenen 
Einsatzfälle verwendet werden. Falls Fremdprodukte und -komponenten zum Einsatz kommen, müssen diese von 
Siemens empfohlen bzw. zugelassen sein. Der einwandfreie und sichere Betrieb der Produkte setzt sachgemäßen 
Transport, sachgemäße Lagerung, Aufstellung, Montage, Installation, Inbetriebnahme, Bedienung und 
Instandhaltung voraus. Die zulässigen Umgebungsbedingungen müssen eingehalten werden. Hinweise in den 
zugehörigen Dokumentationen müssen beachtet werden.

Marken
Alle mit dem Schutzrechtsvermerk ® gekennzeichneten Bezeichnungen sind eingetragene Marken der 
Siemens AG. Die übrigen Bezeichnungen in dieser Schrift können Marken sein, deren Benutzung durch Dritte für 
deren Zwecke die Rechte der Inhaber verletzen kann.
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Security-Hinweise 1
Siemens bietet Produkte und Lösungen mit Industrial Security-Funktionen an, die den sicheren 
Betrieb von Anlagen, Systemen, Maschinen und Netzwerken unterstützen.

Um Anlagen, Systeme, Maschinen und Netzwerke gegen Cyber-Bedrohungen zu sichern, ist 
es erforderlich, ein ganzheitliches Industrial Security-Konzept zu implementieren (und 
kontinuierlich aufrechtzuerhalten), das dem aktuellen Stand der Technik entspricht. Die 
Produkte und Lösungen von Siemens formen einen Bestandteil eines solchen Konzepts.

Die Kunden sind dafür verantwortlich, unbefugten Zugriff auf ihre Anlagen, Systeme, 
Maschinen und Netzwerke zu verhindern. Diese Systeme, Maschinen und Komponenten 
sollten nur mit dem Unternehmensnetzwerk oder dem Internet verbunden werden, wenn und 
soweit dies notwendig ist und nur wenn entsprechende Schutzmaßnahmen (z.B. Firewalls und/
oder Netzwerksegmentierung) ergriffen wurden.

Weiterführende Informationen zu möglichen Schutzmaßnahmen im Bereich Industrial Security 
finden Sie unter:
https://www.siemens.com/industrialsecurity

Die Produkte und Lösungen von Siemens werden ständig weiterentwickelt, um sie noch 
sicherer zu machen. Siemens empfiehlt ausdrücklich, Produkt-Updates anzuwenden, sobald 
sie zur Verfügung stehen und immer nur die aktuellen Produktversionen zu verwenden. Die 
Verwendung veralteter oder nicht mehr unterstützter Versionen kann das Risiko von Cyber-
Bedrohungen erhöhen.

Um stets über Produkt-Updates informiert zu sein, abonnieren Sie den Siemens Industrial 
Security RSS Feed unter:
https://www.siemens.com/industrialsecurity

Plant Automation Accelerator 3.0 SP1
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Vorwort 2
Einführung in SIMATIC PCS 7 PAA (Plant Automation Accelerator)

PAA ist eine in COMOS integrierte Engineering-Lösung für PCS 7-Projekte, was die folgenden 
Vorteile mit sich bringt:

● Kürzere Projektzeiten – Effizientere PCS 7-Planung mit höherer Qualität

● Niedrigere Projektkosten – Ganzheitliches objektorientiertes Datenmodell, was technische 
Planung mit weniger Expertenwissen möglich macht 

● Niedrigere Instandhaltungskosten während des Anlagenbetriebs – Aktuelle 
Anlagendokumentation mit Änderungsmanagement für das vollständige PCS 7-Projekt

Zweck dieser Dokumentation
Das Bedienhandbuch für Plant Automation Accelerator 3.0 SP1 wendet sich an Personen, die 
PAA in einem Engineering System bedienen und überwachen. Dieses Handbuch führt Sie 
durch die grundlegenden Funktionen von PAA. Sie lernen zudem die elementaren 
Projektierungsschritte kennen und entwickeln dabei Ihr Verständnis der Arbeitsweise von PAA.

Voraussetzungen 
Zum Verständnis dieser Dokumentation sind allgemeine Kenntnisse auf dem Gebiet der 
Automatisierungstechnik und Grundkenntnisse von SIMATIC PCS 7, COMOS und PAA 
erforderlich.

Hinweise
Die Dokumentation von PAA enthält auch Verweise auf die Dokumentation von SIMATIC 
PCS 7. Darüber können Sie schnell auf die benötigte Dokumentation zuzugreifen.

Zugriff auf die PAA-Dokumentation
Die relevanten Versionen der Dokumentation von PAA ist auf den Internetseiten von PAA 
(https://mall.industry.siemens.com/mall/de/WW/Catalog/Products/10326822) verfügbar.

Informationen zu COMOS finden Sie unter Übersicht über COMOS (https://
support.industry.siemens.com/cs/ww/de/view/109739837).

Informationen zu PCS 7 finden Sie unter PCS 7 (www.siemens.com/pcs7-documentation).

Konventionen
In diesem Dokument werden Ihnen alle Handlungsanweisungen grundsätzlich über den 
ausführlichen Menübefehl erläutert. Fast alle Funktionen können Sie auch über das 
Kontextmenü oder mit Doppelklick aufrufen.

Plant Automation Accelerator 3.0 SP1
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Zielsetzung und Leistungsumfang der 
Datenschnittstelle 3
Zielsetzung

Die Plugins im Menü "Plugins > Automation > PCS 7 Schnittstelle" bieten eine bidirektionale 
Schnittstelle zum Austausch von Engineering-Daten mit SIMATIC PCS 7. Sie können nach der 
Initialisierung des SIMATIC PCS 7 Plant Automation Accelerator (PAA) -Projekts und des PCS 
7-Projekts wechselweise in beiden Programmen arbeiten. 

Das Ziel ist die "Digitale Anlage" durch integriertes Engineering mit PAA und SIMATIC PCS 7. 
In der digitalen Anlage arbeiten Anlagenplaner und Anlagenbetreiber auf der gleichen 
Datenbasis und erzeugen so ein durchgängiges Engineering.

Leistungsumfang der Schnittstelle
● Bidirektionaler Import/Export von Einzelsteuereinheitstypen (CMTs)

● Bidirektionaler Import/Export von Einzelsteuereinheiten und Parametern, Meldungen und 
Signalen

● Aktualisierung von Instanzen der Einzelsteuereinheiten

● Bidirektionaler Import/Export von Signal-Verschaltungen

– Implementierung von Kanälen auf Signale

– Bausteinlogik in Funktionsplänen

● Bidirektionaler Import/Export von Hardware einschließlich Symboltabellen

● Bidirektionaler Import/Export von redundanter CPU-Hardware einschließlich 
Symboltabellen

● Bidirektionaler Import/Export von Hierarchieordnern

● Bidirektionaler Import/Export von Verriegelungssteuerungen

Umbenannte Objekte
Umbenannte Objekte werden beim Datenaustausch wiedererkannt und beim Datenabgleich 
gegenübergestellt. 

Die Umbenennung wird bei folgenden Objekten erkannt: 

● Knoten der Anlagenhierarchie  

● Einzelsteuereinheitstypen (CMT) 

● Einzelsteuereinheit (CM) 

● Funktionalitäten

● Parameter, Signal (CV)  

● Aufzählung 

Plant Automation Accelerator 3.0 SP1
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● Aufzählungswert 

● Hardware:  

– Station, Slave (Central, Slave) 

– Sub-Netz, Bus (Global Subnet)

Ausschlüsse
Folgende grafische Daten werden nach dem Import in PAA nicht berücksichtigt:

● Kein Import der grafischen Anordnungen der Hardwarekonfiguration in HW Konfig von 
STEP 7.

● Kein Import der grafischen Darstellung von CFC- und Funktionsplänen.

Plugins 
Folgende Plugins stehen Ihnen im Menü "Plugins > Automation > PCS 7 Schnittstelle" zur 
Verfügung:

Name Icon Verwendung
"Import / Export PCS 7" Siehe auch Kapitel Import von PCS 7 

nach PAA (Seite 179) und Export von 
PAA nach PCS 7 (Seite 175).

"Typ-Konfigurator" Siehe auch Kapitel Verwaltung von Ein‐
zelsteuereinheitstypen (Seite 31) 
und Plugin "Typ-Konfigurator" (Sei‐
te 25).

"Verbindungsmanager" Siehe auch Kapitel Anlegen und Bear‐
beiten einer großen Anzahl von Verbin‐
dungen (Seite 157).

"Excel Import" Siehe auch Kapitel Ziel des Excel-Imp‐
orts (Seite 71).

"Neuzuweisung von Typen" Siehe auch Kapitel CM Varianten ab‐
gleichen (Seite 37).

"HW-Konfigurationswerkzeug" Siehe auch Kapitel HW-Konfigurations‐
werkzeug (Seite 121).

"NE 150-Import" Siehe auch Kapitel NE 150-Import (Sei‐
te 185)

"GSD[ML]-Dateien importieren" Siehe auch Kapitel GSD/GSDML-Datei‐
en importieren (Seite 94)

"GSDs zuweisen" Siehe auch Kapitel GSD-Objekte zuwei‐
sen (Seite 99)

Zielsetzung und Leistungsumfang der Datenschnittstelle
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Übersicht über den Datenaustausch mit PCS 7 4
Bidirektionaler Datenaustausch

Beim Datenaustausch zwischen PAA und PCS 7 können Sie die Daten bidirektional 
übertragen und abgleichen.

Für Transfer und Abgleich gibt es folgende Optionen:

● Direkter Datenaustausch: wenn PAA und PCS 7 auf dem gleichen Rechner installiert sind. 
Dabei werden über den Import-Service des Automation Interface (AI) die Typen und 
Instanzen von Technischen Einrichtungen bzw. Einzelsteuereinheiten von PAA und PCS 7 
ausgelesen und gegenübergestellt.

● Indirekter Datenaustausch über eine XML-Datei: wenn PAA und PCS 7 auf verschiedenen 
Rechnern installiert sind.
Für den indirekten Datenaustausch exportieren Sie zuerst die Daten über das Plugin 
"Import / Export PCS 7" aus PAA oder dem SIMATIC Manager in eine XML-Datei.
Danach importieren Sie die XML-Datei, die von PAA bzw. mit PCS 7 erzeugt wurde, 
umgekehrt in den SIMATIC Manager bzw. PAA. Beim Import wird auch ein Abgleich 
durchgeführt. Dabei können Sie Änderungen im Ziel löschen oder übernehmen.

Hinweis
Sicherheit beim Datenaustausch über XML-Format 
● Zugang zu Übergabemedium/Übergabeverzeichnis:

Bei Einsatz des indirekten Datenaustauschs über das XML-Format zwischen PAA und 
SIMATIC PCS 7 müssen Sie darauf achten, dass das Übertragungsmedium bzw. das 
Übertragungsverzeichnis der XML-Dateien nur berechtigten Personen zugänglich ist.

● Digital signierte XML-Dateien:
Um die Herkunft und die Integrität der XML-Daten zu beschreiben, können Sie beim 
Datenaustausch über XML-Format die XML-Datei digital signieren. Dies entspricht den 
Anforderungen des PCS 7-Sicherheitskonzepts. 
Über die Prüfung der digitalen Signatur stellen Sie sicher, dass die XML-Datei auf dem 
Übergabemedium nicht verändert wurde.  
Die digitale Signatur der XML-Datei ist standardmäßig deaktiviert. Es wird empfohlen, 
die digitale Signatur zu aktivieren.
Siehe auch Kapitel Austausch digital signierter XML-Dateien (Seite 167).

Hinweis
Hinweis zu dateibasiertem Datenaustausch

Achten Sie bei der Verwendung von dateibasiertem Datenaustausch darauf, dass die 
Quellen für einen Import vertrauenswürdig sind. Prüfen Sie die Dateien und Datenträger auf 
Virenfreiheit und wenden Sie die üblichen Sicherheitsmechanismen an. Um Ihre Daten zu 
schützen achten Sie darauf, dass die Datenträger bzw. Verzeichnisse ausschließlich 
berechtigten Personen zugänglich sind.

Plant Automation Accelerator 3.0 SP1
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Um Engineering-Daten zwischen PAA und SIMATIC PCS 7 auszutauschen, führen Sie 
mindestens folgende Arbeitsschritte aus:

Übersicht über den Datenaustausch mit PCS 7
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Vorbereitung
1. PCS 7 vorbereiten

Siehe Kapitel Voraussetzungen in PCS 7 (Seite 19).

2. PAA vorbereiten

– PAA-Planungsprojekt vorbereiten
Siehe Kapitel Planungsprojekt öffnen (Seite 22).

– DCS-Struktur anlegen
Siehe Kapitel DCS-Struktur anlegen (Seite 22).

3. Einzelsteuereinheitstypen in PAA verwalten

– Einzelsteuereinheitstypen in PAA importieren.
Siehe Kapitel Einzelsteuereinheitstypen importieren (Seite 35).

– Verknüpfungstabelle für die Einzelsteuereinheitstypen konfigurieren.
Siehe Kapitel Verknüpfungstabelle der Signalbezeichnungen konfigurieren (Seite 161).

– Einzelsteuereinheitstypen in PAA anlegen.
Siehe Kapitel Einzelsteuereinheitstypen anlegen (Seite 31).

Engineering in PAA
1. Hardware-Engineering auf der Registerkarte "Orte"

Siehe Kapitel Hardware-Engineering im Navigator (Seite 100).

– Schaltschrank aufbauen

– Station anlegen und konfigurieren

– Zentrale oder dezentrale Peripherie aufbauen und konfigurieren

2. Software-Engineering (DCS-Struktur) auf der Registerkarte "Anlagen"
Siehe Kapitel Software-Engineering im Navigator (Seite 134).

– Signalplanung

– Kanäle implementieren
Siehe Kapitel Optional: Hardware und Software verknüpfen: Kanäle implementieren 
(Seite 137).
Siehe Kapitel Mit Kanalanforderungen arbeiten (Seite 135).
Dieser Arbeitsschritt verknüpft das Hardware-Engineering und das Software-
Engineering.

3. Einzelsteuereinheiten zuordnen
Software-Engineering per Engineering-Aufgaben bearbeiten (Seite 137).

4. Technische Funktionen anlegen und verwalten
Siehe Kapitel Verwaltung von Technischen Einrichtungen (Seite 49).

5. Symboltabelle anlegen oder aktualisieren
Siehe Kapitel Symboltabellen verwenden (Seite 146).

6. Interlock-Logik auf Funktionsplänen erstellen
Siehe Kapitel Engineering im Funktionsplan (Seite 148).

Übersicht über den Datenaustausch mit PCS 7
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Abschlussarbeiten
1. Gegebenenfalls PAA-Attribute und PCS 7-Attribute verknüpfen

Siehe Kapitel Attribute von PAA und PCS 7 verknüpfen (Seite 161).

2. Export von PAA nach PCS 7 durchführen
Siehe Kapitel Export von PAA nach PCS 7 (Seite 175).

3. Import von PCS 7 nach PAA durchführen
Siehe Kapitel Import von PCS 7 nach PAA (Seite 179).

Übersicht über den Datenaustausch mit PCS 7
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Voraussetzungen in PCS 7 5
Voraussetzungen für Einzelsteuereinheitstypen

Um in PAA mit Einzelsteuereinheiten arbeiten zu können, müssen folgende Bedingungen 
erfüllt sein:

● PCS 7-Projekt ist Bestandteil eines Multiprojekts

● Multiprojekt enthält eine Stammdaten-Bibliothek

● Masterdaten-Bibliothek enthält CMT

Voraussetzungen für Meldungen 
Um Meldungen aus einem PCS 7-Projekt zu importieren, müssen folgende Bedingungen erfüllt 
sein:

● Die Meldung muss in PCS 7 dem Baustein einer Einzelsteuereinheit zugeordnet sein.

● Die Meldung muss in PCS 7 an der technologischen Schnittstelle dem Baustein einer 
Einzelsteuereinheit oder der Bausteinvariable einer Einzelsteuereinheit zugeordnet sein.

Voraussetzungen für optionale Bausteine (Varianten von Einzelsteuereinheitstypen) 
Um optionale Bausteine aus einem PCS 7-Projekt zu importieren, müssen folgende 
Bedingungen erfüllt sein:

● Der Baustein muss in PCS 7 einer Einzelsteuereinheit optional zugeordnet sein.

● Der Baustein muss in PCS 7 an der technologischen Schnittstelle einem technologischen 
Anschluss zugeordnet sein.

● Für diesen Baustein muss die Option "Optional" aktiviert sein.

Siehe auch
Vorbereitungen (Seite 21)
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Vorbereitungen 6
6.1 Neues Planungsprojekt anlegen

Vorgehen
1. Wählen Sie in der Menüleiste den Befehl "Datei > Projekt öffnen".

Die Registerkarte "Projekt öffnen" öffnet sich.
Die Tabelle basiert auf einer Abfrage. Im Kontextmenü der Spaltenköpfe stehen Ihnen die 
Funktionen für Abfragen zur Verfügung, z. B. zum Filtern und Sortieren. Sie können diese 
Einstellungen in Ihren Benutzereinstellungen speichern.

2. Wählen Sie oben auf der Registerkarte über die folgenden Optionen einen Projekttyp aus:

Option Projekttyp
"Planung" Planungsprojekte
"Stammobjekte" Stammprojekte
"Kopiervorlagen" Kopiervorlagenprojekte
"System" Systemprojekte

Sie sehen alle Projekte des ausgewählten Projekttyps, für die Sie Leserechte haben.
Um das Kontextmenü zu öffnen, klicken Sie mit der rechten Maustaste in den 
Tabellenbereich. In der Regel legen Sie ein neues Projekt vom Typ "Planung" an.

3. Wählen Sie im Kontextmenü den Befehl "Neu > Projekt".
Das neue Projekt wird angelegt und die Projekteigenschaften geöffnet. 

4. Geben Sie dem Projekt in der Kategorie "Projektdaten" einen "Namen" und eine 
"Beschreibung".
Der "Typ" des Projekts entspricht laut Voreinstellung der auf der Registerkarte "Projekt 
öffnen" gewählten Option des Projekttyps.

5. Klicken Sie bei "Projektvorgabe" auf die Schaltfläche "...".
Das Fenster "Projektvorgabe auswählen für <Projektname>" öffnet sich.

6. Wählen Sie hier den Knoten "X01 SIMATIC PCS 7 Plant Automation Accelerator".

7. Bestätigen Sie die Auswahl mit "OK".

Weitere Informationen zu diesem Thema finden Sie im Handbuch COMOS Platform 
Administration unter dem Stichwort "Projekte und Arbeitsschichten administrieren".
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6.2 Planungsprojekt öffnen

Vorgehen 
1. Wählen Sie in der Menüleiste den Befehl "Datei > Projekt öffnen".

2. Selektieren Sie ein Projekt.
Wenn das Projekt Arbeitsschichten hat, werden die Arbeitsschichten im unteren Bereich 
der Registerkarte angezeigt.

3. Klicken Sie auf die Schaltfläche "Öffnen".
Das Projekt wird geladen. Wenn Sie mit Arbeitsschichten arbeiten, wird der freigegebene 
Bereich des Projekts geladen.
Weiterführende Informationen zu diesem Thema finden Sie in dem Handbuch "COMOS 
Platform Bedienung", Stichwort "Mit Projekten arbeiten".

6.3 DCS-Struktur anlegen

Einleitung
Die technologische Hierarchie besteht aus Hierarchieordnern, die weitere Hierarchieordner, 
CFC-/SFC-Pläne, Bilder, Reports und Zusatzunterlagen enthalten können. Sie stellt die 
funktionale, hierarchische Gliederung der Anlage dar, unabhängig von der Zuordnung zu 
Automatisierungssystemen bzw. Bedien- und Beobachtungssystemen.

Weiterführende Informationen zu diesem Thema finden Sie in der PCS 7 Dokumentation. 

Voraussetzung
● In den Projekteigenschaften ist die Projektvorgabe für SIMATIC PCS 7 gesetzt. 

Siehe auch Kapitel Neues Planungsprojekt anlegen (Seite 21).

Vorgehen
1. Selektieren Sie im Kontextmenü des Projektknotens den Befehl "Neu > DCS Struktur".

Im Navigator wird unterhalb des Projekts der Knoten "DCS Struktur" angelegt.

2. Selektieren Sie im Kontextmenü des Knotens "DCS Struktur" den Befehl "TH 
Hierarchieordner".

3. Selektieren Sie im Kontextmenü des Knotens "TH01 Hierarchieordner" den Befehl "TH 
Hierarchieordner".

4. Legen Sie die gewünschte Anzahl an Ordnern pro Hierarchieebene an.
Sie können die Hierarchie maximal acht Ebenen tief aufbauen. Nach der achten Ebene ist 
der Befehl im Kontextmenü ausgegraut.

Vorbereitungen
6.3 DCS-Struktur anlegen
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Verwendung des Pipezeichens "|"
Im Namen eines PAA-Objektes der Technologischen Hierarchie kann ein Pipezeichen "|" 
eingetragen werden. Ein Pipezeichen im Namen hat einen unerwünschten Nebeneffekt auf die 
Bildung eines SystemFullName. Ein SystemFullName wird aus den Namen der Eigentümer 
und dem eigenen Namen gebildet, wobei die Namensbestandteile durch Pipezeichen "|" 
getrennt werden. Durch ein Pipezeichen im eigenen Namen eines Objektes kann die 
Technologische Hierarchie nicht korrekt erzeugt werden, die auf der Basis des 
SystemFullName ermittelt wird. Tragen Sie im Namen eines Objekts nicht das Pipezeichen "|" 
ein. 

Wenn in Scripten und bei Importen Namen erzeugt werden, verwenden Sie kein Pipezeichen 
"|".

6.4 Norm ISA-88 in der Anlagenstruktur

Voraussetzung
● Im Navigator existiert der Knoten "DCS Struktur".

● Eine technologische Hierarchie ist angelegt. Siehe auch Kapitel DCS-Struktur anlegen 
(Seite 22).

Vorgehen
1. Öffnen Sie die Eigenschaften eines Ordner der ersten Ebene der technologischen 

Hierarchie.

2. Selektieren Sie die Registerkarte "Attribute > Automation Interface".

3. Selektieren Sie in der Liste "S88-Typisierung" den Eintrag "Anlage". 

4. Bestätigen Sie Ihre Eingaben.
Das Icon und die Beschreibung des Objekts im Navigator ändern sich.

5. Öffnen Sie die Eigenschaften eines Ordner der zweiten Ebene der technologischen 
Hierarchie.

6. Selektieren Sie die Registerkarte "Attribute > Automation Interface".

7. Selektieren Sie in der Liste "S88-Typisierung" den Eintrag "Anlage".

8. Bestätigen Sie Ihre Eingaben.
Das Icon und die Beschreibung des Objekts im Navigator ändern sich.

9. Öffnen Sie die Eigenschaften eines Ordner der dritten Ebene der technologischen 
Hierarchie.

10.Selektieren Sie die Registerkarte "Attribute > Automation Interface".

11.Selektieren Sie in der Liste "S88-Typisierung" den Eintrag "EMOD".

12.Bestätigen Sie Ihre Eingaben.
Das Icon und die Beschreibung des Objekts im Navigator ändern sich.

Vorbereitungen
6.4 Norm ISA-88 in der Anlagenstruktur
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Vorbereitungen
6.4 Norm ISA-88 in der Anlagenstruktur
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Plugin "Typ-Konfigurator" 7
7.1 Zielsetzung Typ-Konfigurator

Der Typ-Konfigurator dient der massenhaften Erstellung von CMT/EMT sowie der Bearbeitung 
von Varianten.

7.2 Plugin "Typ-Konfigurator" öffnen

Voraussetzungen
Ein Planungsprojekt ist geöffnet.

Vorgehen
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > Typ-

Konfigurator". 

7.3 Globale Befehls- und Statusbibliothek erzeugen

Einleitung
Die Befehls- und Statusbibliothek stellt Ihnen die gängigsten Befehle und Status für 
Technische Einrichtungen zur Verfügung. Sie haben die Möglichkeit die Bibliothek in den 
Stammobjekten zu erweitern. 

Voraussetzung
Das Plugin "Typ-Konfigurator" ist geöffnet. Siehe auch Kapitel Plugin "Typ-Konfigurator" öffnen 
(Seite 25).

Vorgehen
Klicken Sie in der Menüleiste des Plugin auf die Schaltfläche "Erzeuge Befehls- und 
Statusbibliothek".
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Ergebnis
Im Knoten "Kopiervorlagen" werden die beiden neuen Ordner "Befehle" und "Status" angelegt. 
Im Ordner "Befehle" werden einige Befehlsobjekte angelegt und im Ordner "Status" werden 
einige Statusobjekte angelegt. Sie haben die Möglichkeit diese Befehle und Status zum 
Beispiel in einer Schrittkette zu verwenden. Siehe auch Kapitel Referenz Plugin "Typ-
Konfigurator" (Seite 204).

7.4 Massenoperationen

Zielsetzung
Anlegen von N Elementen aus der folgenden Liste:

● Einzelsteuereinheit

● Parameter

● Signal

● Meldung

● Status

● Befehl oder Werte am CMT

● Funktion oder Aufzählung

Vorgehen
1. Wählen Sie im Typ-Konfigurator in der Spalte "Typen-Bibliothek" ein Element.

2. Klicken Sie mit der rechten Maustaste auf das Element oder ein Unterelement in der Spalte 
"Typ-Struktur" und wählen Sie "Anlegen N".

3. Wählen Sie die gewünschte Objektart aus.

4. Geben Sie eine Zahl ein

Zusätzlich haben Sie die Möglichkeit, durch Mehrfachselektion zu kopieren und zu löschen.

7.5 Aggregierte CMT
Innerhalb des Typ-Konfigurators können aggregierte CMT erstellt werden.

Plugin "Typ-Konfigurator"
7.5 Aggregierte CMT
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Vorgehen

Hinweis
Benutzeraktionen im Navigator im @Template Ordner führen zu Dateninkonsistenz

Objekte unter dem @Template-Ordner dürfen nicht im Navigator geändert werden. Diese 
manipulierten CMTs erzeugen inkonsistente CMTs unter den aggregierten CMTs. Diese 
Inkonsistenz kann vom Typkonfigurator nicht repariert werden. 
Einen inkonsistenten Zustand erkennen Sie daran, dass der Typ-Konfigurator nicht mehr 
initialisiert wird. 

Machen Sie im Navigator ausgeführte Aktionen rückgängig 

1. Klicken Sie in der Spalte "Typen-Bibliothek" auf "Neues Objekt einfügen" und wählen den 
gewünschten Typ

2. Über Drag & Drop weisen Sie das CMT dem aggregierten CMT zu (aus der Spalte "Typen-
Bibliothek" ziehen in die Spalte "Typ-Struktur")
An kopierten CMTs kann der Name angepasst werden

7.6 Variantenübersicht
Sie haben die Möglichkeit, eine graphische Übersicht aller Varianten eines CMT zu erhalten.

Gehen Sie dazu wie folgt vor:

1. Öffnen Sie das Plugin "Typ-Konfigurator"

2. Öffnen Sie die "Variantenübersicht"

7.7 Grafische Eigenschaften
Die Darstellung der grafischen Eigenschaften auf dem Funktionsplan lässt sich für die 
folgenden Objekte anpassen:

● CMT

● EMT

● Funktionalitäten

Vorgehen
1. Öffnen Sie das Plugin "Typ-Konfigurator"

2. Öffnen Sie die Schaltfläche "Grafische Eigenschaften".
In der "Typen-Bibliothek" können Sie alle Typen einer Objektart oder eine spezifische 
Instanz auswählen. 

3. Die Anpassungen wirken sich nur auf die Auswahl aus.

Plugin "Typ-Konfigurator"
7.7 Grafische Eigenschaften
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7.8 Funktionen erzeugen

Einleitung
Funktionen können Sie auf dem Funktionsplan wie Standard-Logikbausteine verwenden. 
Wenn Sie mit Funktionen auf dem Funktionsplan arbeiten möchten, ziehen Sie diese per 
Drag&Drop aus dem Knoten "@Template" auf den Funktionsplan.

Hinweis
Zu den Funktionen gehörende Aufgaben-Objekte

Wenn Sie eine Funktion auf dem Funktionsplan platzieren, wird im Navigator automatisch ein 
Aufgaben-Objekt angelegt. Diese Aufgaben werden bei Abfragen mit ausgewertet.

Hinweis
Option Report-Script

Es steht eine neue Report-Script-Option FunctionsAndBlocksPlacingMode zur 
Verfügung. Diese Script-Option ist hilfreich, wenn die Funktionen von PCS 7 importiert und 
automatisch im Funktionsplan platziert werden.

Sie steuert das Platzierungsverhalten der Funktionen im Funktionsplan. Standardmäßig ist 
ihre Einstellung "0" und die Funktionen werden neben ihrem Verbindungspartner platziert. Ist 
für diese Option "1" eingestellt, werden die mit Eingängen der CM verbundenen Funktionen auf 
der linken Seite der CM, beginnen auf der ersten Seite oben platziert, bzw. auf der rechten 
Seite, wenn sie mit Ausgängen verbunden sind.

Voraussetzung
Das Plugin "Typ-Konfigurator" ist geöffnet. Siehe auch Kapitel Plugin "Typ-Konfigurator" öffnen 
(Seite 25).

Vordefinierte Funktionsbausteine verwenden
1. Klicken Sie in der Menüleiste des Plugin auf die Schaltfläche "Funktionen".

Die Spalte "Funktionen" wird eingeblendet.

2. Selektieren Sie die gewünschten Funktionen.

3. Klicken Sie auf die Schaltfläche "Funktionen generieren".
Die ausgewählten Funktionen werden im Knoten "@Vorlage > PCS 7 > Vorlage-Container 
> Funktionen" angelegt und in Spalte "Typen-Bilbiothek" des Plugins angezeigt.

4. Selektieren Sie in der Spalte "Typen-Bibliothek" eine Funktion.

5. Selektieren Sie in der Spalte "Typ-Struktur" einen Parameter.

6. Bearbeiten Sie in der Spalte "Typ-Attribute" die Eigenschaften des Parameters.
Die Attribute Text 0/ Text 1 sind nur an Parametern des Typs BOOL verfügbar.

7. Bestätigen Sie Ihre Eingaben.

8. Wiederholen Sie die Schritte 4 bis 7 für alle Parameter, die Sie bearbeiten möchten.

Plugin "Typ-Konfigurator"
7.8 Funktionen erzeugen
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Neue Funktionsbausteine anlegen
1. Wählen Sie in der Menüleiste des Plugin den Befehl "Neues Objekt einfügen > Funktion".

Die Funktion wird in der Spalte "Typen-Bibliothek" angelegt. Der Name der neu angelegten 
Funktion lautet "Funktion_<fortlaufende Nummer>". In der Spalte "Typ-Struktur" wird die 
Funktion angezeigt. 

2. Selektieren Sie die Funktion in der Spalte "Typ-Struktur".

3. Wählen Sie im Kontextmenü den Befehl "Neues Objekt einfügen > Parameter".

4. Bearbeiten Sie in der Spalte "Typ-Attribute" die Eigenschaften des Parameters.
Die Attribute Text 0/ Text 1 sind nur an Parametern des Typs BOOL verfügbar.

5. Bestätigen Sie Ihre Eingaben.

6. Wiederholen Sie die Schritte 3 bis 5 für alle Parameter, die Sie anlegen möchten.

Siehe auch
Referenz Plugin "Typ-Konfigurator" (Seite 204)

7.9 Meldungen konfigurieren
Sie haben die Möglichkeit, die Meldungstypen zu konfigurieren. Die zugehörigen Daten sind 
wie folgt in der Datenbank zu finden:

Name der Meldeart Y10|M40|A10|Y10M40N00005

Name der Meldeklasse Y10|M40|A10|Y10M40N00015

Kürzel für Sammelanzeige Y10|M40|A10|Y10M40N00016

Zusätzlich gibt es fünf neue Attribute für Meldungen. Diese finden Sie am Objekt "B05 @ Y 
Meldungen" auf der Registerkarte "Automation Interface":

● Einzelquittierung

● Aktion auslösen             

● Batch-Kennung          

● OS-Bereich              

● Mit Quittierung        

Vorgehen
1. Klicken Sie im Typ-Konfigurator auf die Schaltfläche "Nachrichtensystem konfigurieren"

2. Bearbeiten Sie die Daten in der Tabelle
Sie können durch Multiselektion mehrere Zellen einer Spalte gleichzeitig editieren.

Datentransfer
Im Datentransferdialog wurde die Checkbox "Meldeklassen" hinzugefügt.

Nach Aktivieren der Checkbox werden die Meldeklassen angezeigt und auch übertragen.

Plugin "Typ-Konfigurator"
7.9 Meldungen konfigurieren
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Verwaltung von Einzelsteuereinheitstypen 8
8.1 Einzelsteuereinheitstypen anlegen

Voraussetzung
Das Plugin "Typ-Konfigurator" ist geöffnet. Siehe auch Kapitel Plugin "Typ-Konfigurator" öffnen 
(Seite 25).

Vorgehen
1. Wählen Sie in der Menüleiste des Plugins den Befehl "Neues Objekt einfügen > 

Einzelsteuereinheitstypen".
Die Hülle für einen Einzelsteuereinheitstyp wird in der Spalte "Typen-Bibliothek" angelegt. 
Der Name der neu angelegten Hülle lautet "CMT_<fortlaufende Nummer>".

2. Definieren Sie in der Spalte "Typ-Attribute" die Details des Einzelsteuereinheitstypen. 
Wenn Sie einen neuen Einzelsteuereinheitstyp angelegt haben, ist das Feld "Name" 
automatisch selektiert. 

3. Klicken Sie mit der rechten Maustaste auf die Hülle des CMT in der Spalte "Typ-Struktur" 
und wählen Sie im Kontextmenü den Befehl "Neues Objekt einfügen > < gewünschtes 
Objekt>".

4. Speichern Sie Ihre Eingaben.

Ergebnis
Der Einzelsteuereinheitstyp wird im Knoten "Kopiervorlagen" angelegt und im Plugin "Typ-
Konfigurator" angezeigt.

Der Einzelsteuereinheitstyp ist nur eine Hülle. In PCS 7 weisen Sie diesem 
Einzelsteuereinheitstyp die Anschlüsse und Meldungen des Bausteins zu. 

Hinweis
Einzelsteuereinheitstypen bearbeiten

Bearbeiten Sie Einzelsteuereinheitstypen ausschließlich über das Plugin "Typ-Konfigurator". 
Änderungen im Navigator werden nicht in das Plugin übernommen.

Siehe auch
Verwaltung von Einzelsteuereinheitstypen (Seite 31)
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8.2 Einzelsteuereinheiten anlegen

Voraussetzung
● Das Plugin "Typ-Konfigurator" ist geöffnet.

Siehe auch Kapitel Plugin "Typ-Konfigurator" öffnen (Seite 25).

● Ein Einzelsteuereinheitstyp ist angelegt.
Siehe auch Kapitel Einzelsteuereinheitstypen anlegen (Seite 31).

Vorgehen
1. Selektieren Sie in der Spalte "Typ-Struktur" den Einzelsteuereinheitstyp.

2. Öffnen Sie das Kontextmenü und wählen Sie den Befehl "Neues Objekt einfügen > 
Einzelsteuereinheit".

3. Definieren Sie in der Spalte "Typ-Attribute" die Details der Einzelsteuereinheit. 

4. Um die Einzelsteuereinheit als optional zu kennzeichnen, aktivieren Sie die Option 
"Optional" in der Spalte "Typ-Attribute". Siehe auch Kapitel Varianten mittels optionalen 
Bausteinen verwalten (Seite 36).

5. Legen Sie unterhalb der Einzelsteuereinheit die gewünschten Objekte an.
Um Meldungen, Befehle und Status anzulegen, gehen Sie vor wie für die 
Einzelsteuereinheiten beschrieben. Siehe auch Kapitel Verwaltung von 
Einzelsteuereinheitstypen (Seite 31).

6. Speichern Sie Ihre Eingaben.

Hinweis
Einzelsteuereinheitstypen bearbeiten

Bearbeiten Sie Einzelsteuereinheitstypen ausschließlich über das Plugin "Typ-Konfigurator". 
Änderungen im Navigator werden nicht in das Plugin übernommen.

Siehe auch
Referenz Plugin "Typ-Konfigurator" (Seite 204)

8.3 Aufbau von Einzelsteuereinheitstypen

Voraussetzung
● Das Planungsprojekt ist geöffnet.

Siehe Kapitel Planungsprojekt öffnen (Seite 22).
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Aufbau 

① Permanente Ordnervorlagen (PAA & COMOS)
② Allgemeiner Sammelordner für alle Vorlagen der PCS 7-Schnittstelle 
③ Sammelordner für Aufzählungstypen
④ Sammelordner für Vorlagen (zum Beispiel CMTs oder Funktionen)
⑤ Sammelordner für Einzelsteuereinheiten und Varianten
⑥ Sammelordner für CMT-Gruppe und Varianten (zum Beispiel Ventil mit Rückführsignal und 

Ventil ohne Rückführsignal)
⑦ CMT-Vorlage
⑧ Funktionsplan
⑨ Einzelsteuereinheitstyp (CMT)
⑩ Baustein des Einzelsteuereinheitstyps
⑪ Befehl
⑫ Meldung 

Meldungen besitzen folgende Eigenschaften:
● Sie beschreiben Ereignisse bei Einzelsteuereinheiten.
● Sie werden durch die Attribute "Meldeklasse", "Priorität" und "Herkunft" klassifiziert.
● Sie besitzen ein frei verwendbares Feld "Event" zur Beschreibung des Ereignisses.
● Sie besitzen ein frei verwendbares Feld "Infotext".

 Parameter bzw. Bausteinvariable der Einzelsteuereinheit
⑬ Status
⑭ Verknüpfungstabelle zum Verknüpfen PAA-spezifischer Attribute aus der DCS-Welt mit CO‐

MOS-spezifischen Attributen aus der Anlagenwelt
⑮ Parameter bzw. Bausteinvariable der Einzelsteuereinheit
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⑯ Signal
⑰ Kanalanforderung für das Signal

Optionale Bausteine (Varianten) 
Mit optionalen Bausteinen definieren Sie den Minimalumfang und Maximalumfang eines 
Einzelsteuereinheitstyps. Die Differenz zwischen diesen beiden Zuständen wird durch die 
optionalen Bausteine abgebildet. Zielsetzung ist es, einen Einzelsteuereinheitstyp so zu 
definieren, dass er für verschiedene funktionsverwandte Einzelsteuereinheiten als Vorlage 
verwendet werden kann.

Sie entscheiden während der Vorlagenerstellung darüber, welche optionalen Bausteine 
verwendet werden. Bei einer Einzelsteuereinheit kann nicht mehr geändert werden, welche 
Bausteine zur Verfügung stehen. 

Die optionalen Bausteine werden folgendermaßen verwaltet und gekennzeichnet:

● <Projekt> > @Template > @PCS 7 > Template-Container > CMTs > 
<Einzelsteuereinheitstyp> > <Varianten des Einzelsteuereinheitstyps>

● Im Knoten "Template-Container" liegen die Varianten zusammen mit allen anderen 
Einzelsteuereinheitstypen unterhalb des Ordners "CMTs". 

● Baustein (SubCM) in einer Variante des Einzelsteuereinheitstyps:
Registerkarte "Automation Interface", Attribut "Optional" ist aktiviert

Siehe auch
Einzelsteuereinheitstypen importieren (Seite 35)

Varianten mittels optionalen Bausteinen verwalten (Seite 36)
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8.4 Einzelsteuereinheitstypen importieren

Voraussetzung
● Das Projekt ist geöffnet.

Siehe Kapitel Planungsprojekt öffnen (Seite 22).

● Der Aufbau von Einzelsteuereinheitstypen ist verstanden.
Siehe Kapitel Aufbau von Einzelsteuereinheitstypen (Seite 32).

Vorgehen
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > 

Import / Export PCS 7".
Das Plugin "Import / Export PCS 7" wird geöffnet. 

2. Selektieren Sie die Registerkarte "Import".
Siehe auch Kapitel Registerkarte "Import" (Seite 199).

3. Wählen Sie den Dateityp der Importdatei aus:

– Option "PCS 7-Projekt": s7p

– Option "XML-Datei": xml
Empfehlung: Wenn Sie eine XML-Datei importieren, aktivieren Sie auch die Option 
"XML-Signatur". Der Import erwartet, dass eine signierte XML-Datei übergeben wird. 
Siehe auch Kapitel Austausch digital signierter XML-Dateien (Seite 167).

4. Wählen Sie in der Liste "PCS 7 Projektpfad / XML-Pfad" das Quellprojekt für den Import aus.

5. Aktivieren Sie in der Kontrollgruppe "Filter" die Option "Bibliothek > CM/EM Typen".

6. Deaktivieren Sie alle anderen Optionen in der Gruppe "Filter".

7. Klicken Sie auf die Schaltfläche "Import".
Der Dialog "Datentransfer – Generieren/Importieren" wird geöffnet. Siehe Kapitel Hinweise 
zum Dialog "Datentransfer – Generieren/Importieren" (Seite 195).

8. Klicken Sie im Dialog "Datentransfer – Generieren/Importieren" auf die Schaltfläche 
"Objekte importieren von B nach A".

Hinweis
Import der Signalattribute oberer/unterer Skalierungswert, Einheit

In der Voreinstellung ist die Option "Signalattribute oberer/unterer Skalierungswert, Einheit" in 
der Gruppe "Filter" ausgewählt, wenn Sie das Plugin "Import / Export" öffnen. Wenn Sie diese 
Attribute nicht importieren möchten, wählen Sie diese Option ab.

Ergebnis
Die Bibliothek mit den Einzelsteuereinheitstypen wird in das PAA-Projekt importiert und wird 
auf der Registerkarte "Anlagen" folgendermaßen angezeigt: 

Knoten "@Template > @PCS 7 > Template-Container > CMTs > <Name CMT> Typ/Varianten 
Sammlung" 
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Anschließend haben Sie die Möglichkeit die importierten Einzelsteuereinheitstypen zu 
bearbeiten und mit den Änderungen nach PCS 7 zu exportieren.

Der Einzelsteuereinheitstyp wird automatisch auf dem Funktionsplan platziert, der im 
@Template-Knoten mit angelegt wird.

8.5 Varianten mittels optionalen Bausteinen verwalten

Voraussetzungen
● Einzelsteuereinheitstypen mit unterlagerten Einzelsteuereinheiten sind angelegt. Die 

unterlagerten Einzelsteuereinheiten sind als optional gekennzeichnet.
Siehe auch Kapitel Einzelsteuereinheiten anlegen (Seite 32) und 
Kapitel Einzelsteuereinheitstypen importieren (Seite 35).

● Das Plugin "Typ-Konfigurator" ist geöffnet. Siehe auch Kapitel Plugin "Typ-Konfigurator" 
öffnen (Seite 25).

Ziel
Erzeugung von Varianten für Kopiervorlagen, aus denen die Einzelsteuereinheiten abgeleitet 
werden. 

Vorlagen per Varianten erstellen 
1. Selektieren Sie in der Spalte "Typen-Bibliothek" den Einzelsteuereinheitstyp.

2. Öffnen Sie das Kontextmenü und wählen Sie den Befehl "Neue Variante". 
Wenn der Kontextmenüeintrag inaktiv ist, haben Sie keine optionalen Bausteine am CMT 
definiert oder Sie haben bereits alle möglichen Varianten angelegt.

3. Klappen Sie die Struktur unterhalb des Einzelsteuereinheitstypen auf.

4. Selektieren Sie die neu angelegte Variante.

5. Selektieren Sie in der Spalte "Typ-Struktur" die unterlagerten Einzelsteuereinheiten, die 
diese Variante beinhalten soll.

6. Bestätigen Sie Ihre Eingaben.

Ergebnis
Die Varianten der Einzelsteuereinheitstypen werden auf der Registerkarte "Anlagen" angelegt:

● "@Template > @PCS 7 > Template-Container > CMTs > <CMT> Typ/Varianten Sammlung 
> <CMT_Var1 >"

Hinweis
Automatische Änderungen an Varianten

Änderungen an Einzelsteuereinheitstypen werden automatisch an die Varianten geschrieben.
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Siehe auch
Engineering in PAA (Seite 89)

8.6 CM Varianten abgleichen
Zielsetzung: Import einer Instanz von PCS 7 nach PAA, für die in PAA keine passende Variante 
existiert 

● Variante wird in der PAA-Bibliothek erzeugt 

● Namensgebung: NameMaster#No 

● Instanz wird in PAA angelegt / vorhandene Instanz wird aktualisiert

Allgemein
Wenn es sich um ein neues CM für PAA handelt, wird es grün angezeigt und direkt importiert, 
ohne das alte CM zu löschen.

Um die Bedienoberfläche zu öffnen, öffnen Sie das Plugin "Neuzuweisung der Typen".

Sie können per Drag&Drop arbeiten. 

Vorgehen
1. Aus dem Navigator, Ordner "@Template", einen Typen ins Feld "Typauswahl > Types" 

ziehen.

2. Aus dem Navigator, Ordner "DCS Structure", eine TH ins Feld "Startobjekt" ziehen.

3. Auf "Suchen" klicken.

4. Aus dem Navigator, Ordner "@Template", einen neuen Typen in die Spalte "Neuer 
Einzelsteuereinheitstyp" ziehen.

5. Auf "Ausführen" klicken. Instanzen gewinnen oder verlieren SubCMs aufgrund ihres Status 
im Vergleich zu dem Typ, dem sie zugewiesen wurden.
Das Protokollfenster wird mit allen Informationen über die Typen, die neu zugewiesen 
wurden aktualisiert.

8.7 Steuervariablen anlegen

Voraussetzungen
● Sie verwenden Steuervariablen zur Parametrierung und externen Verschaltung.

● Das Plugin "Typ-Konfigurator" ist geöffnet. Siehe auch Kapitel Plugin "Typ-Konfigurator" 
öffnen (Seite 25).

● Eine Technische Einrichtung ist angelegt. Siehe auch Kapitel Einzelsteuereinheitstypen 
anlegen (Seite 31).
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Vorgehen
1. Klicken Sie in der Spalte "Typ-Struktur" mit der rechten Maustaste auf eine Technische 

Einrichtung und wählen Sie im Kontextmenü den Befehl "Neues Objekt einfügen > 
<Parameter>".

2. Definieren Sie in der Spalte "Typ-Attribute" die Details der Steuervariablen.

3. Speichern Sie Ihre Eingaben.

Hinweis

Der Benutzer kann nur dann gültige Werte selektieren, wenn er einen Parameter des 
Datentyps BOOL für "IOTyp" IN und INOUT anlegt.

Text 0 / Text 1
Die Attribute werden zum Beispiel in WinCC verwendet, um Interlock Meldungen zu definieren.

Wenn Sie einen Parameter vom Datentyp BOOL anlegen, stehen Ihnen die Attribute Text 0 und 
Text 1 zur Verfügung. Wenn Sie einen anderen Datentyp selektieren, können Sie die Attribute 
Text 0 / Text 1 nicht bearbeiten. Den Wert im Kombinationsfeld können Sie trotzdem 
bearbeiten.

Wenn Text 0, Text 1 und Aufzählung nicht vorhanden sind, wird die Auswahl Wahr/Falsch 
angezeigt.

Wird der Datentyp in BOOL geändert, ändert sich der Wert nicht, doch die Liste im 
Kombinationsfeld mit Wahr/Falsch ist verfügbar.

Um die Attribute nachträglich zu bearbeiten, öffnen Sie die Eigenschaften des Parameters aus 
dem Navigator. Selektieren Sie die Registerkarte "Attribute > Automation Interface". Beide 
Attribute können bearbeitet werden.

8.8 Werte LowScale / HighScale / Unit verwalten

8.8.1 Unterer Skalierwert / Oberer Skalierwert / Einheit

Einleitung
LowScale/HighScale/Unit befinden sich an einem Signal unterhalb der CM. Bei einem 
vorhandenen Anlagenbaum können diese Werte über die Zuordnungstabelle der 
entsprechenden Funktion zugeordnet werden.

Der Benutzer kann den technologischen Namen einer Einheit in ein Signal unterhalb der CM 
in PAA eingeben. 
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Diese Einheit wird in den entsprechenden ganzzahligen Wert automatisch übertragen (nach 
IEC 61158) beim Transfer nach PCS 7.

Hinweis

Zum Ändern der Einheitengruppe benötigen Sie Administratorrechte für COMOS oder die 
Funktionsrechte "Stammdaten".

Weiterführende Informationen zu diesem Thema finden Sie im Handbuch "COMOS Platform 
Administration", Stichwort "Verwendung der Registerkarte "Rechte": Funktionsrechte 
zuweisen".

Hinweis
Austausch der Werte LowScale / HighScale / Unit zwischen PAA und PCS 7 im Plugin "Import / 
Export PCS 7"

Sie haben die Option "Signalattribute oberer/unterer Skalierungswert, Einheit" im Bereich 
"Verschiedenes" der Gruppe "Filter" im Plugin "Import / Export PCS 7". In der Voreinstellung ist 
die Option "Signalattribute oberer/unterer Skalierungswert, Einheit" ausgewählt, wenn Sie das 
Plugin "Import / Export" öffnen.

Wenn Sie diese Attribute nicht importieren möchten, da Sie eine PCS 7-Bibliothek verwenden, 
in der Sie die Werte LowScale / HighScale oder Unit als getrennte technologische E/A-
Parameter definiert haben, wählen Sie diese Option ab.

Einheit für Signale und Parameter übertragen
Wird eine Einheit importiert, die in COMOS nicht existiert, muss während des Imports eine 
Meldung angezeigt werden.

Um die Einheitengruppe zu ändern, wird die folgende Autorisierung benötigt:

1. Öffnen Sie "Administrator > System > Benutzerverwaltung" in der Menüleiste.

2. Öffnen Sie die Eigenschaften des Benutzers

3. Wählen Sie die Registerkarte "Rechte"

4. Aktivieren Sie die Option "Funktionsrechte" im Bereich "Anzeige von".

5. Wählen Sie wie in der Abbildung unten gezeigt im Kontextmenü "Neu > Recht" aus.

6. Wählen Sie mindestens die Rechte "Stammdaten" und bestätigen Sie Ihre Eingaben.
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Vorgehen
Folgen Sie den nachstehenden Schritten, um eine Einheit zu erzeugen:

1. Navigieren Sie zu einem Signal unter der CM-Instanz.

2. Öffnen Sie die Eigenschaften des Signals und wählen Sie "Attribute > Automation Interface".

3. Wählen Sie aus dem Kontextmenü im Feld "Messbereich" die Option "Navigieren > 
Attribut" .

4. Öffnen Sie die Eigenschaften des Attributs "Messbereich".

5. Wählen Sie die Registerkarte "Einheit" und klicken Sie neben dem Feld "Einheit oder 
Gruppe setzen" auf die Schaltfläche "...".

6. Das Fenster "Einheitenauswahl" öffnet sich.

7. Wählen Sie die gewünschte Einheit aus dem Bereich "Einheiten" und bestätigen Sie Ihre 
Eingaben. 
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Ergebnis
Die ausgewählte Einheit wird im Feld "Messbereich" angezeigt.

8.8.2 Einheitengruppen gesammelt erstellen oder ändern

Einführung
Um die Einheit der CM-Signale gesammelt zu ändern oder um die vorhandenen Einheiten zu 
ändern, verwenden Sie die Softwareabfrage "A40-Signale" in der Registerkarte "Einheiten". 
Weitere Informationen zu der Abfrage finden Sie in der Registerkarte "Hilfe" im 
Eigenschaftenfenster der Abfrage. 

Hinweis

Zum Ändern der Einheitengruppe benötigen Sie COMOS-Administratorrechte oder die 
Funktionsrechte "Stammdaten" und Objektrechte. Wenn der Anwender diese Rechte nicht hat, 
ist "Einheitengruppe auswählen" deaktiviert.

Siehe auch Unterer Skalierwert / Oberer Skalierwert / Einheit (Seite 38).

Vorgehensweise
1. Navigieren Sie in der Registerkarte "Einheiten" im Softwareabfrageordner zu "A40-

Signale". 

2. Öffnen Sie die Abfrage "A40-Signale" im Navigator.
Standardmäßig ist die DCS-Struktur im Feld "Startobjekt(e)" ausgewählt. Sie können das 
Startobjekt bei Bedarf ändern.

3. Wenn Sie auf das Symbol "Suchen" klicken, werden nachfolgend alle Signale unter der 
DCS-Struktur aufgelistet.

4. Wählen Sie die Zeilen aus, die Sie hinzufügen oder deren Einheiten Sie in der Spalte 
"Messbereich Einheit" ändern möchten.

5. Klicken Sie mit der rechten Maustaste und wählen Sie "Einheitengruppe auswählen".

Hinweis

Die Option "Einheitengruppe auswählen" ist nur für die Signale mit dem Datentyp Real 
aktiviert.

6. Das Fenster "Einheitenauswahl" wird geöffnet.

7. Wählen Sie die gewünschte Gruppe im Bereich "Gruppen" aus und bestätigen Sie Ihre 
Eingaben.

Ergebnis
Die ausgewählte Einheit wird im Feld "Messbereich Einheit" angezeigt.
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8.9 Meldungen anlegen

Einleitung
Eine Technische Einrichtung kann Meldungen absetzen. Diese werden im 
Visualisierungssystem gemeldet, zum Beispiel WinCC. 

Voraussetzungen
● Das Plugin "Typ-Konfigurator" ist geöffnet. Siehe auch Kapitel Plugin "Typ-Konfigurator" 

öffnen (Seite 25).

● Eine Technische Einrichtung ist angelegt. Siehe auch Kapitel Einzelsteuereinheitstypen 
anlegen (Seite 31).

Vorgehen
1. Klicken Sie in der Spalte "Typ-Struktur" mit der rechten Maustaste auf eine Technische 

Einrichtung und wählen Sie im Kontextmenü den Befehl "Neues Objekt einfügen > 
Meldung".

2. Definieren Sie in der Spalte "Typ-Attribute" die Details der Meldung.

3. Speichern Sie Ihre Eingaben.

Ergebnis
Die Meldung ist angelegt. Wenn Sie die Meldungen in PCS 7 übertragen, projektieren Sie in 
PCS 7 nachträglich die Bausteinzuordnung und den Meldebezeichner.

8.10 CM in DCS Struktur anlegen

Voraussetzung
● Die DCS Struktur ist angelegt.

Siehe auch Kapitel DCS-Struktur anlegen (Seite 22).

Vorgehen
1. Öffnen Sie die Eigenschaften der CMT-Vorlage in der DCS-Struktur, die Sie verknüpfen 

möchten.

2. Selektieren Sie die Registerkarte "Aufgaben > SW-Schnittstelle".

3. Prüfen Sie, ob die Aufgabe "In Vorlage kopieren" angezeigt wird, und legen Sie sie 
gegebenenfalls über das Kontextmenü "Neu > In Vorlage kopieren" an.

4. Navigieren Sie zur CMT-Vorlage.
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5. Ziehen Sie die CMT-Vorlage per Drag&Drop aus dem Navigator in die Spalte "CM/EM-Typ" 
auf der Registerkarte "SW-Schnittstelle" des Hierarchieordners.

6. Klicken Sie in der Menüleiste der Registerkarte auf die Schaltfläche "Ausführen 
(selektierte)".

7. Bestätigen Sie Ihre Eingaben.

8. Wiederholen Sie die obigen Schritte für jede weitere CMT-Vorlage, die Sie mit der DCS 
Struktur verknüpfen möchten.
Sie haben die Möglichkeit die CMT Vorlagen massenhaft mit der DCS Struktur zu 
verknüpfen.

CM mit Position über Unit Pointer verknüpfen
1. Selektieren Sie den CM.

2. Öffnen Sie die Eigenschaften des CM.

3. Selektieren Sie die Registerkarte "Allgemein".

4. Ziehen Sie die gewünschte Position per Drag&Drop aus der Anlagenstruktur in das Feld 
"Anlage".

Hinweis
Unit Pointer massenhaft setzen

Unter dem Knoten "DCS Struktur" ist eine Abfrage vorbereitet, über die Sie massenhaft Unit 
Pointer setzen können.

Siehe auch Kapitel Verknüpfungstabelle der Signalbezeichnungen konfigurieren 
(Seite 161).

8.11 Aggregierte CMTs anlegen

Einleitung
Der aggregierte CMT besteht aus einzelnen Einzelsteuereinheitstypen, die zusammengefasst 
werden um zum Beispiel eine CMT Kombination für eine Regelung aufzubauen. Diese können 
dann im Projekt verwendet werden und müssen nicht einzeln aufgebaut werden.

Voraussetzung
● Mehrere CMTs sind angelegt.

Siehe auch Kapitel Einzelsteuereinheitstypen anlegen (Seite 31).
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Vorgehen
1. Öffnen Sie das Plugin "Typ-Konfigurator".

2. Wählen Sie in der Spalte "Typ-Bibliothek" des Plugins "Typ-Konfigurator" den Befehl 
"Neues Objekt einfügen > Aggregierter CMT".
Die Hülle für einen aggregierten CMT wird in der Spalte "Typ-Struktur" angelegt. Der Name 
der neu angelegten Hülle lautet "Aggregierter CMT_<fortlaufende Nummer>". 

– Das Objekt "Aggregierte CMT Vorlage" und darunter ein Funktionsplan werden in der 
Spalte "Typ-Struktur" angelegt.

3. Definieren Sie in der Spalte "Typ-Attribute" die Details des aggregierten CMT. Wenn Sie 
einen neuen aggregierten CMT angelegt haben, ist das Feld "Name" automatisch selektiert.

4. Ziehen Sie die erforderlichen CMTs mittels Drag&Drop auf den aggregierten CMT in der 
Spalte "Typ-Struktur".

5.  Wiederholen Sie die Schritte 3 und 4 für alle aggregierten CMTs, die Sie den CMTs 
hinzufügen möchten.

6. Doppelklicken Sie auf die CM unter den aggregierten CMTs im Navigator.

7. Gehen Sie zu "Attribute > Automation Interface > Suffix" und geben Sie im Feld "Suffix" 
einen Wert ein, zum Beispiel "_1".

8. Wiederholen Sie die Schritte 6 und 7 für die restlichen CMs im aggregierten CMT.

9. Erstellen Sie eine Vorlage für den aggregierten CMT in der DCS-Struktur und ändern Sie 
den Namen der ACMT-Vorlage, zum Beispiel in LC101.

10.Legen Sie in der DCS-Struktur die Instanz des aggregierten CMT mit der Engineering-Task 
an.

11.Die CM-Instanzen werden mit dem Suffixwert erstellt, der den CM-Namen im aggregierten 
CMT angehängt ist.
In diesem Beispiel ist dies "LC101_1" und analog für die anderen CMs.

Hinweis

Attribut "Suffix" ist zwingend erforderlich, wenn mehrere CMs verwendet werden sollen. 
Sonst liegt nach der Instanziierung ein Namenskonflikt vor.
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12.Optional: 

– Öffnen Sie den Funktionsplan unterhalb des Objekts "Aggregierte CMT Vorlage".

– Platzieren Sie die CMTs aus der Sammlung auf dem Funktionsplan und verbinden Sie 
die CMTs miteinander.

– Sie haben die Möglichkeit Funktionen auf dem Funktionsplan zu platzieren.

Hinweis
Kein Austausch mit PCS 7

Aggregierte CMTs nehmen nicht am Datenaustausch mit PCS 7 teil und werden nicht 
exportiert. Nur die Objekte unter dem aggregierten CMT werden nach dem Export in 
PCS 7 ausgetauscht.

13.Optional: 

– Um die aggregierte CMT Vorlage nach PCS 7 zu übertragen, verwenden Sie das Objekt 
in der DCS Struktur über die Aufgabe "Vorlage einkopieren" in den Eigenschaften des 
Ordners in der DCS Struktur. Siehe auch Kapitel CM in DCS Struktur anlegen (Seite 42). 

Hinweis
Aktualisierung der Sammlung

Wenn Sie in PCS 7 oder dem Plugin "Typ Konfigurator" Änderungen an einem CMT 
vornehmen, der Bestandteil der Sammlung ist, aktualisieren Sie die CMTs anschließend 
über das Plugin "Baugruppen Updater".  Dabei werden auch die Instanzen der CMTs 
aktualisiert. Siehe auch Kapitel Typ-Verwendungen aktualisieren (Seite 141). 

8.12 Referenzen verwenden

Definition
Die Referenz in PAA entspricht in PCS 7 der Referenz an einem Parameter einer 
Steuervariablen.

Um Verbindungen zu anderen Bausteinen vorzubereiten, werden textuelle Referenzen 
eingesetzt. Dies können zukünftig geplante Verbindungen sein oder Verbindungen zu 
Bausteinen, die zum Bearbeiten entfernt werden.

Folgende Arten von Referenzen werden unterschieden:

● Globale Variablen Referenz
Verbindung zu Datenbausteinen

● Blockvariablen Referenz
Verbindungen zu CFC-Bausteinanschlüssen, die nicht im Plugin "Typ-Konfigurator" oder 
technologischen Editor für den Austausch zwischen PAA und PCS 7 definiert sind 

● Textuelle Referenz
Verbindung zu Steuervariablen, die im Plugin "Typ-Konfigurator" oder technologischen 
Editor für den Austausch zwischen PAA und PCS 7 definiert sind 
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Voraussetzung
Ein Funktionsplan ist zum Bearbeiten geöffnet. 

Ein Baustein ist platziert, dessen Parameter Sie mit dem Parameter eines anderen Bausteins 
verknüpfen möchten.

Vorgehen
1. Ziehen Sie die Referenz per Drag&Drop aus der Symbolleiste auf den Funktionsplan.

Das Referenzobjekt wird im Navigator unterhalb des Funktionsplans angelegt.

2. Verbinden Sie die Referenz mit dem Eingangsparameter des platzierten Objekts.

3. Um die Referenz zu markieren, klicken Sie ein Mal auf das Symbol der platzierten Referenz.
Die selektierte Referenz wird magentafarben angezeigt.

4. Um die Art der Referenz zu definieren, wählen Sie im Kontextmenü den Befehl "Referenzart 
> <gewünschte Art>". 
Standardmäßig wird eine textuelle Referenz angelegt.

5. Um den Pfad des Bausteins einzutragen, den Sie referenzieren möchten, wählen Sie eine 
der folgenden Möglichkeiten:

– Um den absoluten Pfad einer in PAA vorhandenen Steuervariablen zu übernehmen, 
selektieren Sie eine Steuervariable im Navigator und ziehen Sie per Drag&Drop auf das 
Symbol der Referenz auf dem Funktionsplan. 
Passen Sie den Pfad so an, dass er der gewünschten Referenz entspricht: 
Beispiel für die Syntax einer textuellen Referenz mit Anlagen-Hierarchie: PCS 7 
Projektname\Hierarchie Pfad\CM.CV
Beispiel für die Syntax einer Globalen Variablen Referenz mit Anlagen-Hierarchie: 
Name der globalen DB.Elementname
Beispiel für die Syntax einer Blockvariablen Referenz mit Anlagen-Hierarchie: PCS 7 
Projektname\\Hierarchie Pfad\\Blockname.BlockVariable

– Um den Pfad der Referenz manuell einzugeben, klicken Sie zwei Mal nacheinander auf 
den Beschreibungstext im Symbol der platzierten Referenz. 
Das Textfeld ist zum Bearbeiten aktiviert.
Geben Sie den Pfad ein.
Sie können einen relativen oder einen absoluten Pfad eingeben. Dabei gilt die Syntax 
aus PCS 7: (Plan\Baustein.Anschluss) mit TH-Pfad (sofern vorhanden). Weiterführende 
Informationen zu diesem Thema finden Sie in dem Handbuch "CFC für SIMATIC S7 
(V9.0)", Stichwort "Referenz am Parameter einer Steuervariablen".

6. Um eine Referenz zu schließen, selektieren Sie das Symbol der Referenz und wählen im 
Kontextmenü den Befehl "Referenz schließen".
Wenn PAA den referenzierten Baustein findet und die Referenz geschlossen werden kann, 
wird aus der textuellen Referenz eine Verbindung.

7. Bestätigen Sie Ihre Eingaben.
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Import von textuellen Referenzen
Wenn Sie textuelle Referenzen aus PCS 7 importieren und den zugehörigen Baustein bereits 
auf einem Funktionsplan platziert haben, werden die textuellen Referenzen nach dem 
Reengineering auch auf dem Funktionsplan angezeigt. Im Navigator liegen die textuellen 
Referenzen unterhalb des Funktionsplans.
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Verwaltung von Technischen Einrichtungen 9
9.1 Technische Einrichtung (Typ) anlegen

Voraussetzung
Das Plugin "Typ-Konfigurator" ist geöffnet. Siehe auch Kapitel Plugin "Typ-Konfigurator" öffnen 
(Seite 25).

Vorgehen
1. Wählen Sie in der Menüleiste des Plugin den Befehl "Neues Objekt einfügen > Technische 

Einrichtung (Typ)".
Die Hülle für eine Technische Einrichtung wird in der Spalte "Typen-Bibliothek" angelegt. 
Der Name der neu angelegten Hülle lautet "EMT_<fortlaufende Nummer>". In der Spalte 
"Typ-Struktur" wird die Technische Einrichtung angezeigt. Die Sequenzierung und ihre 
Merkmale befinden sich darunter. Der EMT kann darunter auch Einzelsteuereinheit, 
Parameter, Signal und Meldung enthalten.

2. Definieren Sie in der Spalte "Typ-Attribute" die Details der Technischen Einrichtung (Typ). 
Wenn Sie eine neue Technische Einrichtung (Typ) angelegt haben, ist das Feld "Name" 
automatisch selektiert.

3. Klicken Sie mit der rechten Maustaste auf den EMT in der Spalte "Typ-Struktur" und wählen 
Sie im Kontextmenü den Befehl "Neues Objekt einfügen > < gewünschtes Objekt>".

4. Wählen Sie im Ordner "Merkmale" in der Spalte "Typ-Struktur" einen Unterordner aus. 
Klicken Sie zum Beispiel mit der rechten Maustaste auf "Fahrweisen" und wählen Sie 
"Neues Objekt einfügen > Fahrweise" oder "Anlegen N < Fahrweise", um ein Merkmal zu 
erzeugen.

5. Speichern Sie Ihre Eingaben.

Ergebnis
Die Hülle der Technischen Einrichtung wird im Knoten "Kopiervorlagen" gespeichert. Siehe 
auch Kapitel Referenz Plugin "Typ-Konfigurator" (Seite 204) und Merkmale anlegen 
(Seite 54).

Hinweis
Keine Varianten

Varianten von EMTs werden nicht unterstützt.
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9.2 Technische Einrichtung (Typ) kopieren

Voraussetzung
Das Plugin "Typ-Konfigurator" ist geöffnet. Siehe auch Kapitel Plugin "Typ-Konfigurator" öffnen 
(Seite 25).

Vorgehen
1. Selektieren Sie die Hülle einer Technischen Einrichtung.

2. Wählen Sie in der Spalte "Typen-Bibliothek" den Befehl "Kopieren".

3. Wählen Sie in der Spalte "Typen-Bibliothek" den Befehl "Einfügen".
Die Kopie der Technischen Einrichtung wird in der Spalte "Typen-Bibliothek" angelegt. Der 
Name der neu angelegten Hülle lautet "EMT_<fortlaufende Nummer>". 

4. Definieren Sie in der Spalte "Typ-Attribute" die Details der Technischen Einrichtung. 

5. Klicken Sie mit der rechten Maustaste auf den EMT in der Spalte "Typ-Struktur" und wählen 
Sie im Kontextmenü den Befehl "Neues Objekt einfügen > < gewünschtes Objekt>".
Der Ordner "Merkmale" kann nicht umbenannt oder gelöscht werden.

6. Speichern Sie Ihre Eingaben.

Ergebnis
Die Hülle der Technischen Einrichtung wird im Knoten "Kopiervorlagen" gespeichert. Siehe 
auch Kapitel Referenz Plugin "Typ-Konfigurator" (Seite 204).

9.3 Technische Einrichtung (Typ) löschen

Voraussetzung
Das Plugin "Typ-Konfigurator" ist geöffnet. Siehe auch Kapitel Plugin "Typ-Konfigurator" öffnen 
(Seite 25).

Vorgehen
1. Selektieren Sie die Hülle einer Technischen Einrichtung.

2. Wählen Sie in der Spalte "Typen-Bibliothek" den Befehl "Löschen".

3. Speichern Sie Ihre Eingaben.

Ergebnis
Die Hülle der Technischen Einrichtung wird im Knoten "Kopiervorlagen" gelöscht. Siehe auch 
Kapitel Referenz Plugin "Typ-Konfigurator" (Seite 204).
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9.4 Steuervariablen anlegen

Voraussetzungen
● Sie verwenden Steuervariablen zur Parametrierung und externen Verschaltung.

● Das Plugin "Typ-Konfigurator" ist geöffnet. Siehe auch Kapitel Plugin "Typ-Konfigurator" 
öffnen (Seite 25).

● Eine Technische Einrichtung ist angelegt. Siehe auch Kapitel Technische Einrichtung (Typ) 
anlegen (Seite 49).

Vorgehen
1. Klicken Sie in der Spalte "Typ-Struktur" mit der rechten Maustaste auf eine Technische 

Einrichtung und wählen Sie im Kontextmenü den Befehl "Neues Objekt einfügen > 
<Parameter>".

2. Definieren Sie in der Spalte "Typ-Attribute" die Details der Steuervariablen.

3. Speichern Sie Ihre Eingaben.

Hinweis

Der Benutzer kann nur dann gültige Werte selektieren, wenn er einen Parameter des 
Datentyps BOOL für "IOTyp" IN und INOUT anlegt.

Text 0 / Text 1
Die Attribute werden zum Beispiel in WinCC verwendet, um Interlock Meldungen zu definieren.

Wenn Sie einen Parameter vom Datentyp BOOL anlegen, stehen Ihnen die Attribute Text 0 und 
Text 1 zur Verfügung. Wenn Sie einen anderen Datentyp selektieren, können Sie die Attribute 
Text 0 / Text 1 nicht bearbeiten. Den Wert im Kombinationsfeld können Sie trotzdem 
bearbeiten.

Wenn Text 0, Text 1 und Aufzählung nicht vorhanden sind, wird die Auswahl Wahr/Falsch 
angezeigt.

Wird der Datentyp in BOOL geändert, ändert sich der Wert nicht, doch die Liste im 
Kombinationsfeld mit Wahr/Falsch ist verfügbar.

Um die Attribute nachträglich zu bearbeiten, öffnen Sie die Eigenschaften des Parameters aus 
dem Navigator. Selektieren Sie die Registerkarte "Attribute > Automation Interface". Beide 
Attribute können bearbeitet werden.
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9.5 Meldungen anlegen

Einleitung
Eine Technische Einrichtung kann Meldungen absetzen. Diese werden im 
Visualisierungssystem gemeldet, zum Beispiel WinCC. 

Voraussetzungen
● Das Plugin "Typ-Konfigurator" ist geöffnet. Siehe auch Kapitel Plugin "Typ-Konfigurator" 

öffnen (Seite 25).

● Eine Technische Einrichtung ist angelegt. Siehe auch Kapitel Technische Einrichtung (Typ) 
anlegen (Seite 49).

Vorgehen
1. Klicken Sie in der Spalte "Typ-Struktur" mit der rechten Maustaste auf eine Technische 

Einrichtung und wählen Sie im Kontextmenü den Befehl "Neues Objekt einfügen > 
Meldung".

2. Definieren Sie in der Spalte "Typ-Attribute" die Details der Meldung.

3. Speichern Sie Ihre Eingaben.

Ergebnis
Die Meldung ist angelegt. Wenn Sie die Meldungen in PCS 7 übertragen, projektieren Sie in 
PCS 7 nachträglich die Bausteinzuordnung und den Meldebezeichner.

9.6 Verwendung von CM unterhalb von EMT
Der Benutzer kann mit unter dem EMT angelegten CMs arbeiten. Die CMs können aus den 
vorhandenen CMTs (typisierte CMTs) angelegt werden oder sie können über das 
Kontextmenü in der Spalte "Typ-Struktur" unter dem EMT (nicht typisierte CMTs) neu angelegt 
werden.

Siehe auch Kapitel Technische Einrichtung (Typ) anlegen (Seite 49).

Anlegen der CM mittels vorhandenem CMT (typisierte CMTs)
1. Öffnen Sie das Plugin "Typ-Konfigurator".

2. Wählen Sie einen vorhandenen EMT aus.

3. Ziehen Sie einen CMT mittels Drag&Drop aus der Spalte "Typ-Bibliothek" auf den EMT in 
der Spalte "Typ-Struktur".

4. Die neue CM wird unterhalb des EMT angelegt und kann für die Zuordnung von 
Einzelsteuereinheiten verwendet werden.
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Hinweis

Nur mit vorhandenem CMT angelegte CMs können als "Grundvoraussetzung" definiert 
werden.

Anlegen von CM über das Kontextmenü (nicht typisierte CMTs)
1. Öffnen Sie das Plugin "Typ-Konfigurator".

2. Wählen Sie in der Spalte "Typ-Struktur" einen ETM aus.

3. Klicken Sie mit der rechten Maustaste auf eine Technische Einrichtung und wählen Sie im 
Kontextmenü den Befehl "Neues Objekt einfügen > Einzelsteuereinheit".

4. Die CM wird unterhalb des EMT angelegt und kann nicht für die Zuordnung von 
Einzelsteuereinheiten verwendet werden.

9.7 Mit Basisanforderungen arbeiten

Einleitung
Mit Hilfe der Option "Basisanforderung" werden die Mindestanforderungen an die 
zuzuordnende Einzelsteuereinheit abstrakt beschrieben, z. B. die benötigten Befehle oder 
Rückmeldungen über den Zustand.

Einer Technischen Einrichtung (Typ) zugeordnete Einzelsteuereinheiten werden als 
sogenannte Basisanforderungen gekennzeichnet, wenn sie nur die Anforderung an eine 
Einzelsteuereinheit beschreiben und im Zuge des Instanziierens nicht implizit mit in der 
Kopiermenge enthalten sein sollen. Wenn Sie eine Einzelsteuereinheit-Zuordnung definieren, 
verwenden Sie eine Einzelsteuereinheit-Basisanforderung oder eine konkrete 
Einzelsteuereinheit als Bestandteil der Technischen Einrichtung.

Voraussetzung
● Das Plugin "Typ-Konfigurator" ist geöffnet.

Siehe auch Kapitel Plugin "Typ-Konfigurator" öffnen (Seite 25).

● Eine Technische Einrichtung (Typ) ist angelegt.
Siehe auch Kapitel Technische Einrichtung (Typ) anlegen (Seite 49).

● Mindestens ein Einzelsteuereinheitstyp ist angelegt.
Siehe auch Kapitel Einzelsteuereinheitstypen anlegen (Seite 31).

Vorgehen
1. Legen Sie in der Spalte "Typ-Struktur" eine Einzelsteuereinheit-Zuordnung unter der 

Technischen Einrichtung (Typ) an.

2. Ziehen Sie die gewünschten Einzelsteuereinheitstypen per Drag&Drop von der Spalte "Typ-
Bibliothek" zu der Technischen Einrichtung in der Spalte "Typ-Struktur".

Verwaltung von Technischen Einrichtungen
9.7 Mit Basisanforderungen arbeiten

Plant Automation Accelerator 3.0 SP1
Bedienhandbuch, 08/2019, A5E46351212-AB 53



3. Aktivieren Sie in der Spalte "Typ-Attribute" der unterlagerten Einzelsteuereinheitstypen die 
Option "Basisanforderung".

4. Ziehen Sie die Basisanforderung für die Einzelsteuereinheit per Drag&Drop zu der 
Einzelsteuereinheit-Zuordnung.
Sie können die Basisanforderung beliebig oft verschiedenen Einzelsteuereinheit-
Zuordnungen innerhalb einer Technischen Einrichtung zuweisen.

Hinweis
Basisanforderungen entfallen an der EMT-Instanz

Als Basisanforderung definierte Einzelsteuereinheiten unter einem EMT entfallen beim 
Instanziieren. Um sicherzustellen, dass die zugehörigen Fahrweisen an den 
Verwendungsstellen noch zulässig und funktionsfähig sind, ordnen Sie in diesem Fall konkrete 
Einzelsteuereinheiten zu.

9.8 Merkmale anlegen

Voraussetzungen
● Das Plugin "Typ-Konfigurator" ist geöffnet. Siehe auch Kapitel Plugin "Typ-Konfigurator" 

öffnen (Seite 25).

● Eine Technische Einrichtung ist angelegt. Siehe auch Kapitel Technische Einrichtung (Typ) 
anlegen (Seite 49).

Vorgehen
1. Wählen Sie in der Spalte "Typ-Struktur" unter der Technischen Funktion den Ordner 

"Merkmale".

2. Klicken Sie mit der rechten Maustaste auf einen Unterordner und wählen Sie im 
Kontextmenü den Befehl "Neues Objekt einfügen> <Merkmal>".
Siehe auch Kapitel Beschreibung der Merkmale (Seite 55).

Hinweis
Massenhaft anlegen

Verwenden Sie eine der zwei Optionen zum Anlegen mehrerer Merkmale in einem 
bestimmten Unterordner:
● Wählen Sie einen Unterordner in der Spalte "Typ-Struktur". Klicken Sie mit der rechten 

Maustaste auf einen Unterordner und wählen Sie "Anlegen N < <Merkmal>" in der 
Spalte "Typ-Struktur". Geben Sie einen Wert in das Feld "Anlegen N" des Fensters 
"Neues Objekt einfügen" ein, um diese Anzahl von Merkmalen in dem gewählten 
Unterordner anzulegen.

● Wählen Sie einen Unterordner in der Spalte "Typ-Struktur" und klicken Sie auf die 
Schaltfläche "Neues Objekt einfügen" in der Spalte "Typ-Attribute". Pro Klick wird ein 
Merkmal angelegt.
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3. Definieren Sie in der Spalte "Typ-Attribute" die Details des Merkmals.
Im Feld "Name" sind maximal 24 Zeichen zulässig.

4. Speichern Sie Ihre Eingaben.

9.9 Beschreibung der Merkmale

Fahrweisen (Control Strategies)
Mit Hilfe von Fahrweisen definieren Sie verschiedene verfahrenstechnische Abläufe. Das 
Ansteuern der Schrittketten erfolgt in Abhängigkeit von den Fahrweisen. Fahrweisen sind 
wichtig für die überlagerte Rezeptsteuerungsebene (Batch-Systeme).  Sie können maximal 32 
Fahrweisen anlegen. Den Fahrweisen können Sie Sollwerte zuweisen.

Sollwerte (Setpoints)
Sollwerte werden verfahrenstechnisch durch eine manuelle Bedienung oder eine überlagerte 
Steuerungsebene (Batch-System) vorgegeben. 

Folgende Datentypen werden unterstützt:

● BOOL

● INT

● DINT

● REAL

● STRING

● PI

● PO

Sie weisen einzelnen Fahrweisen Sollwerte zu. Neben dem Sollwert wird standardmäßig auch 
der Istwert als Steuervariable angeboten. 

Oberer und unterer Grenzwert werden im typischen Fall an der EM-Instanz ermittelt oder 
benutzerdefiniert festgelegt. Je nach gewähltem Datentyp können Sie den oberen und unteren 
Grenzwert auch im Plugin "Typ-Konfigurator" bearbeiten. 

Prozesswerte (Process Values)
Die Anbindung von Prozesswerten an die Technische Einrichtung dient der Steuerung der 
Schrittketten. Typischerweise werden Prozesssignale, wie z. B. ein Istwert, für das 
Weiterschalten von Schrittketten verwendet. Werte definieren Sie auf dem Funktionsplan. 

Die Einheit wird typischerweise an der EM-Instanz gesetzt.
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Steuerwerte (Control Values)
Steuerwerte werden dazu genutzt, eine Verbindung zu externen Einzelsteuereinheiten zu 
erstellen. Im EMT werden die Steuerwerte konfiguriert. Die eigentliche Verbindung zur 
Einzelsteuereinheit wird erst auf Instanzseite implementiert.

Die Einheit wird typischerweise an der EM-Instanz gesetzt.

Parameter
Ein Parameter dient der Beeinflussung des Verhaltens einer Grundfunktion an einer konkreten 
Instanz, z. B. bei Optionen. Ein anderes Beispiel für die Verwendung von Parametern ist das 
instanzspezifische Parametrieren von Grenzwerten.

Bitspeicher
Bitspeicher sind für das vorübergehende Speichern von Werten erforderlich. Bitspeicher 
werden nur lokal im Bedienelement verwendet.

Folgende Datentypen werden unterstützt:

● INT

● DINT

● BOOL

● REAL

● STRING

Zeiten (Timers)
Zeiten werden vielfältig verwendet, als Überwachungszeit oder zur Berechnung einer Laufzeit.

Hinweistexte (Note texts)
Hinweistexte werden bevorzugt für die Bedienerführung verwendet.

Positionstexte (Position texts)
Positionstexte dienen zum Anzeigen des aktuellen Prozesszustands auf der HMI.

9.10 Anlegen von Kennlinienparametern

Einleitung
Der Benutzer kann die Parameter, die zum Ordner "Kennlinien" gehören, anlegen/löschen und 
die zu den Kennlinienparametern gehörende Logik um die EM ändern.
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Vorgehen

Hinweis
● Der Kennlinienparameter muss mit dem Plugin "Typ-Konfigurator" angelegt werden.
● Wenn der Datentyp der Kennlinie geändert wird, werden alle Parameter gelöscht und auch 

die zusätzlichen Parameter und Verbindungen werden im Funktionsplan entfernt.

1. Öffnen Sie das Plugin "Typ-Konfigurator".

2. Navigieren Sie zu einer bestimmten Kennlinie (z. B. Zeiten), wo der Parameter noch nicht 
angelegt ist.

3. Wählen Sie beispielsweise "Neu > TIMER-Zeit > IO PInput Pulse" aus dem Kontextmenü im 
Navigator aus.
Der Parameter wird unterhalb der Zeit angelegt.

Kennlinien für die Standard-Erstellung von Parametern ändern
Wenn alle Datentypen der Kennlinie geändert wurden, werden alle Parameter automatisch 
angelegt, wenn eine neue Kennlinie mit dem Plugin "Typ-Konfigurator" angelegt wird.

1. Gehen Sie zum Stammobjekt (im Stammprojekt) der Kennlinie, für die alle Parameter 
standardmäßig erstellt werden sollen. 
Beispiel: @20|X01|C70|A30|A70|A30 Setpoint. Element (Setpoint) enthält alle verfügbaren 
Parameter für verschiedene Datentypen.

2. Ist dieses Element geerbt, gehen Sie zur Quelle (zum Beispiel @20|X01|C70|A30|B60|A10|
A30 Setpoint BOOL).

3. Öffnen Sie die Eigenschaften des Elements (Setpoint BOOL).

4. Wählen Sie in der Dropdownliste als Erstelloption für das Element "Baustein".

9.11 Austausch von Zuordnungen von Einzelsteuereinheiten
Der Benutzer kann die Zuordnungen der Einzelsteuereinheit zwischen PCS 7 und PAA 
importieren/exportieren.

CM-Zuordnung von PCS 7 in PAA gemäß Definition in EMT importieren
Vor dem Import müssen die folgenden Voraussetzungen in PCS 7 und PAA erfüllt sein:

● EMT erstellt (in PAA & PCS 7)

● CM mit Hilfe vorhandener CMTs unterhalb von EMT (in PCS 7) erstellt

– CM als Grundanforderung definiert oder nicht

● CM-Zuordnung unterhalb von EMT (in PCS 7) erstellt

● Zugeordnete CM (in PCS 7)

Verwaltung von Technischen Einrichtungen
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Vorgehen
1. Importieren mit dem Plugin "Import / Export PCS 7".

Prüfen Sie im Typ-Konfigurator, ob die Zuordnung erstellt und die zugeordnete 
Einzelsteuereinheit in PAA richtig eingestellt ist.

CM-Zuordnung von PCS 7 in PAA gemäß Definition in der EM-Instanz importieren
Vor dem Import müssen die folgenden Voraussetzungen in PCS 7 und PAA erfüllt sein:

● CM mit Hilfe vorhandener CMTs unterhalb von EMT erstellt und als Grundanforderung (in 
PAA & PCS 7) definiert

● Zuordnung erstellt und CM zugeordnet (in PAA & PCS 7)

● Eine andere CM-Instanz des gleichen Typs wie die CM unterhalb von EMT existiert (in PAA 
& PCS 7)

● EMT-Instanz erstellt (in PCS 7)

● In der EM-Instanz eine andere CM-Instanz zuordnen 

Hinweis

Es können nur Instanzen kompatibler CM-Typen im Projekt zugeordnet werden.

Vorgehen
1. Importieren mit dem Plugin "Import / Export PCS 7".

In den Zuordnungseigenschaften in der EM-Instanz prüfen, ob die zugeordnete 
Einzelsteuereinheit eine Verknüpfung zur CM-Instanz hat.

CM-Zuordnung von PAA in PCS 7 gemäß Definition in EMT exportieren
Vor dem Export müssen die folgenden Voraussetzungen in PCS 7 und PAA erfüllt sein:

● EMT erstellt (in PAA & PCS 7)

● CM-Zuordnung unterhalb von EMT (in PAA) erstellt

– CM als Grundanforderung definiert oder nicht

● CM mit vorhandenen CMT unterhalb von EMT (in PAA) erstellt

● Zugeordnete CM in der Zuordnung (in PAA)

Vorgehen
1. Exportieren mit dem Plugin "Import / Export PCS 7".

Prüfen Sie in PCS 7, ob die Zuordnung erstellt und die zugeordnete Einzelsteuereinheit 
richtig eingestellt ist.

Verwaltung von Technischen Einrichtungen
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CM-Zuordnung von PAA zu PCS 7 gemäß Definition in der EM-Instanz exportieren
Vor dem Export müssen die folgenden Voraussetzungen in PCS 7 und PAA erfüllt sein:

● CM mit Hilfe vorhandener CMTs unterhalb von EMT erstellt und als Grundanforderung (in 
PAA & PCS 7) definiert

● Zuordnung erstellt und CM zugeordnet (in PAA & PCS 7)

● Eine andere CM-Instanz des gleichen Typs wie die CM unterhalb von EMT existiert (in PAA 
& PCS 7)

● EMT-Instanz erstellt (in PAA)

– Zuerst muss die EMT-Vorlage erstellt werden

– Führen Sie die Engineering-Task aus, um eine EM-Instanz zu erzeugen
Siehe auch Kapitel Software-Engineering per Engineering-Aufgaben bearbeiten 
(Seite 137).

● Zugeordnete andere CM-Instanz in der Zuordnung der EM-Instanz

Hinweis

Es können nur Instanzen kompatibler CM-Typen im Projekt zugeordnet werden.

Vorgehen
1. Exportieren mit dem Plugin "Import / Export PCS 7".

Prüfen Sie in PCS 7 in der EM-Instanz, ob die zugeordnete Einzelsteuereinheit die CM-
Instanz ist.

Verwaltung von Technischen Einrichtungen
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Verwaltung von Aufzählungen 10
10.1 Aufzählungstypen anlegen

Hinweis
Arbeiten mit zentralen Aufzählungstypen

Wenn Sie mit einer zentralen Aufzählungsbibliothek arbeiten möchten, legen Sie diese im 
Stammprojekt an. Exportieren Sie die Aufzählungstypen über den XML-Export und importieren 
sie diese anschließend in Ihr Planungsprojekt. Im Planungsprojekt können Sie weitere 
Aufzählungstypen definieren.

Voraussetzung
Das Plugin "Typ-Konfigurator" ist geöffnet. Siehe auch Kapitel Plugin "Typ-Konfigurator" öffnen 
(Seite 25).

Vorgehen
1. Wählen Sie in der Menüleiste des Plugin den Befehl "Neues Objekt einfügen > Aufzählung".

Die Hülle für eine Aufzählung wird in der Spalte "Typ-Bibliothek" angelegt. Der Name der 
neu angelegten Hülle lautet "Aufzählung_<fortlaufende Nummer>". In der Spalte "Typ-
Struktur" wird die Aufzählung angezeigt. Das Attribut "Name" ist die Kennung des 
Aufzählungstyps in PAA und unabhängig von der verwendeten Sprache. Bereits 
vorhandene Aufzählungen werden aufgelistet. 

2. Definieren Sie in der Spalte "Typ-Attribute" die Details des Aufzählungstypen. 
Wenn Sie einen neuen Aufzählungstyp angelegt haben, wird das Feld "Anzeigename" für 
diesen Aufzählungstyp automatisch generiert. Der "Anzeigename" beschreibt den 
Aufzählungstyp mit einem Namen für die UI und ist sprachabhängig. Der Standard-
Anzeigename ist der gleiche wie der Hüllenname und kann im Typ-Konfigurator bearbeitet 
werden.

3. Um einige Aufzählungswerte anzulegen, klicken Sie mit der rechten Maustaste in der Spalte 
"Typ-Struktur" auf die Aufzählung und wählen im Kontextmenü den Befehl "Neues Objekt 
einfügen > Wert". 
Die Anzeigenamen von Aufzählungswerten werden in der UI angezeigt und sind 
sprachabhängig.

4. Um Ihre Einträge zu speichern, klicken Sie im Typ-Konfigurator auf die Schaltfläche 
"Übernehmen".

Ergebnis
Der Aufzählungstyp wird im Knoten "@Template > @PCS 7 > Freigegebene Deklarationen > 
Aufzählungstypen" gespeichert. 
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Siehe auch Kapitel Arbeiten mit Aufzählungen in CMT/EMT (Seite 62).

10.2 Arbeiten mit Aufzählungen in CMT/EMT

Voraussetzungen
● Sie haben mindestens einen Aufzählungstypen angelegt. Der Aufzählungstyp muss 

mindestens einen Aufzählungswert unterhalb haben, wenn Sie ihn für CM/CMT-Instanzen 
verwenden. Siehe auch Kapitel Aufzählungstypen anlegen (Seite 61).

● Sie haben einen CMT/EMT mit einem Parameter angelegt und möchten hier eine 
Aufzählung verwenden. Siehe auch Kapitel Einzelsteuereinheitstypen anlegen (Seite 31) 
und Technische Einrichtung (Typ) anlegen (Seite 49).

● Parameter und/ oder Sollwert haben den Datentyp INT, DINT, BOOL, BYTE, WORD oder 
DWORD.

● Das Plugin "Typ-Konfigurator" ist geöffnet. Siehe auch Kapitel Plugin "Typ-Konfigurator" 
öffnen (Seite 25). 

Vorgehen
1. Wählen Sie in der Spalte "Typen-Bibliothek" den CMT/EMT, an dem Sie die Aufzählung 

verwenden möchten.
Wählen Sie in der Spalte "Typ-Struktur" den gewünschten Parameter.

2. Wählen Sie in der Spalte "Typ-Attribute" das Feld "Enumeration". 

3. Wählen Sie aus der Liste eine Aufzählung. Der Anzeigename des Aufzählungstyps im Feld 
"Enumeration" wird angezeigt.

4. Wählen Sie das Feld "Wert" aus, das den Anzeigenamen des Aufzählungswerts angibt.

5. Bestätigen Sie Ihre Eingaben.

Bearbeiten von Aufzählungen 
1. Um die Verwendung einer Aufzählung an einem Parameter zu ändern, öffnen Sie die 

Eigenschaften des Parameters. 

2. Wählen Sie die Registerkarte "Attribute > Automation Interface".

3. Bearbeiten Sie die Attribute "Aufzählung" und "Wert".

4. Bestätigen Sie Ihre Eingaben.

Das Attribut "Anzeigename" des Aufzählungstyps und des Aufzählungswerts kann zwischen 
PCS 7 und PAA in beiden Richtungen ausgetauscht werden. Der Wert "Anzeigename" kann im 
Plugin "Typ-Konfigurator" bearbeitet werden.

Verwaltung von Aufzählungen
10.2 Arbeiten mit Aufzählungen in CMT/EMT
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Vordefinierte Abfragen 11
11.1 Vordefinierte Abfragen

Vordefinierte Abfragen sind die in PAA definierten Hardware- und Softwareobjekte für PCS 7. 
Die Abfragestruktur ist auf der Registerkarte "Anlagen" und "Orte" definiert.

11.2 Abfragestruktur auf Registerkarte "Anlagen" 

Einleitung
Der Order "Abfragenordner QRY-SW" ist ein vordefinierter Ordner mit Abfragen zu 
Softwareobjekten für PAA-Anwender. Auch kann der Anwender eigene Abfragen im Ordner 
"Benutzerdefinierte Abfragen" anlegen. Der Anwender kann eine Massendaten-Projektierung 
in PAA standardmäßig ohne Anpassung durchführen.

Hinweis

Weitere Informationen zu einer bestimmten Abfrage enthält die "Funktionsbeschreibung" auf 
der Registerkarte "Hilfe" in den Eigenschaften der jeweiligen Abfrage.

Vorgehen
1. Wählen Sie die Registerkarte "Anlagen". 

2. Klicken Sie mit der rechten Maustaste auf den Projektknoten und wählen Sie im 
Kontextmenü den Befehl "Neu > Abfragenordner QRY-SW".

3. Der "Abfragenordner QRY-SW" wird einschließlich der Ordner "Objektansicht DCS SW" 
und "Abfragen für SW-Engineering" auf der zweiten Ebene unter dem Projektknoten 
angelegt. Die Struktur ist im Bild unten dargestellt.
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4. Klicken Sie mit der rechten Maustaste auf den Knoten "Abfragenordner QRY-SW" und 
wählen Sie im Kontextmenü den Befehl "Neu > Benutzerdefinierte Abfragen".

5. Der Ordner "Benutzerdefinierte Abfragen" wird angelegt. Die Struktur ist im Bild unten 
dargestellt.

Hinweis

Es können nur zwei Ebenen benutzerdefinierter Abfragen angelegt werden.

Objektansicht DCS SW
Der Ordner "Objektansicht DCS SW" hat folgende Abfrageelemente:

● Einzelsteuereinheiten

● Unterlagerte Einzelsteuereinheiten

● Parameter

● Signale

● Bibliotheksdatei für Excel/NE 150-Import-Plugin

● Meldungen

● Hierarchieordner

● Technische Einrichtungen

Hinweis
Startobjekt(e)

Das Feld "Startobjekt(e)" ist mit der Voreinstellung "DCS-Struktur" belegt. Das gilt für alle 
Abfrageelemente mit Ausnahme des Abfrageelements "Bibliotheksdatei für Excel/NE 150-
Import-Plugin", und der Anwender kann das Startobjekt per Drag&Drop ändern.

Vordefinierte Abfragen
11.2 Abfragestruktur auf Registerkarte "Anlagen" 
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Einzelsteuereinheiten
Die Abfrage "Einzelsteuereinheiten" erfasst alle Einzelsteuereinheiten.

Unterlagerte Einzelsteuereinheiten
Die Abfrage "Unterlagerte Einzelsteuereinheiten" erfasst alle unterlagerten 
Einzelsteuereinheiten.

Parameter
Die Abfrage "Parameter" erfasst alle Parameter.

Signale
Die Abfrage "Signale" erfasst alle Signale.

Bibliotheksdatei für Excel/NE 150-Import-Plugin
Die Abfrage "Bibliotheksdatei für Excel/NE 150-Import-Plugin" dient zur Unterstützung der 
Erzeugung einer Bibliotheksdatei für den Excel-Import/NE 150-Import.

Siehe auch Automatische Generierung von Bibliotheksdateien (Seite 79).

Hinweis

Ausführliche Schritte zur Erstellung der Bibliotheksdatei finden Sie in der 
"Funktionsbeschreibung" auf der Registerkarte "Hilfe" in den Eigenschaften der Abfrage.

Meldungen
Die Abfrage "Meldungen" erfasst alle Meldungen.

Hierarchieordner
Die Abfrage "Hierarchieordner" erfasst alle Hierarchieordner.

Technische Einrichtungen
Die Abfrage "Technische Einrichtungen" erfasst alle Technischen Einrichtungen.

Abfragen für SW-Engineering
Der Ordner "Abfragen für SW-Engineering" hat folgende Abfrageelemente:

● Anlagenpointer für CM/EM-Instanzen setzen

● DCS: Implementierung für Kanalanforderungen setzen

Vordefinierte Abfragen
11.2 Abfragestruktur auf Registerkarte "Anlagen" 
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● Anlage: Implementierung für Kanalanforderungen setzen

● Festlegen von CM-Zuordnungen an EM-Instanzen

Hinweis
Startobjekt(e)

Das Feld "Startobjekt(e)" ist in der Voreinstellung leer, und der Anwender kann das 
gewünschte Objekt per Drag&Drop einfügen.

Anlagenpointer für CM/EM-Instanzen setzen
Die Abfrage "Anlagenpointer für CM/EM-Instanzen setzen" erfasst alle Instanzen von 
Einzelsteuereinheiten und Technischen Einrichtungen.

DCS: Implementierung für Kanalanforderungen setzen
Die Abfrage "DCS: Implementierung für Kanalanforderungen setzen" dient zum Erfassen von 
Kanalanforderungen in Anwendungsfällen, in denen nur ein DCS-Knoten existiert.

Anlage: Implementierung für Kanalanforderungen setzen
Die Abfrage "Anlage: Implementierung für Kanalanforderungen setzen" dient zum Erfassen 
von Kanalanforderungen in Anwendungsfällen, in denen beide Knoten (DCS und Anlage) 
existieren.

Festlegen von CM-Zuordnungen an EM-Instanzen
Die Abfrage "CM-Zuordnung an EM-Instanzen festlegen" erfasst alle CM-Zuordnungen von 
EM-Instanzen.

Benutzerdefinierte Abfragen
Der Ordner "Benutzerdefinierte Abfragen" dient dem Benutzer zum Anlegen seiner eigenen 
Abfragenstruktur.

Vordefinierte Abfragen
11.2 Abfragestruktur auf Registerkarte "Anlagen" 
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11.3 Abfragestruktur auf Registerkarte "Orte"

Einleitung
Der Order "Abfragenordner QRY-HW" ist ein vordefinierter Ordner mit Abfragen zu 
Hardwareobjekten für PAA-Anwender. Auch kann der Anwender eigene Abfragen im Ordner 
"Benutzerdefinierte Abfragen" anlegen. Der Anwender kann eine Massendaten-Projektierung 
in PAA standardmäßig ohne Anpassung durchführen.

Hinweis

Weitere Informationen zu einer bestimmten Abfrage enthält die "Funktionsbeschreibung" auf 
der Registerkarte "Hilfe" in den Eigenschaften der Abfrage.

Vorgehen
1. Wählen Sie die Registerkarte "Orte".

2. Klicken Sie mit der rechten Maustaste auf den Projektknoten und wählen Sie im 
Kontextmenü den Befehl "Neu > Abfragenordner QRY-HW".

3. Der "Abfragenordner QRY-HW" wird einschließlich der Ordner "Objektansicht DCS HW" 
und "Abfragen für HW-Engineering" auf der zweiten Ebene unter dem Projektknoten 
angelegt. Die Struktur ist im Bild unten dargestellt.

4. Klicken Sie mit der rechten Maustaste auf den Knoten "Abfragenordner QRY-HW" und 
wählen Sie im Kontextmenü den Befehl "Neu > Benutzerdefinierte Abfragen".

5. Der Ordner "Benutzerdefinierte Abfragen" wird angelegt. Die Struktur ist im Bild unten 
dargestellt.

Hinweis

Es können nur zwei Ebenen benutzerdefinierter Abfragen angelegt werden.

Vordefinierte Abfragen
11.3 Abfragestruktur auf Registerkarte "Orte"

Plant Automation Accelerator 3.0 SP1
Bedienhandbuch, 08/2019, A5E46351212-AB 67



Objektansicht DCS HW
Die "Objektansicht DCS HW" hat folgende Abfrageelemente:

● Profibus-Slaves

● Profinet-Slaves

Hinweis
Startobjekt(e)

Das Feld "Startobjekt(e)" ist in der Voreinstellung leer, und der Anwender kann das 
gewünschte Objekt per Drag&Drop einfügen.

Profibus-Slaves
Die Abfrage "Profibus-Slaves" erfasst alle Profibus-Slaves. 

Hierzu zählen beispielweise ET 200-Stationen (Support Profibus), GSD Profibus-Geräte, 
DP/PA Link und andere.

Profinet-Slaves
Die Abfrage "Profinet-Slaves" erfasst alle Profinet-Slaves.

Hierzu zählen beispielweise ET 200-Stationen (Support Profibus), Kompaktfeldgerät (CFU), IE/
PB Link und andere.

Abfragen für HW-Engineering
Der Ordner "Abfragen für HW-Engineering" hat folgende Abfrageelemente:

● Redundanten Partner für E/A-Module setzen

● Adressen für E/A-Module setzen

Hinweis
Startobjekt(e)

Das Feld "Startobjekt(e)" ist in der Voreinstellung leer, und der Anwender kann das 
gewünschte Objekt per Drag&Drop einfügen.

Redundanten Partner für E/A-Module setzen
Die Abfrage "Redundanten Partner für E/A-Module setzen" erfasst alle E/A-Module, die für 
Redundanz genutzt werden können

Adressen für E/A-Module setzen
Die Abfrage "Adressen für E/A-Module setzen" erfasst alle E/A-Module.

Vordefinierte Abfragen
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Hierzu zählen beispielsweise E/A-Module für ET 200-Stationen, GSD-Geräte, SIMOCODE, 
SIMODRIVE, CFU und andere.

Benutzerdefinierte Abfragen
Der Ordner "Benutzerdefinierte Abfragen" dient dem Benutzer zum Anlegen seiner eigenen 
Abfragenstruktur.

Vordefinierte Abfragen
11.3 Abfragestruktur auf Registerkarte "Orte"
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Vordefinierte Abfragen
11.3 Abfragestruktur auf Registerkarte "Orte"
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Plugin "Excel-Import" 12
12.1 Ziel des Excel-Imports

Einleitung
Das Plugin "Excel-Import" dient zum Importieren von Technologischen Hierarchien, CM-
Instanzen, Hardware, Parametern und Signalen. Das Plugin "Excel-Import" ist sehr flexibel bei 
der Zuordnung der Daten aus Excel-Arbeitsblättern zu den Objekten oder Attributen in PAA, 
wodurch das Plugin benutzerfreundlicher wird. Mit diesem Plugin lässt sich die 
Massendatenprojektierung besser und schneller erledigen.

Siehe auch Flexible Zuordnungen beim Excel-Import (Seite 76).

Voraussetzung
● Die erforderliche Software Microsoft Excel ist installiert.

● Die Datei Signalliste.xls/xlsx ist vorhanden und befüllt.

● Die Datei BPCMT_Lib.xls/xlsx mit "Zuordnungskennungen" ist vorhanden und befüllt, wenn 
Parameter/Signalinformationen importiert werden sollen.
Alternativ können Sie neben den im PAA-Setup enthaltenen Beispieldateien auch Ihre 
eigenen Bibliotheksdateien verwenden. Um die Signale und Parameter der CMTs 
einzusammeln, verwenden Sie die mitgelieferte Abfrage.

Hinweis

Für die Excel-Signalliste gelten folgende Voraussetzungen:
● Es müssen beim Importieren von CM-Instanzen die gleichen CMTs vorhanden sein wie 

im PAA-Projekt
● Es müssen beim Importieren von Hardware die gleichen AS-Stationsnamen und 

Subnetznamen vorhanden sein wie im PAA-Projekt
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Vorgehen
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > 

Excel-Import" oder klicken Sie auf das Symbol "Excel-Import" in der Symbolleiste.
Das Plugin "Excel Import" öffnet sich.

2. Standardmäßig hat das "Zielobjekt" eine DCS-Struktur. Im Navigator können Sie jeden 
Hierarchieordner mit der Maus unter den DSC-Strukturordner ziehen.

3. Klicken Sie neben dem Feld "Excel-Datei" auf die Schaltfläche "…".
Ein Fenster öffnet sich.

4. Wählen Sie die Signalliste.

Hinweis

Der Anwender kann die Signallistendatei (englische und deutsche Datei) unter 
"C:\ProgramData\Siemens\PCS 7 Plant Automation Accelerator\Vx.y\Excel" nach der 
Installation verwenden.

5. Wählen Sie das erforderliche Arbeitsblatt aus der Klappliste im Feld "Arbeitsblatt" aus.

6. Geben Sie die Titelzeile im Feld "Titelzeile" ein bzw. wählen Sie sie aus.

7. Geben Sie im Feld "Startzeile" die Zeile an, ab der das Excel-Arbeitsblatt eingelesen 
werden soll, bzw. wählen Sie sie aus.

Plugin "Excel-Import"
12.1 Ziel des Excel-Imports
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8. Klicken Sie neben dem Feld "Bibliotheksdatei" auf die Schaltfläche "...".
Ein Fenster öffnet sich.

9. Wählen Sie die Bibliotheksdatei aus. 
Die Bibliotheksdatei ist nur erforderlich, wenn Sie die Zuordnungsklassen "Signal" und 
"Parameter" verwenden möchten.

Hinweis

Der Anwender kann die Beispielbibliotheksdatei unter "C:\ProgramData\Siemens\PCS 7 
Plant Automation Accelerator\Vx.y\Excel" nach der Installation verwenden.

Hinweis

Wenn der Anwender eine ungültige Bibliotheksdatei auswählt, wird ein Fehlerdialog 
angezeigt, die Signale/Parameter sind leer, doch die Daten werden für TH, CM und HW 
dennoch befüllt.

10.Der Bereich "Spaltenzuordnung" ist aktiviert und Sie können die erforderlichen 
Zuordnungen für verschiedene Eigenschaften von Zuordnungsklassen in der Baumstruktur 
"Spaltenzuordnung" vornehmen.

Hinweis
● Unter jeder Zuordnungskennung gibt es obligatorische Eigenschaften, die durch "*" für 

die Zuordnung gekennzeichnet sind, oder Ihnen wird in Rot ein Fehler angezeigt, wie im 
Beispielbild unten, und die Schaltfläche "Importieren" ist deaktiviert. Der Fettdruck weist 
daraufhin, dass die Zuordnungen korrekt sind. Die rote Schrift bedeutet, dass die 
Zuordnungen nur für die nicht obligatorischen Eigenschaften vorgenommen werden und 
nicht für die obligatorischen Eigenschaften unter der Zuordnungskennung.
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11.Nehmen Sie die erforderliche Konfiguration in der Baumstruktur im Bereich 
"Spaltenzuordnung" vor.

Hinweis
● Im Vorschaufenster werden alle den einzelnen Eigenschaften zugeordneten Spalten 

angezeigt. Im Vorschaufenster der Spaltenzuordnung ändert sich die Zeile "Daten" 
entsprechend der Auswahl der "Startzeile" und die Titelzeile ändert sich entsprechend 
der Auswahl der Titelzeile.

● Leere Zeilen im Excel-Arbeitsblatt werden ignoriert, während die Daten für die 
"Titelzeile" und die "Startzeile" im Vorschaufenster der Zuordnung gelesen werden.

● Wenn der Wert "Titel" in Excel fehlt, wird die Spalte im Vorschaufenster der Zuordnung 
ignoriert.

● Um die Anzahl von Spalten im Vorschaufenster der Zuordnung zu aktualisieren, wählen 
Sie das "Worksheet" oder die "Excel-Datei" erneut aus.
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12.Klicken Sie neben "Spaltenzuordnung" auf das Symbol "Konfiguration".
Das Fenster "Konfiguration..." wird geöffnet.

13.Wählen Sie die verfügbaren Optionen ("Neu", "Speichern", "Laden" oder "Löschen") je nach 
Ihrem Bedarf im Fenster "Konfiguration..." aus.

Hinweis

Die Konfiguration wird in der jeweiligen Sprache, in der Sie arbeiten, gespeichert. Wenn Sie 
die Datenbank in Deutsch konfigurieren und speichern und dann versuchen, diese 
gespeicherte Konfiguration in der englischen Datenbank zu öffnen, funktioniert es nicht.

Hinweis

Die Beispielkonfigurationsdateien "Example_Signallist_EN_V1.0" und 
"Example_Signalliste_DE_V1.0", die auf den Beispielsignallisten in "C:\ProgramData
\Siemens\PCS 7 Plant Automation Accelerator\Vx.y\Excel" beruhen, können geladen 
werden.

14.Die Option "DCS" ist standardmäßig in der Einstellung "Zielstruktur für Signalplanung" im 
Bereich "Optionen" ausgewählt.

15.Deaktivieren Sie die Option "In Arbeitsschicht importieren", wenn Sie in die aktuelle 
Arbeitsschicht importieren möchten.
Standardmäßig ist die Option aktiviert.

16.Klicken Sie auf die Schaltfläche "Import".

Hinweis

Die Protokollmeldungen können im Statusfenster angesehen werden, in dem die "Fehler", 
"Warnungen" und "Meldungen" angezeigt werden; der Anwender erhält genaue 
Informationen und kann Fehler ggf. schnell beheben.

Ergebnis
Die Technologische Hierarchie, CM-Instanzen, Hardware, Parameter und Signale werden 
basierend auf der vorgenommenen Konfiguration importiert.
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Siehe auch
ET 200-Stationen mit dem HW-Konfigurationswerkzeug konfigurieren (Seite 125)

12.2 Flexible Zuordnungen beim Excel-Import

Einführung
Der Anwender hat die Flexibilität, die erforderlichen Spalten aus dem Excel-Arbeitsblatt den 
entsprechenden Objekten oder Attributen in PAA zuzuordnen, und er kann die Konfiguration 
zur späteren Verwendung anpassen und speichern. Der Anwender kann ebenso die 
gespeicherte Konfigurationsdatei laden, die vorhandene Konfigurationsdatei löschen oder 
eine neue Konfigurationsdatei erstellen, was dem Anwender bei der Verwendung des Plugins 
"Excel-Import" eine größere Flexibilität gibt. Siehe auch Ziel des Excel-Imports (Seite 71).

Spaltenzuordnung
Die folgenden Zuordnungsklassen können im Bereich "Spaltenzuordnung" des Plugins wie im 
nachfolgenden Bild gezeigt zugeordnet werden.

● TH

● CM

● HW

● Signal

● Parameter

Hinweis
● Um die Zuordnungskennungen/Eigenschaften von Signalen und Parametern zu 

verwenden, ist die Auswahl "Bibliotheksdatei" obligatorisch.
● Sie können für die Eigenschaften in der Auswahltabelle basierend auf Ihren Attributen auch 

neue Werte hinzufügen.
● Zuordnungskennungen von Parametern werden aus der Bibliotheksdatei abgerufen. Alle 

anderen werden direkt aus der Auswahltabelle abgerufen.

Zuordnungsklassen, Zuordnungskennungen und Eigenschaftstabelle
Die Auswahltabellen enthalten die Zuordnungsklassen im Pfad "Auswahltabellen > Y10 > X01 
> A10 > X01N00023", und die Zuordnungskennungen und die entsprechende 
Eigenschaftstabelle befinden sich unter diesen Zuordnungsklassen.
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Struktur der Zuordnungsklassen

Spalte Beschreibung
"Name" In diese Spalte tragen Sie einen Namen nach folgendem Schema ein: A+ 3 Zahlen 

in Zehnerschritten hochgezählt. Beispiel: "A010" 
Voreinstellung: "A010"

"Beschreibung" Beschreibung der Zuordnungsklassen, auf deren Basis die Zuordnungskennung 
ausgewählt wird. Beispiel: "TH"

"Wert 1" Link zu den Auswahltabellen der Zuordnungskennungen. Beispiel: 
"X01N00023A01", TH-Zuordnungskennungen

Beispiel für die Struktur der Zuordnungsklassen

Struktur der Zuordnungskennungen

Spalte Beschreibung
"Name" In diese Spalte tragen Sie einen Namen nach folgendem Schema ein: A+ 3 Zahlen 

in Zehnerschritten hochgezählt. Beispiel: "A010" 
Voreinstellung: "A010"

"Beschreibung" Beschreibung des Objekts einer bestimmten Zuordnungskennung. Beispiel: Hie‐
rarchieebenen, "Ebene 1" bis "Ebene 8"

"Wert 1" Link zu den Eigenschaften der unterschiedlichen Zuordnungsklassen. Beispiel: 
"X01N00023A01BO1", TH-Eigenschaften

Hinweis
● Zuordnungskennungen sind für "CM" und "Signal" nicht verfügbar.
● Zuordnungskennungen für den "Parameter" werden aus der ausgewählten Bibliotheksdatei 

abgerufen (sofern in der Bibliotheksdatei Zuordnungskennungen definiert sind).
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Beispiel für die Struktur von TH-Zuordnungskennungen

Eigenschaftenstruktur

Spalte Beschreibung
"Name" In diese Spalte tragen Sie einen Namen nach folgendem Schema ein: A+ 3 Zahlen 

in Zehnerschritten hochgezählt. Beispiel: "A010" 
Voreinstellung: "A010"

"Beschreibung" Eigenschaften/Attribute der Zuordnungsklasse. Beispiel: "Hierarchiename"
"Wert 1" Wert der Eigenschaft (Register.Attribut)
"Wert 2" Typ der Eigenschaft (Attribut/Eigenschaft)
"Wert 3" Optionale/zwingende Auswahl des Attributs ("M" (zwingend, "O" (optional))

Beispiel für die Struktur von TH-Eigenschaften
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12.3 Automatische Generierung von Bibliotheksdateien

Generierung von Bibliotheksdateien
Die Bibliotheksdateien können automatisch generiert werden, indem die Abfrage "A41-
Bibliotheksdatei für Excel/NE 150-Import-Plugin" aus dem QRY-SW-Abfrageordner im 
Register "Einheiten" ausgeführt wird.

Nach Ausführung der Abfrage können Sie über das Symbol "Daten exportieren..." in der 
Symbolleiste des Plugin-Menüs die Signal- und Parameterliste in eine Excel-Datei exportieren.

Weitere Informationen zum Abfrageelement finden Sie im Abschnitt "Bibliotheksdatei für Excel/
NE 150-Import-Plugin" in Abfragestruktur auf Registerkarte "Anlagen"  (Seite 63).

12.4 Technologische Hierarchie (TH) importieren

Zweck
Importieren nur der TH in PAA Sobald der Import über das Plugin "Excel-Import" erfolgt ist, 
werden TH-Ebenen unter dem Strukturobjekt angelegt, wie vom Anwender in der Excel-Datei 
festgelegt.

Vorgehensweise
1. Öffnen Sie das Plugin "Excel-Import".

Siehe auch Ziel des Excel-Imports (Seite 71).

2. Ordnen Sie die Attribute des Hierarchieordners im Bereich "Spaltenzuordnung" 
entsprechend der benutzerdefinierten Excel-Datei zu.
Sie können "Hierarchiename", "S88-Typdefintion", "Autor" und "Beschreibung" importieren.

Hinweis
● Das Attribut "Hierarchiename" ist zwingend zuzuordnen.
● Unter der DCS-Struktur können maximal acht Ebenen von Hierarchieordnern angelegt 

werden.
● Wenn der Wert des Attributs "S88-Typdefinition" nicht in der Excel-Datei definiert ist, hat 

der angelegte Default-Hierarchieordner den Typ "Standard".

3. Klicken Sie auf "Importieren".

Ergebnis
Die TH-Ordner werden entsprechend den Spaltenzuordnungen der benutzerdefinierten Excel-
Datei unter der DCS-Struktur angelegt.
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12.5 CM importieren

Zweck
Importieren von CM, CM-Varianten, ACMs und Stationszuordnungen für mehrere Stationen. 
So kann der Anwender die CM-Instanzen gesammelt erstellen und das Engineering kann 
schneller durchgeführt werden.

Voraussetzungen
● PCS 7-Bibliothek mit CMTs muss in PAA-Projekt importiert werden (Beispiel: 

BPCMT_Lib_V1.0)

● CMT-Varianten, sofern erforderlich, können über das Plugin "Typ-Konfigurator" angelegt 
werden
Siehe auch Verwaltung von Einzelsteuereinheitstypen (Seite 31) und Plugin "Typ-
Konfigurator" (Seite 25).

● Ist eine AS-Zuordnung zur CM erforderlich, wird die entsprechende S7 400 Station benötigt

● Sofern erforderlich, können dann ACMTs angelegt werden
Siehe auch Aggregierte CMTs anlegen (Seite 43).

Vorgehensweise
1. Öffnen Sie das Plugin "Excel-Import".

Siehe auch Ziel des Excel-Imports (Seite 71) und Technologische Hierarchie (TH) 
importieren (Seite 79).

2. Ordnen Sie die CM-Eigenschaften gemäß der Excel-Datei dem entsprechenden CM-Typ 
zu.
Sie können die Eigenschaften "Name", "CMT", "Kommentar", "Autor", "Bedienersymbol", 
"Abtastzeit", "Version" und "Anlagenpointer" der CM importieren.

Hinweis

Die Eigenschaften "Name" und "CMT" sind zwingend zuzuordnen.

3. Klicken Sie auf "Importieren".

Hinweis
● Wenn das Zielobjekt das Leitsystem ist, werden auch die CMs angelegt, und der Anwender 

muss die CMs manuell in den entsprechenden TH-Ordner verschieben.
● Selbst wenn es keine Hardware oder AS-Zuordnung gibt, wird der Import durchgeführt. 

Ergebnis
Die CMs und ACMs werden mit dem entsprechendem CM/ACM-Typ gemäß der 
benutzerdefinierten Excel-Datei unter dem TH-Ordner angelegt.
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12.6 Parameterwerte importieren

Zweck
Konfigurieren und Importieren der Parameterwerte von CMs. 

Siehe auch Signalwerte importieren (Seite 82).

Voraussetzungen
● PCS 7-Bibliothek mit CMTs muss in PAA-Projekt importiert werden (Beispiel: 

BPCMT_Lib_V1.0)

● CMT-Varianten, sofern erforderlich, können über das Plugin "Typ-Konfigurator" angelegt 
werden

● Ist eine AS-Zuordnung zur CM erforderlich, wird die entsprechende S7 400 Station benötigt

● Die Bibliotheksdatei muss angelegt werden und die Zuordnungskennungen werden 
basierend auf der PCS 7-Bibliothek und der importierten Beispielsignalliste gesetzt 
(beispielsweise ist in der Einzelsteuereinheit MonAn "PV_AH_En" der Parameter mit der 
Zuordnungskennung "EN-HL3" in Bibliothek "BPCMT_Lib_V1.0")

Vorgehensweise
1. Öffnen Sie das Plugin "Excel-Import".

2. Konfigurieren Sie TH, CM und HW entsprechend der benutzerdefinierten Excel-Datei.

3. Konfigurieren Sie die erforderlichen Parameterattribute im Baum "Spaltenzuordnung" und 
ordnen Sie die Attribute zu.
Die Attribute "Wert", "Kommentar", "Enumeratiom", "Text 0", "Text 1" und 
"Bedienungskennung" können zugeordnet werden.

4. Klicken Sie auf "Importieren".

Hinweis
Signal und Parameter

Die Signale und Parameter direkt unter CM und auch unter SubCM von CMTs können 
importiert werden. Wenn es in Signal/Parameter schreibgeschützte Attribute für den Import 
gibt, wird der Import auch nicht unterbrochen. 

Ergebnis
Die CMs werden mit allen zugeordneten Parametern importiert.
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12.7 Signalwerte importieren

Zweck
Konfigurieren und Importieren der Signalwerte von CMs.

Siehe auch Parameterwerte importieren (Seite 81).

Voraussetzungen
● PCS 7-Bibliothek mit CMTs muss in PAA-Projekt importiert werden (Beispiel: 

BPCMT_Lib_V1.0)

● CMT-Varianten, sofern erforderlich, können über das Plugin "Typ-Konfigurator" angelegt 
werden

● Ist eine AS-Zuordnung zur CM erforderlich, wird die entsprechende S7 400 Station benötigt

● Die Bibliotheksdatei muss angelegt werden und die Zuordnungskennungen werden 
basierend auf der PCS 7-Bibliothek und einer importierten Beispielsignalliste gesetzt 
(beispielsweise ist in der Einzelsteuereinheit MonAn "PV_In" das Signal mit der 
Zuordnungskennung "PV" in Bibliothek "BPCMT_Lib_V1.0")

Vorgehensweise
1. Öffnen Sie das Plugin "Excel-Import".

2. Führen Sie die erforderliche Konfiguration für den Import von TH, CM und HW durch.
Siehe auch Technologische Hierarchie (TH) importieren (Seite 79), CM importieren 
(Seite 80) und Hardware (HW) importieren (Seite 83).

3. Konfigurieren Sie die Signaleigenschaften im Baum "Spaltenzuordnung" und ordnen Sie 
die Eigenschaften zu.
"Signalkennung", "Signalname (symbolische Adresse)", "Kommentar", "Messbereich – 
Min / Max / Einheit" können zugeordnet werden.

Hinweis

"Signalkennung" ist zwingend zuzuordnen.

Hinweis

Um eine eigene Einheit (benutzerdefinierte Einheit) zu erstellen, beispielsweise 
"MeineEinheit", gehen Sie wie folgt vor:
● Erstellen Sie "MeineEinheit" im COMOS-Einheitensystem (Administrator > Stammdaten 

> Einheitensystem). Beispiel: Einheitengruppe "Z05" und Einheit "Z05.AA100".
● Erstellen Sie die Einheit in der PCS 7-Einheitendatei (C:\Programme (x86)\SIEMENS

\STEP7\S7DATA\Units) im Bereich für benutzerdefinierte Einheiten 1-199. Beispiel: 
<Unit ComosText="MeineEinheit" ComosId="Z05.AA100" Pcs7Text="MeineEinheit" 
Pcs7Id="198"/>.

● Fügen Sie die neue Einheit der Auswahltabelle für den Excel-Import hinzu (Y10|X01|
A10|X01N00024 Einheiten-Mapping COMOS PCS 7).
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4. Um für eine Einheit verschiedene Schreibweisen hinzuzufügen, beispielsweise kann "m2" 
auch als "m2" geschrieben werden, gehen Sie wie nachfolgend beschrieben vor:

– Navigieren Sie zu Systemtabellen Y10|X01|A10|X01N00024 Einheiten-Mapping 
COMOS PCS 7.

– Navigieren Sie zu dem Wert "A240" und fügen Sie in der Spalte "Wert 4" einen Wert 
hinzu, verwenden Sie dabei das Trennzeichen ";". Beispiel: m2;m2.

Hinweis
1. Ist eine Änderung in der Einheiten-Auswahltabelle für alle Engineering-Projekte 

erforderlich, muss sie im Stammprojekt vorgenommen werden. Wenn eine Änderung in 
der Einheiten-Auswahltabelle sich nur auf ein Engineering-Projekt bezieht, sollte diese 
Auswahltabelle in das aktuelle Engineering-Projekt eingebucht werden, um die 
Einheitenwerte in einer Einheiten-Auswahltabelle zu ändern oder hinzuzufügen. Hierfür 
navigieren Sie zu "Administrator > Stammdaten > Auswahltabellen" und wählen im 
Kontextmenü von "X01N00024 Einheiten-Mapping COMOS PCS 7" die Option "Ins 
aktuelle Projekt einbuchen" aus.

2. Der Benutzer kann Einheiten in der Excel-Datei in einem beliebigen Format festlegen 
(etwa als PCS7 Unit ID oder COMOS Unit ID oder COMOS Einheitentext), 
beispielsweise kann "m2" auch als "m2" (COMOS Einheitentext) oder "1023" (PCS7 Unit 
ID) oder "I10.AA120" (COMOS Unit ID geschrieben werden).

3.  Wenn eine Zuordnungskennung für eine CM-Variante fehlt, wird die 
Zuordnungskennung nach der Stammvorlage für CM überprüft.

4. Die Kanäle des Signals werden implementiert, wenn die IO-Kanalinformationen für ein 
bestimmtes Signal in der Excel-Datei angegeben sind.

5. Klicken Sie auf "Importieren".
Die Einheit mit geändertem Text wird ebenfalls importiert und die entsprechende COMOS-
Einheit wird im Attribut "Messbereich" eines Signals von der CM-Instanz eingefügt.

Ergebnis
Die CMs mit allen Signalen und entsprechenden Einheiten werden importiert.

12.8 Hardware (HW) importieren

Zweck
Konfigurieren und Importieren der HW-Objekte mit PROFIBUS (beispielsweise ET 200 
Stationen) für den unspezifizierten HW-Ordner. Alle Stationen der ET 200-Familie (ET 200M, 
ET 200iSP, ET 200PA SMART, ET 200SP HA und ET 200SP) können importiert werden, als 
Beispiel wird in den nachfolgenden Abschnitten nur ET 200M beschrieben. Der Anwender 
muss die Slaves nach dem ersten Import in die verschiedenen Schaltschränke verschieben. 
Nach dem zweiten Import sind die Slaves jedoch aufgrund der Subnetz-Verbindung weiterhin 
identifiziert. Abhängig von der MLFB des Interfacemoduls wird das entsprechende Slave-
Objekt angelegt. So kann der Anwender verschiedene HW-Objekte gesammelt konfigurieren 
und erstellen und das Engineering kann schneller durchgeführt werden.
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Beim Importieren der HW sind die folgenden Konfigurationen für PROFIBUS möglich:

● Einzelkonfiguration (1 Subnetz)

● Einzelkonfiguration (1 Subnetz) mit redundanten Steckplätzen

● Einzelkonfiguration (1 Subnetz), 2 redundante Steckplätze auf 2 IO-Stationen

● Redundante Konfiguration (2 Subnetze) auf 1 IO-Station

● Redundante Konfiguration (2 Subnetze), 2 redundante Steckplätze auf 1 IO-Station

● Redundante Konfiguration (2 Subnetze), 2 redundante Steckplätze auf 2 IO-Stationen

Siehe auch Ziel des Excel-Imports (Seite 71) und Flexible Zuordnungen beim Excel-Import 
(Seite 76).

Grundsätzlich können die folgenden HW-Eigenschaften und -Attribute beim Konfigurieren und 
Importieren der HW zugeordnet werden:

● Station

– Name

● Subnetz

– Name

● Subnetz B

– Name

● Slave

– MLFB

– Adresse

– Name

– IP-Adresse

– Subnetzmaske

● Slave (redundant)

– Adresse

– Name

– IP-Adresse

– Subnetzmaske

● IO-Baugruppe

– MLFB

– Steckplatz

– Kommentar
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● IO-Baugruppe (redundant)

– Steckplatz

– Kommentar

● Kanal

– Nummer

Voraussetzungen
● Einzelne oder redundante S7-400 Stationen müssen im PAA-Projekt angelegt werden. AS-

Namen und Subnetz-/Subnetz B-Namen müssen den Angaben in der Excel-Datei 
entsprechen.

Hinweis

Bei redundanten Stationen muss auch ein Subnetz B konfiguriert werden.

Hinweis
Bundle-Informationen des ET 200M importieren

Die beim Anlegen der ET 200M-Station generierten Bundle-Informationen können 
importiert werden. Siehe auch Abschnitt Bundles beim Anlegen der ET 200M-Station 
erzeugen in Kapitel ET 200-Stationen mit dem HW-Konfigurationswerkzeug konfigurieren 
(Seite 125).

Einzelnen ET 200-Slave importieren
1. Öffnen Sie das Plugin "Excel-Import".

2. Ordnen Sie die Eigenschaften des HW-Objekts im Baum "Spaltenzuordnung" 
entsprechend der nachfolgenden Tabelle zu:

Station 
- Name

Subnetz 
- Name

Subnetz B
- Name

Slave 
- Adresse

Slave (re‐
dundant) - 
Adresse 

IO-Bau‐
gruppe 
- Steck‐
platz

IO-Bau‐
gruppe 
(redun‐
dant)
- Steck‐
platz 

Kanal 
- Nummer

A1 PROFI‐
BUS_1

 3  4  0

3. Klicken Sie auf "Importieren".

Plugin "Excel-Import"
12.8 Hardware (HW) importieren

Plant Automation Accelerator 3.0 SP1
Bedienhandbuch, 08/2019, A5E46351212-AB 85



Einzelnen ET 200-Slave (1 Subnetz) mit redundanten Steckplätzen importieren
Ordnen Sie die Eigenschaften des HW-Objekts im Baum "Spaltenzuordnung" entsprechend 
der nachfolgenden Tabelle zu:

Station 
- Name

Subnetz 
- Name

Subnetz B 
- Name

Slave 
- Adresse 

Slave (re‐
dundant) - 
Adresse 

IO-Bau‐
gruppe 
- Steck‐
platz

IO-Bau‐
gruppe (re‐
dundant) 
- Steck‐
platz 

Kanal 
- Nummer

A1 PROFI‐
BUS_1

 3  4 5 0

Einzelnen ET 200-Slave (1 Subnetz), 2 redundante Steckplätze auf 2 IO-Stationen importieren
Ordnen Sie die Eigenschaften des HW-Objekts im Baum "Spaltenzuordnung" entsprechend 
der nachfolgenden Tabelle zu:

Station 
- Name

Subnetz 
- Name

Subnetz B 
- Name

Slave 
- Adresse 

Slave (re‐
dundant) - 
Adresse 

IO-Bau‐
gruppe 
- Steck‐
platz

IO-Bau‐
gruppe (re‐
dundant) 
- Steck‐
platz 

Kanal 
- Nummer

A1 PROFI‐
BUS_1

 3 13 4 5 0

Redundanten ET 200-Slave (2 Subnetze) auf 1 IO-Station importieren
Ordnen Sie die Eigenschaften des HW-Objekts im Baum "Spaltenzuordnung" entsprechend 
der nachfolgenden Tabelle zu:

Station 
- Name

Subnetz 
- Name

Subnetz B 
- Name

Slave 
- Adresse

Slave (re‐
dundant) - 
Adresse 

IO-Bau‐
gruppe 
- Steck‐
platz

IO-Bau‐
gruppe (re‐
dundant) 
- Steck‐
platz 

Kanal 
- Nummer

A1 PROFI‐
BUS_1

PROFI‐
BUS_2

3  4  0
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Redundanten ET 200-Slave (2 Subnetze), 2 redundante Steckplätze auf 1 IO-Station importieren
Ordnen Sie die Eigenschaften des HW-Objekts im Baum "Spaltenzuordnung" entsprechend 
der nachfolgenden Tabelle zu:

Station 
- Name

Subnetz 
- Name

Subnetz B 
- Name

Slave 
- Adresse 

Slave (re‐
dundant) - 
Adresse 

IO-Bau‐
gruppe 
- Steck‐
platz

IO-Bau‐
gruppe (re‐
dundant) 
- Steck‐
platz 

Kanal 
- Nummer

A1 PROFI‐
BUS_1

PROFI‐
BUS_2

3  4 5 0

Redundanten ET 200-Slave (2 Subnetze), 2 redundante Steckplätze auf 2 IO-Stationen importieren
Ordnen Sie die Eigenschaften des HW-Objekts im Baum "Spaltenzuordnung" entsprechend 
der nachfolgenden Tabelle zu:

Station 
- Name

Subnetz 
- Name

Subnetz B 
- Name

Slave 
- Adresse 

Slave (re‐
dundant) - 
Adresse 

IO-Bau‐
gruppe 
- Steck‐
platz

IO-Bau‐
gruppe (re‐
dundant) 
- Steck‐
platz 

Kanal 
- Nummer

A1 PROFI‐
BUS_1

PROFI‐
BUS_2

3 13 4 5 0

Hinweis

Bestimmte Eigenschaften müssen zwingend für die HW zugeordnet werden, sie sind 
nachfolgend aufgeführt:
● Slave

– MLFB
– Adresse

● Slave (redundant)
– Adresse

● IO-Baugruppe
– MLFB
– Steckplatz

● IO-Baugruppe (redundant)
– Steckplatz

Siehe auch
Technologische Hierarchie (TH) importieren (Seite 79)

CM importieren (Seite 80)
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Engineering in PAA 13
13.1 Transfer von Logikbausteinen

Hinweis
Datenverlust bei Verwendung von Standard Logikbausteinen – Defekter Datentransfer

Die in COMOS verwendeten Logikbausteine werden in PAA nicht weiter verwendet. Die auf 
dem Funktionsplan vorhandenen Logikbausteine dürfen daher nicht verwendet werden.

Nutzen Sie stattdessen folgende Vorgehensweise über Funktionen.

Beim Import einer Standardfunktion von PCS 7 auf PAA, für die in der PAA-Bibliothek kein 
Funktionstyp vorhanden ist, wird der Funktionstyp automatisch angelegt und in der Bibliothek 
gesichert. und dann die Instanz mit dem automatisch erstellten Funktionstyp erstellt.

Dieses Szenario enthält CM beim Import von PCS 7 zu PAA mit Logikbausteinen. Liste der 
Objekte:

"ABS", "ADD", "AND", "DIV", "EQ", "GE", "GT", "LE", "LT", "MUL", "NAND", "NE", "NEG", 
"NOR", "NOT", "OR", "SQRT", "SUB", "XOR"

Vorgehen 
1. Die Logikbausteine können von PCS 7 in PAA importiert werden, ohne explizit 

Funktionstypen zu erzeugen. Der Funktionstyp wird automatisch erstellt und in der 
Bibliothek gespeichert.

2. Nach dem Import wird im "Typ-Konfigurator" ein Funktionstyp erstellt und kann 
wiederverwendet werden.

3. Die Funktion wird unter dem CM platziert.

4. Beim Export von PAA befinden sich die Funktionen bereits unter dem CM.
Nur Funktionen unter dem Ordner "@Template" werden unterstützt. 

13.2 Belegung rechte Maustaste anpassen
1. Klicken Sie auf "Projekt öffnen"

2. Wählen Sie Ihr Projekt, klicken Sie mit der rechten Maustaste "Eigenschaften > Bearbeiten"

3. Wählen Sie "Kundeneinstellungen > Select Version PAA"

4. De-/Selektieren Sie die gewünschten Optionen

Plant Automation Accelerator 3.0 SP1
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Ergebnis
Beim Projektieren im Projekt zeigt die rechte Maustaste alle Objekte der selektierten Versionen 
an.

13.3 Funktionsmerkmale der Hardware-Objekte
My Documentation Manager bietet Ihnen eine Excel-Liste, in der erkennbar ist, für welchen 
Anwendungsfall die einzelnen Hardware-Stammobjekte ausmodelliert sind. Zum Beispiel, ob 
es über das AI ausgetauscht wird oder ob es auf dem Schaltschrankplan platzierbar ist.

Weitere Informationen zu Hardware-Objekten finden Sie in der Liste 
"Manufacturer_devices_PA_Accelerator*.xlsx" im PAA-Setup.

Verfügbare HW-Baugruppen
Weitere Informationen zu verfügbaren HW-Baugruppen finden Sie in der Liste 
"Manufacturer_devices_PA_Accelerator*.xlsx" im PAA-Setup.

Siehe auch
Excel-Liste der Hardware-Objekte (http://w3.siemens.com/mcms/industrial-automation-
systems-simatic/de/handbuchuebersicht/tech-dok-pcs7/simatic_pcs7_v811/Seiten/
Default.aspx)

13.4 Projektieren der Hardware-Komponenten

Zielsetzung
Alle Hardware-Komponenten, die über die PCS 7-Schnittstelle importiert oder exportiert 
werden, müssen sowohl in PAA als auch in PCS 7 eindeutige Bezeichnungen erhalten. Nur bei 
eindeutigen Bezeichnungen werden die Daten während des Imports oder Exports automatisch 
zugeordnet. 
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Vergleich der Identifikationsfelder von PAA und von PCS 7
Die Hardware-Komponenten werden mittels der Felder "Name" und "Artikelnummer" 
identifiziert. In PAA werden die Eigenschaften "Name" und "Artikelnummer" nach anderen 
Regeln erzeugt als in PCS 7. 

 PAA-Regel PCS 7-Regel (gemäß HW Konfig)
Name Laufende Nummer Nummer gemäß Steckplatzregeln.

Steckplatznummer des Moduls im Baugruppenträger 
oder in der dezentralen Peripherie. Siehe dazu im 
Folgenden die Beschreibung zu "Grundsätze der 
Steckplatzregeln von PCS 7". 

Artikelnummer Frei wählbare Artikel‐
nummer

Maschinenlesbare Fabrikatenummer (MLFB) des 
Herstellers.
Beispiel: "6ES7 417-4XT05-0AB0"

In PAA werden die Objekte zunächst nach den PAA-Regeln erzeugt. Um die Objekte nach PCS 
7 zu exportieren, müssen Sie die Objekte nach den PCS 7-Regeln umbenennen. 

Grundsätze der Steckplatzregeln von PCS 7 
Für die Identifikation einer Hardware-Komponente in PCS 7 sind sowohl die Steckplatzregeln 
des Baugruppenträgers als auch die Anschlussregeln des Bussystems wichtig. Eine SIMATIC-
Steuerung ist im Regelfall folgendermaßen aufgebaut: 

● Aufbau des Baugruppenträgers gemäß den Steckplatzregeln von HW Konfig: Busadresse
Im Baugruppenträger sind Stromversorgung, die CPU und die Ein-/Ausgabebaugruppen 
gesteckt. Die Busadresse muss im PAA-Objekt eingetragen und im Bus eindeutig sein.
Beispiel: Für die Stromversorgung wird eine "1" eingetragen.

● Anschlüsse gemäß den Anschlussregeln des Bussystems: Adressen von Ein- und 
Ausgängen
Das Bussystem ist an der CPU oder an einem Kommunikationsprozessor (CP) 
angeschlossen. Die Adressen werden in 8er-Blöcken verwaltet und in der Notation 
"Byte.BIT" geschrieben. Der Wertebereich reicht von 0 bis 7. Zuerst wird die y-Stelle 
hochgezählt, danach die x-Stelle.
Beispiel: Die Adressen für eine digitale Einbaugruppe mit 24 Eingängen reichen von E0.0 
bis E2.7.

Hinweis
Sonderregelung für UR2H-Racks

Bei UR2H-Racks werden alle Module der gesamten Station auf ein Rack gesteckt. Dieses 
UR2H-Rack ist nur elektrisch in zwei Bereiche aufgeteilt, die Steckplätze an sich bieten 
Platz für zwei CPUs.
Aus diesem Grund werden die UR2H-Racks nicht als zwei Racks mit den Steckplätzen 1 bis 
9 nach PAA übertragen, sondern nur ein Rack mit den Steckplätzen 1 bis 18. Wobei die 
erste Hälfte der Steckplätze für die erste CPU, die zweite Hälfte für die zweite CPU 
vorgesehen ist. 

Sie müssen bei den UR2H-Racks die Steckplatznummern entsprechend selbst anpassen.
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Regelprüfung beim Export von PAA nach PCS 7
Beim Export der Hardware-Konfiguration gilt: 

Die projektierten Bauteile werden anhand der Attribute "Name" und "Artikelnummer" 
identifiziert. 

Hinweis
Prüfung der Steckplatzregeln von HW Konfig

Der Inhalt des Attributs "Name" wird erst im Automation Interface geprüft. Im Fehlerfall wird 
folgende Meldung ausgegeben: 

"Der Wert des Attributs "Name" verletzt eine Steckplatzregel von HW Konfig."

Regelprüfung beim Import von PCS 7 nach PAA
Beim Reengineering gilt für den Import der Hardware-Konfiguration: 

Die projektierten Bauteile werden anhand des Attributs "Artikelnummer" identifiziert und in PAA 
den Stammobjekten zugeordnet.

Siehe auch
Übersicht über den Datenaustausch mit PCS 7 (Seite 15)

13.5 Verfügbare HW-Baugruppen

Referenz
Weitere Informationen zu verfügbaren HW-Baugruppen finden Sie in der Liste 
"Manufacturer_devices_PA_Accelerator*.xlsx" im PAA-Setup.

13.6 GSD[ML]-Importer

13.6.1 GSD/GSDML-Informationen
Der Transfer von GSD/GSDML-Informationen ist möglich

Mit PAA sind folgende Anwendungsfälle möglich:

● Gerät mit den zugehörigen GSD/GSDML-Informationen ist platziert und parametriert; wird 
übertragen

● Nach dem Export nach PCS 7 muss das Gerät in der HW-Konfiguration platziert und 
parametriert sein.
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13.6.2 Zielsetzung und Leistungsumfang der Schnittstelle

Zielsetzung
Der Anwender hat die Möglichkeit, GSD/GSDML-Dateien zu importieren und aus dieser 
interpretierten Gerätebeschreibung automatisch eine Stammobjektstruktur unter einem 
gewünschten Knoten in COMOS anzulegen. Die angelegte Struktur beschreibt die möglichen 
Slots, Subslots und Modulkonfigurationen der Geräte als COMOS-Stammobjektstruktur mit 
Elementen pro Slot und Modul. Wenn die Elemente und Slots zugewiesen sind, können Sie die 
spezifische Gerätestruktur im Navigator unter dem Gerät über das Kontextmenü der rechten 
Maustaste anlegen. 

Leistungsumfang der Schnittstelle
● Finden von passenden Geräte für die Funktionsanforderung (functional requirements)

● Bereitstellung von Informationen zu Eigenschaften des gewählten Messgeräts

● Setzen von Parametern und Konfiguration für ein Gerät 

● Dokumentation der gewählten Eigenschaften eines Geräts

● Entscheidung, welche Signale von einem modularen Gerät zur Verfügung gestellt werden

● Entscheidung, welches Echtgerät verwendet wird und direkter Zugang zur richtigen GSD/
GSDML-Datei

● Bereitstellung der Informationen zu der Konfiguration der modularen Geräte in der 
Anlagendokumentation

● Definition und Dokumentation der E/A-Belegung eines modularen Geräts

● Bereitstellung der Informationen zur Implementierung der Geräte in das DCS System

Plugins
Folgende Plugins stehen Ihnen im Menü "Plugins > Automation > PCS 7 Schnittstelle" zur 
Verfügung:

Plugin Beschreibung
"GSD[ML]-Dateien importieren" Siehe auch Kapitel GSD/GSDML-Dateien impor‐

tieren (Seite 94). 
"GSDs zuweisen" Siehe auch Kapitel GSD-Objekte zuweisen (Sei‐

te 99). 
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13.6.3 GSD/GSDML-Dateien importieren

Einleitung
Die Daten werden in das Projekt importiert, das beim Starten des Plugins geöffnet ist. Wenn ein 
Planungsprojekt geöffnet ist, werden die Daten als lokale Stammobjekte angelegt und können 
nur in diesem Projekt verwendet werden. Wenn Sie die Daten projektübergreifend verwenden 
möchten, öffnen Sie das Stammprojekt bevor Sie das Plugin öffnen. Die auf der GSD-Datei 
basierenden Objekte und die auf der GSDML-Datei basierenden Objekte können in PAA-
Projekten verwendet und mit PCS 7 ausgetauscht werden.

Voraussetzung
● Das Projekt ist geöffnet, in das die Daten importiert werden sollen.

● Die GSD/GSDML-Dateien sind lokal gespeichert oder Sie halten die Zugangsdaten für den 
Webzugriff bereit.

Vorgehen
1. Um die Daten in das Stammprojekt (SO1) zu importieren, muss sich der Knoten unter "@50 

> A20" befinden.

2. Um die Daten in ein Engineering-Projekt zu importieren, muss der Knoten unter dem lokalen 
Stammobjekt "@Local" (ggf. neu anlegen, falls nicht vorhanden) eingefügt werden.

3. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > 
GSD[ML]-Dateien importieren".
Das Plugin wird geöffnet und die Registerkarte "Ziel auswählen" ist aktiviert.

4. Wählen Sie einen Knoten aus, wo die GSD/GSDML-Datei importiert werden soll:

Engineering in PAA
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5. Klicken Sie auf "Weiter".

6. Die Registerkarte "Quelle auswählen" wird aktiviert und Sie können die gewünschte Quelle 
für den Import auswählen.

7. Klicken Sie auf "Weiter".

Engineering in PAA
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8. Die Registerkarte "GSD[ML]-Dateien auswählen" wird aktiviert und Sie können eine der 
folgenden Optionen auswählen:

– Um GSD/GSDML-Dateien aus dem Internet zu importieren, klicken Sie auf Schaltfläche 
"URLs hinzufügen...".
Kopieren Sie die gewünschten URLs in das Fenster "URLs hinzufügen".

Bestätigen Sie Ihre Eingaben. Die ausgewählten Dateien sind im Bereich "Ausgewählte 
URLs" zu sehen.

Engineering in PAA
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– Um lokal gespeicherte GSD/GSDML-Dateien zu importieren, klicken Sie auf die 
Schaltfläche "Dateien hinzufügen...".
Selektieren Sie die gewünschte Datei.
Klicken Sie "Öffnen".

Bestätigen Sie die Eingabe. Die ausgewählten Dateien werden im Bereich 
"Ausgewählte Dateien" angezeigt.
Wiederholen Sie die letzten beiden Schritte für jede weitere Datei, die Sie importieren 
möchten.

9. Klicken Sie auf die Schaltfläche "Importieren".

10.Der Fortschritt wird im Importdialog angezeigt, und im Bereich "Ausgabe" sehen Sie die 
angelegten Strukturen wie im nachfolgenden Bild.

11.Klicken Sie nach dem Import auf "Fertigstellen".

Engineering in PAA
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Hinweis
● Wenn eine GSD-Datei in den Knoten "@Local" und in das Stammobjekt importiert wird, hat 

das GSD-Gerät im Knoten "@Local" beim Import, beispielsweise aus PCS 7, die höchste 
Priorität.

● Der Importer importiert nur eine Sprache (Englisch ist die Primärsprache). Der Austausch 
mit PCS 7 in einer anderen Sprache ist möglich, doch die Beschreibungen/Objektnamen 
werden in der ausgewählten Sprache geschrieben, was nicht akkurat sein kann.

Ergebnis
Die Geräte werden importiert und die Objekte unter dem angegebenen Zielknoten angelegt. 
Die Module, Slots und Subslots werden in unterschiedlichen Strukturen angelegt.

13.6.4 GSDML zwischen PAA and PCS 7 austauschen

GSDML-Objekte importieren/exportieren
Es ist möglich, die GSDML-Objekte zwischen PAA und PCS 7 zu importieren/exportieren. Alle 
Instanzen von GSDML-Objekten, die mit dem GSDML-Importer unter dem Ordner ""@50 > 
A20" im Stammobjekt oder "@Local" in ein Engineering-Projekt importiert werden, können 
nach PCS 7 übertragen oder mit dem Automation Interface entweder direkt oder via XML-Datei 
von PCS 7 empfangen werden.

Voraussetzung
Die GSDML-Objekte werden mit der gleichen Sprache (Englisch ist die Voreinstellung) in PAA 
und PCS 7 importiert.

Siehe auch GSD/GSDML-Dateien importieren (Seite 94).

Von PCS 7 nach PAA importieren
Beim Importieren der GSDML-Objekte von PCS 7 gehen Sie wie folgt vor:

1. Verbinden Sie ein GSDML-Objekt mit einem PROFINET-Subsystem.

2. Stecken Sie IO-Submodule mit Kanälen in die Steckplätze des GSDML-Objekts.

3. Importieren Sie das PCS 7-Projekt in PAA.
Nach dem Import sollten die GSDML-Objekte mit allen Submodulen übereinstimmen.

4. Prüfen Sie die GSDML-Objektinstanz auf die IO-Submodule mit den IO-Kanälen.

5. Prüfen Sie die E-Blockaufgaben auf die Verbindung zum PROFINET-Subsystem.
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Von PAA nach PCS 7 exportieren
Beim Exportieren der GSDML-Objekte aus PAA gehen Sie wie folgt vor:

1. Erstellen Sie eine GSDML-Objektinstanz in PAA unter dem Ortsbaum.

2. Verbinden Sie dieses GSDML-Objekt via E-Blockaufgabe mit dem Netzknoten unter einem 
PNIO-Device-Controller (beispielsweise Simatic-Station mit 410-5H CPU) mit einem PNIO-
Subsystem.

3. Instanziieren Sie ein IO-Submodul mit IO-Kanälen.
Der Export erfasst das GSDML-Objekt im Objektbaum.

4. Exportieren Sie in ein leeres PCS 7-Projekt.
Siehe auch Austausch eines PAA/PCS 7-Projekts (Seite 168).

5. Sobald der Export beendet ist, stimmen die GSDML-Objekte mit allen Submodulen überein.

6. Das GSDML-Objekt muss in HW Konfig des PCS 7-Projekts vorhanden und mit dem 
richtigen PROFINET-Subsystem verbunden sein.

13.6.5 GSD-Objekte zuweisen

Einleitung
Sie haben die Möglichkeit Objekte von der Registerkarte "Anlagen" im Navigator als 
Implementierung auf der Registerkarte "Orte" anzulegen. An der Implementierung können Sie 
die importierten GSD-Objekte als Elemente verfügbar machen.

Voraussetzung
● GSD-Daten sind importiert. Siehe auch Kapitel GSD/GSDML-Dateien importieren 

(Seite 94).

● In der Anlagenstruktur sind Objekte mit dem Attribut "PMD.PMD_ACF864_001_000" oder 
"Y30T00001.GSDFile" vorhanden. Objekte mit diesem Attribut finden Sie zum Beispiel auf 
der Registerkarte "Stammobjekte" unter den Knoten "@50 > A20 > A10 > A20 > A10 > A10 
> A20 > A10 > A40 > A10 Schnittstellenmodule" und "@30 > M41 > B20 PIA LCM 
Geräteanforderungen". Nur diese Objekte werden ausgewertet. 

Vorgehen
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7-Schnittstelle > 

GSDs zuweisen".
Das Plugin wird geöffnet. Die letzte Auswahl des Startobjekts (Registerkarte "Einheiten") 
und des Zielobjekts (Ortsbaum) bleibt gespeichert und ist automatisch gesetzt.

2. Ziehen Sie das Stammobjekt unter dem die GSD-Struktur liegt in das Feld "GSD-Quelle".
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3. Um die zuweisbaren Objekte zu suchen, klicken Sie in der Menüleiste des Plugin auf die 
Schaltfläche "Zuweisbare Geräte suchen". 
Alle unter dem Startobjekt gefundenen Feldgeräte werden aufgelistet. Die Spalte 
"Anlagenobjekt" zeigt die Objekte, an denen eines der geforderten Attribute vorhanden ist. 
Wenn bereits eine Implementierung für das Anlagenobjekt existiert, ist die Reihe in der 
Tabelle schreibgeschützt. 

4. Deselektieren Sie in der ersten Spalte Objekte, die Sie erst später zuweisen.

5. Wenn eine GSD-Stammobjektstruktur vorhanden ist, können Sie den obersten Knoten der 
Stammobjektstruktur in der Spalte "GSD-Datei" selektieren. 

6. Klicken Sie auf die Schaltfläche "Zuweisen".

Ergebnis
Die Feldgeräte werden den GSD-Objekten auf der Registerkarte "Orte" im Navigator 
zugeordnet. Wenn das GSD-Objekt noch nicht auf der Registerkarte "Orte" platziert war, wird 
es automatisch platziert und implementiert.

Wenn das Attribut GSD-Download-Pfad (GSDUri) vorhanden ist und kein GSD-Stammobjekt 
gefunden wird, werden zwei Schaltflächen eingeblendet. Über diese Schaltflächen rufen Sie 
das Plugin "Import" auf oder öffnen die Webseite zum Herunterladen der Dateien. So können 
Sie direkt Informationen aus PIA LCP nutzen und müssen diese nicht suchen.

13.7 Hardware-Engineering im Navigator

13.7.1 Neue physikalische Struktur durch Klicken mit der rechten Maustaste anlegen 

Einleitung
Die neue physische Struktur kann durch Klicken mit der rechten Maustaste im Register "Orte" 
(verfügbar für Schrank- und Feldortobjekt) erstellt werden. Gegenwärtig ist diese Funktionalität 
für die Stationen ET 200M, ET 200iSP, ET 200PA SMART und ET 200SP HA verfügbar.
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Vorgehen
1. Unter Objekt "Schrank" oder "Feldort" im Kontextmenü ET 200-Stationen wie im Bild unten 

hinzufügen.
Die Bilder sind hier beispielhaft für ET 200SP HA dargestellt.

2. Wählen Sie im Kontextmenü der ET 200 den Befehl "Neu > Profilschiene / Montageschiene 
> benötigte Schiene".
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3. Wählen Sie wie in der Abbildung unten gezeigt im Kontextmenü der Montageschiene "Neu 
> gewünschte Objekte" aus.

Hinweis

Die Struktur über die rechte Maustaste ist nur unter Schiene/Baugruppenträger und nicht 
bei den Terminalmodulen und Schnittstellenmodulen verfügbar.

4. Nachdem alle gewünschten Objekte hinzugefügt sind, klicken Sie zum Anlegen 
zusätzlicher Objekte (zum Beispiel Terminalmodul oder Trägermodul oder Klemmenblock 
oder aktiver Bus) im Kontextmenü der ET 200-Station auf "Busmodule erstellen" wie im 
folgenden Bild gezeigt.

Hinweis

Bei Ausführung des Befehls "Busmodule erstellen" werden die zusätzlichen Objekte in der 
richtigen Struktur angelegt.
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Die Struktur ist identisch mit der Struktur im Schaltschrank der Anlage.

① E/A mit neuer Potentialgruppe
② Standard-E/A
③ Redundante E/A
④ E/A für Klemmenblock doppelter Breite
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Hinweis

Falls zwischen den Steckplätzen Platz vorhanden ist (z. B. ein Modul in Steckplatz 4 und 
das nächste Modul in Steckplatz 7), werden zwischen den Modulen leere Terminal-/
Busmodule angelegt. Nur bei ET 200iSP können Reservemodule zusammen mit 
Terminalmodulen angelegt werden.

Hinweis
ET 200SP HA
● Unterstützt die Funktionen "Redundanter Partner", "Potentialgruppe" und 

"Klemmenblock doppelter Breite" für die Erstellung zusätzlicher Objekte wie 
Terminalmodule, Trägermodule usw. mit der Option "Busmodule erstellen".

● Bei Verwendung der Option "Busmodule erstellen" erscheinen Protokollmeldungen im 
Fenster "Objekttest", wenn ungültige Konfigurationen gefunden werden.

Benennen der Stromversorgung durch Klick mit der rechten Maustaste
Die Benennungen der Stromversorgungsobjekte für verschiedene ET 200-Stationen sind in 
der folgenden Tabelle dargestellt. Der Benutzer muss beim Erstellen der Objekte über die 
rechte Maustaste diese Namenskonventionen einhalten.

ET 200 Station Stromversorgung (SV) SV-Schild SV-Name
ET 200M Einzeln PS1 .2

Redundant PS1 .1
PS2 .2

ET 200PA SMART Einzeln PS1 .2
Redundant PS1 .1

PS2 .2
ET 200iSP Einzeln PS1 1

Redundant PS1 0
PS2 1

13.7.2 PROFINET und PROFIBUS
Sie haben die Möglichkeit sowohl PROFIBUS als auch PROFINET zu verwenden. In den 
folgenden Kapiteln wird in den Beispielen nur PROFINET erwähnt.
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Hinweise zu PROFINET
Die Verbindung der Busteilnehmer zu ihrem Master wird, genau wie bei PROFIBUS, über die 
Aufgaben "Feldbus zuweisen" und "Redundantem Feldbus zuweisen" durchgeführt. Zusätzlich 
zur funktionalen Zuordnung haben Sie die Möglichkeit eine MRP Konfiguration durchzuführen. 
Verwenden Sie dazu auf der Registerkarte "Attribute > Automation Interface" die folgenden 
Attribute:

● "MRP Domäne" 

● "MRP Rolle"

● "MRP-Diagnose 

Um das MRP Protokoll nutzen zu können, verbinden Sie die Anschlüsse der Echtgeräte in der 
gewünschten Reihenfolge.
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Beispiel
Das folgende Beispiel zeigt die verbundenen Anschlüsse der Echtgeräte in PAA.
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Im Topologie-Editor von PCS 7 sieht das Beispiel folgendermaßen aus:

13.7.3 SIMATIC Station konfigurieren

Voraussetzung
● Im Navigator wird die Registerkarte "Orte" angezeigt.

● Ein Werk ist angelegt.

SIMATIC-Station anlegen
1. Selektieren Sie im Navigator das Objekt "Werk > Gebäude > Geschoss, Etage > Raum, 

Zentrale".

2. Wählen Sie im Kontextmenü des Raums den Befehl "Neu > Schrank".
Der Schrank wird unter dem Raum angelegt.

3. Wählen Sie im Kontextmenü des Schranks den Befehl "Neu > Station > <gewünschte 
Station>".
Die Station wird unter dem Schrank angelegt.
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SIMATIC Station mit Hardware ausstatten
1. Selektieren Sie im Navigator die Station.

2. Wählen Sie im Kontextmenü der Station den Befehl "Neu > Rack > <gewünschter 
Baugruppenträger>".
Der Baugruppenträger dient zur Aufnahme der Baugruppen.

3. Wählen Sie im Kontextmenü des Baugruppenträgers unter "Neu > Stromversorgung" die 
gewünschte Stromversorgung.

4. Wählen Sie im Kontextmenü des Baugruppenträgers unter "Neu > Zentralbaugruppen" eine 
Zentralbaugruppe (CPU).

– Jede Zentralbaugruppe ist mit mindestens einem Submodul ausgestattet. Das 
Submodul wird automatisch mit angelegt.
Siehe auch Kapitel Zentralbaugruppe (CPU) konfigurieren (Seite 110).

– In Abhängigkeit der Zentralbaugruppe gilt: Legen Sie bei Bedarf unter der CPU weitere 
Module an, z. B. ein Schnittstellenmodul für ein Bussystem.

5. Wählen Sie im Kontextmenü des Baugruppenträgers unter "Neu" eine Eingabebaugruppe 
aus einem der folgenden Ordner:

– "Digitale Elektronikmodule" 

– "Analog Baugruppen"

– "Kommunikation"

– "Funktionsbaugruppen"

6. Wählen Sie im Kontextmenü des Baugruppenträgers unter "Neu" passend zur 
Eingabebaugruppe eine Ausgabebaugruppe aus einem der folgenden Ordner:

– "Digitale Elektronikmodule" 

– "Analog Baugruppen"

– "Kommunikation"

– "Funktionsbaugruppen"

7. Weisen Sie bei Bedarf dem Baugruppenträger den Ort zu, an dem der Baugruppenträger 
montiert ist.

Siehe auch
Schnittstellenmodule mit IO-Baugruppen ausstatten (Seite 111)
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13.7.4 Zentralbaugruppe (CPU) konfigurieren

Voraussetzung
● Eine SIMATIC-Station ist angelegt und mit Hardware ausgestattet.

● Im Baugruppenträger ist mindestens eine Zentralbaugruppe (CPU) angelegt.
Siehe Kapitel SIMATIC Station konfigurieren (Seite 108).

● Im Navigator wird die Registerkarte "Orte" angezeigt.

Vorgehen
1. Selektieren Sie im Navigator die Zentralbaugruppe (CPU).

2. Öffnen Sie die Eigenschaften der Zentralbaugruppe (CPU).

3. Tragen Sie im Feld "Name" den Wert entsprechend der Steckplatznummer der CPU im 
Baugruppenträger ein.
Die Steckplatznummer der CPU ist abhängig davon, wieviele Steckplätze die 
Stromversorgung belegt. Wenn die Stromversorgung nur einen Steckplatz belegt, tragen 
Sie den Wert "2" ein. Wenn die Stromversorgung zwei Steckplätze belegt, tragen Sie den 
Wert "3" ein.

Siehe auch
Projektieren der Hardware-Komponenten (Seite 90)

Schnittstellenmodul als dezentrale Peripherie anlegen (Seite 110)

13.7.5 Schnittstellenmodul als dezentrale Peripherie anlegen

Voraussetzung
● Eine SIMATIC-Station mit CPU und Bussystem ist angelegt.

Siehe Kapitel SIMATIC Station konfigurieren (Seite 108).

● Im Navigator wird die Registerkarte "Orte" angezeigt.

Vorgehen
1. Selektieren Sie das Planungsobjekt "Werk".

2. Wählen Sie im Kontextmenü des Objekts den Befehl "Neu > Feldort".
Der Feldort wird unter dem Objekt angelegt.

3. Wählen Sie im Kontextmenü des Feldorts den Befehl "Neu > Dezentrale Peripherie > 
<gewünschtes Objekt>".
Selektieren Sie zum Beispiel "Neu > Dezentrale Peripherie > ET200M".
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Siehe auch
Schnittstellenmodule mit IO-Baugruppen ausstatten (Seite 111)

Feldbus über Engineering-Aufgabe dem DP Slave zuweisen (Seite 118)

13.7.6 Schnittstellenmodule mit IO-Baugruppen ausstatten

Voraussetzung
● Die Schnittstellenmodule sind als dezentrale Peripherie angelegt.

Siehe Kapitel Schnittstellenmodul als dezentrale Peripherie anlegen (Seite 110).

● Im Navigator wird die Registerkarte "Orte" angezeigt.

Vorgehen
1. Selektieren Sie im Navigator das Schnittstellenmodul der dezentralen Peripherie.

Zum Beispiel:
"Werk > Feldort > (Schnittstellenmodul)"

2. Wählen Sie im Kontextmenü des Schnittstellenmoduls unter "Neu > Profilschienen > 
<gewünschte Profilschiene>". 

3. Wählen Sie im Kontextmenü der Profilschiene unter "Neu > Stromversorgungen" die 
gewünschte Stromversorgung.

4. Wählen Sie im Kontextmenü der Profilschiene unter "Neu > Interfacemodule" das 
gewünschte Modul.

5. Wählen Sie im Kontextmenü des Baugruppenträgers unter "Neu" eine Eingabebaugruppe 
aus einem der folgenden Ordner:

– "Digitale Elektronikmodule" 

– "Analog Baugruppen"

– "Kommunikation"

– "Funktionsbaugruppen"

Wählen Sie dazu eine mit "E" gekennzeichnete Baugruppe.

6. Wählen Sie im Kontextmenü des Schnittstellenmoduls unter "Neu" passend zur 
Eingabebaugruppe eine Ausgabebaugruppe aus einem der folgenden Ordner:

– "Digitale Elektronikmodule" 

– "Analog Baugruppen"

– "Kommunikation"

– "Funktionsbaugruppen"

Wählen Sie dazu passend zur Eingabebaugruppe eine mit "A" gekennzeichnete 
Baugruppe.
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Siehe auch
IO-Baugruppen konfigurieren (Seite 112)

13.7.7 IO-Baugruppen konfigurieren

Voraussetzung
● Die Zentralbaugruppe (CPU) ist konfiguriert

Siehe Kapitel Zentralbaugruppe (CPU) konfigurieren (Seite 110).

● Die Schnittstellenmodule der dezentralen Peripherie sind mit IO-Baugruppen ausgestattet.
Siehe Kapitel Schnittstellenmodule mit IO-Baugruppen ausstatten (Seite 111).

● Im Navigator wird die Registerkarte "Orte" angezeigt.

Vorgehen
1. Selektieren Sie im Navigator die Baugruppe unter dem Schnittstellenmodul.

2. Öffnen Sie die Eigenschaften der Baugruppe.

3. Tragen Sie im Feld "Name" den Wert entsprechend der Steckplatznummer im 
Schnittstellenmodul ein. Für die meisten Konfigurationen werden Werte ab "1" eingetragen.
Beispiel:

– Die Eingangsbaugruppe erhält den Namen "1".

– Die Ausgangsbaugruppe erhält den Namen "2".

Dadurch entsprechen die Namen der Signalmodule der jeweiligen Steckplatznummer im 
Schnittstellenmodul. Siehe auch Projektieren der Hardware-Komponenten (Seite 90).

13.7.8 Busmodule anlegen

Busmodule
Die Busmodule werden bei der Konfiguration von Peripheriebaugruppen im Plugin "HW-
Konfigurationswerkzeug" automatisch angelegt.

Wenn Sie die Peripheriebaugruppen manuell konfigurieren, müssen Sie die Busmodule über 
das Kontextmenü "Busmodule anlegen" unter dem Modul anlegen, nachdem Sie den 
Baugruppenträger und die Stromversorgung konfiguriert haben.
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13.7.9 Anlegen des Kompaktfeldgeräts (CFU)

Einleitung
Die folgenden Konfigurationen sind möglich:

● CFU (einzeln)

● CFU mit S2-Redundanz

Voraussetzungen
● Im Navigator wird die Registerkarte "Orte" angezeigt.

● Ein Werk ist angelegt, einschließlich des Schranks oder des Feldorts.

Anlegen eines CFU
1. Wählen Sie das Objekt "Werk > Gebäude > Geschoss, Etage > Raum, Zentrale > Schrank".

Oder
Wählen Sie Objekt "Werk > Neu > Feldort".
Der Schrank oder der Feldort werden entsprechend unter dem Werk angelegt.

2. Wählen Sie den Befehl "Neu > Dezentrale Peripherie > CFU" im Kontextmenü des 
Schranks oder des Feldorts.
Das CFU wird unterhalb des Schranks oder des Feldorts angelegt.

Siehe auch Kapitel Austausch der CFU mit PA-Slaves (Seite 171).

Hinzufügen der PROFIBUS PA-Slaves
●  PA-Profile / GSD-Slaves werden in PAA über die Engineering-Aufgabe mit dem CFU 

verbunden. 

●  Die PROFIBUS-Adresse des Slaves dient zur Identifikation der Steckplatznummer.

Hinweis
●  Wenn der Slave verbunden wird, wird die PROFIBUS-Adresse automatisch von 20 auf 27 

gesetzt.
● Um einen Steckplatz zu ändern, ändern Sie die PROFIBUS-Adresse manuell.

Die in PCS 7 verfügbaren PROFIBUS PA-Profile sind auch in PAA verfügbar, und zwar an 
folgendem Knoten:

@50|A20|A10|A20|A90|A10|A10|B30|A10|A20 Profibus PA-Profile

Ergebnis
  Die PA-Slave-Projektierung des CFU kann in PAA vorgenommen und an PCS 7 übertragen 
werden.
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13.7.10 Redundante SIMATIC-Station anlegen

Voraussetzung
● Im Navigator wird die Registerkarte "Orte" angezeigt.

● Ein Werk ist angelegt.

SIMATIC-Station anlegen
1. Wählen Sie im Navigator das Objekt "Werk > Gebäude > Geschoss, Etage > Raum, 

Zentrale".

2. Wählen Sie im Kontextmenü des Raums den Befehl "Neu > Schrank".
Der Schrank wird unterhalb des Raums angelegt.

3. Wählen Sie im Kontextmenü des Schranks eine Station aus, die für redundante Hardware 
vorbereitet ist.
Beispiel: "Neu > PLS > SIMATIC 400H Station".
Die Station wird unterhalb des Schranks angelegt.

SIMATIC-Station mit redundanter Hardware ausstatten
1. Wählen Sie im Kontextmenü der Station den Befehl "Neu > Rack > <gewünschter 

Baugruppenträger>".
Der Baugruppenträger dient zur Aufnahme der Baugruppen.
Beispiel: Wählen Sie einen Baugruppenträger des Typs UR2:
"Baugruppenträger, UR2"

Hinweis
Sonderregelung für UR2-H-Racks

Bei UR2-H-Racks werden alle Module der gesamten Station auf ein Rack gesteckt. Dieses 
UR2-H-Rack ist nur elektrisch in zwei Bereiche aufgeteilt, die Steckplätze an sich bieten 
Platz für zwei CPUs.
Aus diesem Grund werden die UR2H-Racks nicht als zwei Racks mit den Steckplätzen 1 bis 
9 nach PAA übertragen, sondern nur ein Rack mit den Steckplätzen 1 bis 18. Wobei die 
erste Hälfte der Steckplätze für die erste CPU, die zweite Hälfte für die zweite CPU 
vorgesehen ist. 

Sie müssen bei den UR2-H-Racks die Steckplatznummern entsprechend selbst anpassen.

2. Wählen Sie im Kontextmenü des Baugruppenträgers unter "Neu > Stromversorgung" eine 
Stromversorgung aus.

3. Wählen Sie im Kontextmenü des Baugruppenträgers unter "Neu > Zentralbaugruppen" eine 
Zentralbaugruppe (CPU).

4. Wählen Sie im Kontextmenü der CPU unter "Neu > Sync-Module zur Kopplung seit V6" ein 
Synchronisierungsmodul.
Im Feld "Name" der Synchronisierungsmodule steht die Slotnummer, die das 
Synchronisierungsmodul in der CPU belegt. 
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5. Wählen Sie im Kontextmenü des Baugruppenträgers unter "Neu" eine Eingabe- oder 
Ausgabebaugruppe aus einem der folgenden Ordner:
Wählen Sie dazu eine mit "E" oder "A" gekennzeichnete Baugruppe aus einem der 
folgenden Ordner: 

– "Digitalbaugruppen" 

– "Analogbaugruppen"

– "Kommunikation"

– "Funktionsbaugruppen"

6. Weisen Sie bei Bedarf dem Baugruppenträger den Ort zu, an dem der Baugruppenträger 
montiert ist.

7. Legen Sie den zweiten Baugruppenträger an. Gehen Sie dabei so vor, wie für den ersten 
Baugruppenträger beschrieben.

Siehe auch
Verwaltung von Einzelsteuereinheitstypen (Seite 31)

Redundante Peripherie anlegen (Seite 115)

13.7.11 Redundante Peripherie anlegen

Voraussetzung
● Zwei SIMATIC-Stationen für redundante Hardware sind angelegt.

Siehe Kapitel Redundante SIMATIC-Station anlegen (Seite 114).

● Im Navigator wird die Registerkarte "Orte" angezeigt.

Dezentrale Peripherie (DP Slave) anlegen
1. Selektieren Sie das Planungsobjekt "Werk".

2. Wählen Sie im Kontextmenü des Objekts den Befehl "Neu > Feldort".

3. Wählen Sie im Kontextmenü des Feldorts den Befehl "Neu > Dezentrale Peripherie > ET 
200M".

4. Wählen Sie im Kontextmenü des Schnittstellenmoduls unter "Neu > Profilschienen > 
<gewünschte Profilschiene>". 

5. Wählen Sie im Kontextmenü der Profilschiene unter "Neu > Interfacemodule > 
<Interfacemodul des Typs "IM 153-2 HF">".

6. Legen Sie unterhalb des Schnittstellenmoduls eine Baugruppe an. 

7. Legen Sie ein zweites Schnittstellenmodul des Typs "IM 153-2 HF" an.

Engineering in PAA
13.7 Hardware-Engineering im Navigator

Plant Automation Accelerator 3.0 SP1
Bedienhandbuch, 08/2019, A5E46351212-AB 115



8. Legen Sie unterhalb des Schnittstellenmoduls eine Baugruppe an. 

Hinweis
Ein-/Ausgabebaugruppen

Verwenden Sie nur Ein-/Ausgabebaugruppen mit gleicher Bestellnummer in analoger oder 
digitaler Ausführung.

9. Bestätigen Sie Ihre Eingaben. 

10.Öffnen Sie in den Eigenschaften der ersten Baugruppe die Registerkarte "Attribute > 
Automation Interface". 

11.Ziehen Sie die zweite Baugruppe per Drag&Drop aus dem Navigator in das Feld 
"Redundanter Partner". 

12.Bestätigen Sie Ihre Eingaben.

Ergebnis
Die zweite Baugruppe wird automatisch verknüpft und in ihren Eigenschaften auf der 
Registerkarte "Attribute > Automation Interface" der redundante Partner eingetragen.

Siehe auch
Redundanten Feldbus über Engineering-Aufgabe zuweisen (Seite 119)

13.7.12 DP/PA Koppler verwenden

Einleitung
Mit Hilfe des DP/PA Kopplers erreichen Sie eine bessere Trennung der Aufgaben, da Sie 
kleinere Subnetze innerhalb des Feldbussystems aufbauen.

Vorgehen
1. Legen Sie eine Station als Master an.

2. Legen Sie unter der Station alle benötigten Objekte inklusive eines Interfacemoduls an.

3. Um einen Slave anzulegen, verwenden Sie einen Netzübergang wie zum Beispiel einen DP/
PA Link.
Sie können im Kontextmenü des Schranks den folgenden Befehl verwenden: "Neu > 
Gateway – Geräte > DP/PA Link"

4. Legen Sie unterhalb des DP/PA Links eine Profilschiene an.

5. Legen Sie unterhalb der Profilschiene ein Interfacemodul vom Typ PAYLINK an.
Zum Beispiel "PAYLINK: 6ES7 153-2BA82-0XB0 IM153-2 HF".

6. Öffnen Sie in den Eigenschaften des Interfacemoduls die Registerkarte "Aufgaben".
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7. Ziehen Sie den PROFIBUS des Masters per Drag&Drop in das Feld "Zielobjekt" der 
Aufgabe "Feldbus zuweisen".

8. Führen Sie die Aufgabe aus.

9. Legen Sie ein neues Peripheriegerät aus der Gruppe ET 200 an.

10.Öffnen Sie in den Eigenschaften des ET 200 die Registerkarte "Aufgaben".

11.Ziehen Sie den Feldbus des DP/PA Links per Drag&Drop in das Feld "Zielobjekt" der 
Aufgabe "Feldbus zuweisen".

12.Führen Sie die Aufgabe aus.

Ergebnis
PAA unterscheidet nicht zwischen einer CPU oder CP und einem Slave (Netzübergang) als 
BUS-Master. 

Beim Generieren wird das Attribut "YLinkMode" am BUS-Master angelegt und entscheidet, 
welches BUS-Objekt verwendet wird. 

Hinweis
Nur ein Bussystem verwenden

Wenn Sie mit dem DP/PA-Koppler arbeiten, existieren zwei Bus-Objekte: Ein Profibus DP und 
ein Profibus PA. Verwenden Sie nur eines der BUS-Systeme.

13.7.13 Den IE/PB Link verwenden

Einleitung
PAA unterstützt die Anbindung von PROFIBUS DP-Geräten an ein PROFINET IO-System 
über einen IE/PB Link.

Vorgehen
1. Legen Sie eine Station als Master an.

2. Um einen Slave anzulegen, verwenden Sie einen Netzübergang wie zum Beispiel einen IE/
PB Link.
Sie können im Kontextmenü des Schranks den folgenden Befehl verwenden: "Neu > 
Gateway – Geräte > IE/PB Link"

3. Legen Sie unterhalb des IE/PB Links eine Profilschiene an.

4. Legen Sie unterhalb der Profilschiene einen IE/PB Link an.
Beispiel: "6GK1 411-5AB10 IE/PB LINK PN IO".

5. Öffnen Sie in den Eigenschaften des IE/PB Links die Registerkarte "Aufgaben".

6. Ziehen Sie den PROFINET des Masters per Drag&Drop in das Feld "Zielobjekt" der 
Aufgabe "Feldbus zuweisen".
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7. Führen Sie die Aufgabe aus.

8. Erstellen Sie einen neuen DP-Slave.

9. Öffnen Sie in den Eigenschaften des Slave die Registerkarte "Aufgaben".

10.Ziehen Sie den IE/PB Link-Feldbus des DP-Moduls per Drag&Drop in das Feld "Zielobjekt" 
der Aufgabe "Feldbus zuweisen".

11.Führen Sie die Aufgabe aus.

Ergebnis
Der IE/PB Link wird angelegt.

Hinweis

Beim IE/PB Link 6GK1 411-5AB10 ist es möglich, zusätzliche Busadapter aus dem 
Kontextmenü zu verwenden. In diesem Fall müssen Sie den integrierten Busadapter löschen.

13.8 Hardware-Engineering über Engineering-Aufgaben bearbeiten

13.8.1 Feldbus über Engineering-Aufgabe dem DP Slave zuweisen

Voraussetzung
● Das Hardware-Engineering im Navigator ist durchgeführt.

– Eine SIMATIC-Station ist angelegt und mit Hardware ausgestattet.

– Ein Schnittstellenmodul der dezentralen Peripherie ist mit IO-Baugruppen ausgestattet.

Siehe Kapitel Hardware-Engineering im Navigator (Seite 100).

● Im Navigator wird die Registerkarte "Orte" angezeigt.

Weiterführende Informationen zu diesem Thema finden Sie im Handbuch "EI&C Bedienung", 
Stichwort "Engineering-Aufgaben verwenden".

Bus zuweisen
Um das Schnittstellenmodul der dezentralen Peripherie einem Bus zuzuweisen, gehen Sie 
folgendermaßen vor:

1. Selektieren Sie im Navigator das Schnittstellenmodul.

2. Öffnen Sie die Eigenschaften des Schnittstellenmoduls.

3. Selektieren Sie die Registerkarte "Aufgaben > Bussystem". 
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4. Prüfen Sie, ob die Engineering-Aufgabe "Feldbus zuweisen" vorhanden ist.
Wenn die Engineering-Aufgabe "Feldbus zuweisen" fehlt, legen Sie diese über das 
Kontextmenü an.

5. Selektieren Sie im Navigator die SIMATIC-Station.

6. Erweitern Sie die Struktur unterhalb der SIMATIC-Station, bis der Bus angezeigt wird.
Die Struktur wurde in folgendem Schritt festgelegt: Siehe auch Kapitel SIMATIC Station 
konfigurieren (Seite 108).

7. Ziehen Sie das Objekt "PROFIBUS" oder ein ähnliches Objekt per Drag&Drop aus dem 
Navigator in die Spalte "Zielobjekt" in der Zeile "Feldbus zuweisen".

8. Klicken Sie in der Menüleiste der Registerkarte "Aufgaben > Bussystem" auf die 
Schaltfläche "Ausführen". 

Siehe auch
Redundanten Feldbus über Engineering-Aufgabe zuweisen (Seite 119)

Software-Engineering im Navigator (Seite 134)

13.8.2 Redundanten Feldbus über Engineering-Aufgabe zuweisen

Voraussetzung
● Das Hardware-Engineering im Navigator ist durchgeführt.

– Eine Station für redundante Hardware ist angelegt und mit Hardware ausgestattet.

– Die redundanten Schnittstellenmodule der dezentralen Peripherie sind mit IO-
Baugruppen ausgestattet.

Siehe Kapitel Hardware-Engineering im Navigator (Seite 100).

● Das Zuweisen eines Feldbusses über eine Enginnering-Aufgabe ist durchgeführt.
Siehe auch Kapitel Feldbus über Engineering-Aufgabe dem DP Slave zuweisen (Seite 118).

● Im Navigator wird die Registerkarte "Orte" angezeigt.

Weiterführende Informationen zu diesem Thema finden Sie im Handbuch "EI&C Bedienung", 
Stichwort "Engineering-Aufgaben verwenden".

Überblick 
● Das erste Teilsystem der Station wird mit der Engineering-Aufgabe "Feldbus zuweisen" 

über eine DP-Masterschnittstelle mit einer der beiden PROFIBUS DP-Schnittstellen 
verbunden.

● Das zweite Teilsystem der Station wird mit der Engineering-Aufgabe "Redundanter Feldbus 
zuweisen" mit der zweiten PROFIBUS DP-Schnittstelle verbunden.
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Vorgehen
1. Selektieren Sie im Navigator das erste Schnittstellenmodul.

2. Öffnen Sie die Eigenschaften des Schnittstellenmoduls.

3. Selektieren Sie die Registerkarte "Aufgaben > Bussystem".

4. Prüfen Sie, ob die Aufgabe "Feldbus zuweisen" vorhanden ist.
Wenn die Aufgabe "Feldbus zuweisen" fehlt, legen Sie diese Aufgabe über das 
Kontextmenü an.

5. Prüfen Sie, ob die Engineering-Aufgabe "Redundanten Feldbus zuweisen" vorhanden ist.
Wenn die Engineering-Aufgabe "Redundantem Feldbus zuweisen" fehlt, legen Sie diese 
Aufgabe über das Kontextmenü an.

6. Selektieren Sie im Navigator die Station.

7. Erweitern Sie die Struktur unterhalb der Station, bis der erste Bus angezeigt wird.

8. Ziehen Sie das Objekt "PROFIBUS" oder ein ähnliches Objekt per Drag&Drop aus dem 
Navigator in der Zeile "Feldbus zuweisen" in die Spalte "Zielobjekt".

9. Erweitern Sie die Struktur unterhalb der Station, bis der redundante Bus angezeigt wird.

10.Ziehen Sie das Objekt "PROFIBUS" oder ein ähnliches Objekt per Drag&Drop aus dem 
Navigator in die Spalte "Zielobjekt" in der Zeile "Redundanten Feldbus zuweisen".

11.Klicken Sie in der Registerkarte "Aufgaben > Bussystem" auf die Schaltfläche "Ausführen".

12.Bestätigen Sie Ihre Eingaben.

Hinweis

Bei redundanten ET 200SP HA weisen Sie alle vier zugewiesen Feldbusse zu.

Siehe auch
Software-Engineering im Navigator (Seite 134)
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13.9 Hardware-Engineering mit dem Konfigurationswerkzeug

13.9.1 HW-Konfigurationswerkzeug

Einleitung
Das Konfigurationswerkzeug dient dazu, verfügbare/freigegebene Hardwarekonfigurationen 
zusammenzustellen. Alle benötigten Komponenten werden miterzeugt. Die angewendeten 
Regeln sind kompatibel zu PCS 7 V9.0. Sie können das Plugin "HW-Konfigurationswerkzeug" 
zur Konfiguration verschiedener Peripheriebaugruppen wie ET 200M, ET 200iSP, ET 200PA 
SMART, ET 200SP HA, ET 200SP, AS Bundle, WS Bundle und PCS 7 BOX über das Menü 
"Plugins" oder wie unten dargestellt über das Symbol in der Symbolleiste nutzen. Dieses 
Werkzeug wird bei der Massendaten-Projektierung verwendet.
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Voraussetzung
Die erforderliche Version von PCS 7 wird gewählt, indem im Fenster "Eigenschaften" für das 
Projekt in den Kategorien "Kundeneinstellungen" die Option "Version selektieren" gewählt wird.

Hinweis

Es stehen nur die Baugruppen für die ausgewählte Version von PCS 7 zur Verfügung.

Vorgehen
In der nachstehenden Vorgehensweise wird das HW-Konfigurationswerkzeug ganz allgemein 
beschrieben.

● Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > HW-
Konfigurationswerkzeug" oder klicken Sie auf das Symbol in der Symbolleiste. 
Das Plugin "HW-Konfigurationswerkzeug" öffnet sich.

● Wählen Sie im Fenster "HW-Konfigurationswerkzeug" aus den verfügbaren Registerkarten 
die erforderliche Peripheriebaugruppe zur Konfiguration aus.

● Ziehen Sie das Zielobjekt per Drag&Drop aus dem Navigator in das Feld "Zielobjekt" im 
Bereich "Orte als Eigentümer festlegen".

● Wählen Sie die erforderlichen Interfacemodule und andere zur gewählten Baugruppe 
gehörigen Komponenten im Bereich "Allgemein" aus.

Hinweis
● Um eine redundante Stromversorgung oder redundante Interfacemodule zu erstellen, 

aktivieren Sie in den entsprechenden Feldern die Option "Redundant".
● Die Taste "Erstellen" ist nur verfügbar, wenn ein Baugruppenträger, eine 

Stromversorgung bzw. ein Interfacemodul ausgewählt ist.
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● Nehmen Sie die erforderliche E/A-Konfiguration abhängig von den zu konfigurierenden E/A 
im Bereich "E/A-Konfiguration" vor.

Hinweis

Ein Modul kann nur einmal ausgewählt werden.

– Gängige E/A-Einstellungen

– Standardmäßige E/A-Einstellungen

– Failsafe-Einstellungen

● Klicken Sie auf die Taste "Erstellen".
Nachdem der Slave erstellt wurde, wird im Statusfenster am unteren Rand eine Meldung mit 
der Anzahl der angelegten Stationen bzw. Fehler oder Warnungen angezeigt.

Hinweis
● Wenn die Taste "Erstellen" ein zweites Mal gedrückt wird, wird eine neue Station 

angelegt.
● WS Bundle und PCS 7 Box haben einen Online-Konfigurator, und es wird die 

Übersichtsseite in der Industry Mall geöffnet, weshalb eine Internetverbindung 
erforderlich ist.

● WS Bundle und PCS 7 Box können nach dem Anlegen im Werkzeug über das Menü in 
der Baumstruktur neu konfiguriert werden.

Ergebnis
Die konfigurierten E/A-Module werden unter dem ausgewählten Zielobjekt angelegt.

13.9.2 AS Bundle mit dem HW-Konfigurationswerkzeug konfigurieren

Voraussetzung
Das HW-Konfigurationswerkzeug ist geöffnet. Siehe auch Kapitel HW-
Konfigurationswerkzeug (Seite 121).
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Vorgehen
Das HW-Konfigurationswerkzeug dient zum Konfigurieren des AS Bundle wie nachfolgend 
beschrieben:

1. Wählen Sie die Registerkarte "AS Bundle" aus.

2. Ziehen Sie das Zielobjekt per Drag&Drop aus dem Navigator in das Feld "Zielknoten" im 
Bereich "Orte als Eigentümer festlegen".

3. Wählen Sie die erforderliche Version, den AS-Typ und die Anzahl im Bereich "Orte als 
Eigentümer festlegen" aus.
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4. Selektieren Sie die gewünschte Hardware. 
Empfehlung: Gehen Sie bei der Auswahl der Hardware auf der Registerkarte von oben nach 
unten vor, da sich die Listeneinträge abhängig von der bereits selektierten Hardware 
ändern.

Hinweis
● Die rot markierte Zeile kann nicht ausgewählt werden, da sie in der verwendeten 

Datenbank nicht verfügbar ist.
● Die Auswahl einer System Expansion Card und einer PROFIBUS-Verbindung ist 

obligatorisch, damit die Schaltfläche "Erstellen" aktiviert wird.

5. Klicken Sie auf die Taste "Erstellen".

Hinweis

Wenn die Taste "Erstellen" ein zweites Mal gedrückt wird, wird eine neue Station angelegt.

6. Im Anschluss finden Sie die HW unter der Ortestruktur im gewählten Zielknoten.

7. Zusätzlich wird die entsprechende MLFB erzeugt und als Zeile "MLFB" unterhalb der 
"Beschreibung" erzeugt.
Die MLFB finden Sie dann auch am "Objekt > Registerkarte "Attribute" > > Registerkarte 
"Bestelldaten" > Artikelnummer".

Ergebnis
Die Hardware einschließlich der benötigten Komponenten wird im Navigator unter dem als 
Zielobjekt definierten Ort angelegt. 

Beim Erzeugen der Hardware werden Regeln angewendet, die kompatibel zu PCS 7 HW 
Config sind.

13.9.3 ET 200-Stationen mit dem HW-Konfigurationswerkzeug konfigurieren

Voraussetzung
Die erforderliche Version von PCS 7 wird gewählt, indem im Fenster "Eigenschaften" für das 
Projekt in den Kategorien "Kundeneinstellungen" die Option "Version selektieren" gewählt wird.

Hinweis

Es stehen nur die Baugruppen für die ausgewählte Version von PCS 7 zur Verfügung.
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Vorgehen
Das HW-Konfigurationswerkzeug dient zum Konfigurieren der Peripheriebaugruppen der 
Familie ET 200 wie nachfolgend beschrieben:

1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > HW-
Konfigurationswerkzeug" oder klicken Sie auf das Symbol in der Symbolleiste. 
Das Plugin "HW-Konfigurationswerkzeug" öffnet sich.

2. Wählen Sie im Fenster "HW-Konfigurationswerkzeug" aus den verfügbaren Registerkarten 
die erforderliche Peripheriebaugruppe zur Konfiguration aus.
Das folgende Bild zeigt ein Beispiel eines ET 200SP HA.

3. Ziehen Sie das Zielobjekt per Drag&Drop aus dem Navigator in das Feld "Zielobjekt" im 
Bereich "Orte als Eigentümer festlegen".

4. Wählen Sie die erforderlichen Interfacemodule und andere Komponenten im Bereich 
"Allgemein" aus.
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5. Nehmen Sie die erforderliche E/A-Konfiguration im Bereich "E/A-Konfiguration" vor.

Hinweis
Allgemeine E/A-Einstellungen
● Ein Modul kann nur einmal ausgewählt werden
● Gängige E/A-Einstellungen (alle Peripheriebaugruppen)
● Standardmäßige E/A-Einstellungen (ET 200M, ET 200iSP, ET 200SP HA, ET 200SP)
● Fehlersichere E/A-Einstellungen (ET 200M, ET 200iSP, ET 200SP)
● Redundante Peripherie (ET 200SP HA)
● Klemmenblock doppelter Breite (ET 200SP HA)
● E/A-Konfiguration ET 200PA SMART und ET 200M (ET 200PA SMART)

6. Klicken Sie auf die Taste "Erstellen".
Nachdem der Slave erstellt wurde, wird im Statusfenster am unteren Rand eine Meldung mit 
der Anzahl der angelegten Stationen bzw. Fehler oder Warnungen angezeigt.

Hinweis

Wenn die Taste "Erstellen" ein zweites Mal gedrückt wird, wird eine neue Station angelegt.

Weitere Informationen zu ET 200-Stationen entnehmen Sie den nachfolgenden Tabellen.

Von ET 200-Stationen unterstützte Redundanz

 ET 200M ET 200iSP ET 200PA 
SMART

ET 200SP 
HA

ET 200SP

Stromversor‐
gung

Unterstützt Unterstützt Unterstützt Nicht zutref‐
fend

Nicht zutreffend

Interfacemodul Unterstützt bei 
PROFIBUS IM

Unterstützt Unterstützt Unterstützt Nicht zutreffend

E/A-Modul Nicht unter‐
stützt

Nicht zutreffend Nicht unter‐
stützt

Unterstützt Nicht unter‐
stützt

Schaltfläche "Erstellen" im HW-Konfigurationswerkzeug aktivieren 
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Der Anwender muss die folgenden Details für ET 200-Stationen ausfüllen:

  ET 200M ET 200iSP ET 200PA 
SMART

ET 200SP 
HA

ET 200SP

 Zielobjekt Erforderlich Erforderlich Erforderlich Erforderlich Erforderlich
 
 
 

Allgemein

Baugrup‐
penträger

Erforderlich Erforderlich Erforderlich Erforderlich Erforderlich

Stromver‐
sorgung

Erforderlich Erforderlich Erforderlich Nicht zutref‐
fend

Nicht zutref‐
fend

Interface‐
modul

Erforderlich Erforderlich Erforderlich Erforderlich Erforderlich

Frontste‐
cker

Erforderlich Nicht zutref‐
fend

Nicht zutref‐
fend

Nicht zutref‐
fend

Nicht zutref‐
fend

Busadap‐
ter

Nicht zutref‐
fend

Nicht zutref‐
fend

Nicht zutref‐
fend

Erforderlich Erforderlich 
bei PROFI‐
NET IM

E/A-Konfigu‐
ration

Peripherie‐
baugrup‐
pen (belie‐
bige)

Erforderlich Erforderlich Erforderlich Erforderlich Erforderlich

Ergebnis
Die konfigurierten E/A-Module werden unter dem ausgewählten Zielobjekt angelegt.

Anlegen von Bundles beim Anlegen der ET 200M-Station
Sie können beim Anlegen der ET 200M-Station über das HW-Konfigurationswerkzeug Bundle-
Informationen generieren, um die Beschaffungsabteilung zu unterstützen, die Stückliste mit 
der richtigen Artikelnummer anzulegen.

Siehe auch Kapitel Stückliste (Seite 190).

Vorgehen
1. Doppelklicken Sie auf die ET 200M-Station und navigieren Sie zu "Attribute > Bestelldaten", 

um die Bundle-Artikelnummer im Feld "Artikelnummer" und die Bundle-Beschreibung im 
Feld "Kommentar" anzuzeigen.

2. Doppelklicken Sie auf die Bundle-Komponenten und navigieren Sie zu "Attribute > 
Bestelldaten > Artikelnummer", um die "Artikelnummer" der entsprechenden Komponente 
im Bundle anzuzeigen.

3. Doppelklicken Sie auf die ET 200M-Station und navigieren Sie zu "Attribute > Bundle-
Erkennung", um die Artikelnummern sämtlicher Komponenten im Bundle anzuzeigen.

4. Klicken Sie mit der rechten Maustaste auf den Schrank und wählen Sie "Neu > Stückliste – 
mit Bundles", um die Stückliste zu generieren.
Sie können die Stückliste mit oder ohne Bundles anlegen.
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Hinweis
● Das Kontrollkästchen "Bundle" ist für die ET 200M-Station und die Bundle-Komponenten 

standardmäßig aktiviert.
● Wenn das Kontrollkästchen "Bundle" an einem Bundle-Element oder an der Station 

deaktiviert wird, werden alle Bundle-Kontrollkästchen deaktiviert.

Die Details des ET 200M-Bundles wie Bundle-Artikelnummer, Bundle-Beschreibung und 
Bundle-Komponenten sind am Standard-Tabellenknoten Y10|X01|A10|X01N00022 ET200M 
Bundles verfügbar.
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13.9.4 WS Bundle mit dem HW-Konfigurationswerkzeug konfigurieren

Vorgehen
Das HW-Konfigurationswerkzeug dient zum Konfigurieren des WS Bundle wie nachfolgend 
beschrieben:

1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > HW-
Konfigurationswerkzeug" oder klicken Sie auf das Symbol in der Symbolleiste. 
Das Plugin "HW-Konfigurationswerkzeug" öffnet sich.

2. Wählen Sie die Registerkarte "WS Bundle" aus.

3. Ziehen Sie das Zielobjekt per Drag&Drop aus dem Navigator in das Feld "Zielobjekt" im 
Bereich "Orte als Eigentümer festlegen".

4. Wählen Sie im Bereich "Konfiguration auswählen" den Industrial PC und die Anzahl aus.
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5. Klicken Sie auf die Schaltfläche "SIMATIC WS Bundle Online-Konfigurator starten", um die 
Online-Konfigurierung durchzuführen.

Hinweis

Das System muss für die Online-Konfiguration über "SIMATIC WS Bundle Online-
Konfigurator starten" mit dem Internet verbunden sein.

6. Wählen Sie im Bereich "Zusätzliche Elemente" alle weiteren erforderlichen Komponenten 
aus.

7. Klicken Sie auf die Taste "Erstellen".

Hinweis

Wenn die Taste "Erstellen" ein zweites Mal gedrückt wird, wird eine neue Station angelegt.

Hinweis

Wählen Sie im Kontextmenü der angelegten WS Bundle-Hardware "Konfiguration 
aktualisieren" aus, um die Konfiguration zu aktualisieren, nachdem Sie die Komponenten in der 
Hardware hinzugefügt/geändert haben.

Ergebnis
Die konfigurierten WS Bundles werden unter dem ausgewählten Zielobjekt angelegt.

13.9.5 PCS 7 Box mit dem HW-Konfigurationswerkzeug konfigurieren

Vorgehen
Das HW-Konfigurationswerkzeug dient zum Konfigurieren des WS Bundle wie nachfolgend 
beschrieben:

1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > HW-
Konfigurationswerkzeug" oder klicken Sie auf das Symbol in der Symbolleiste. 
Das Plugin "HW-Konfigurationswerkzeug" öffnet sich.

2. Wählen Sie die Registerkarte "PCS 7 Box".

3. Ziehen Sie das Zielobjekt per Drag&Drop aus dem Navigator in das Feld "Zielobjekt" im 
Bereich "Orte als Eigentümer festlegen".

4. Klicken Sie auf die Schaltfläche "SIMATIC PCS 7 Box Online-Konfigurator starten", um die 
Online-Konfigurierung durchzuführen.

Hinweis

Das System muss für die Online-Konfiguration über "SIMATIC PCS 7 Box Online-
Konfigurator starten" mit dem Internet verbunden sein.
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5. Die Webseite für die Konfigurierung wird wie in der nachfolgenden Abbildung gezeigt 
geöffnet. Nehmen Sie die erforderliche Konfigurierung vor und klicken Sie auf die 
Registerkarte "Ergebnis", um die Konfigurationsdetails anzuzeigen.

6. Klicken Sie auf die Schaltfläche "In COMOS zurückschreiben". Daraufhin wird die Webseite 
geschlossen und wieder das Fenster des HW-Konfigurationswerkzeugs angezeigt.
Die Konfiguration wird gespeichert.

7. Wählen Sie im Bereich "Zusätzliche Elemente" alle weiteren erforderlichen Komponenten 
aus.

8. Klicken Sie auf die Taste "Erstellen".

Hinweis

Wenn die Taste "Erstellen" ein zweites Mal gedrückt wird, wird eine neue Station angelegt.
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Hinweis

Wählen Sie im Kontextmenü der angelegten PCS 7 Box-Hardware "Konfiguration 
aktualisieren" aus, um die Konfiguration zu aktualisieren, nachdem Sie die Komponenten in der 
Hardware hinzugefügt/geändert haben.

Ergebnis
Der konfigurierte PCS 7 Box wird unter dem ausgewählten Zielobjekt angelegt.

13.10 Erweiterte Hardware-Parameter

Konfiguration
Über das Automation Interface werden die Hardware-Konfiguration und die erweiterten 
Hardware-Parameter übertragen. Der Datenaustausch der erweiterten Hardware-Parameter 
ist aktivierbar/deaktivierbar, wenn z. B. aus Leistungsgründen nicht alle erweiterten Hardware-
Parameter am Datenaustausch teilnehmen sollen. Sie haben zwei Möglichkeiten, um den 
Austausch der erweiterten Hardware-Parameter zu steuern:

● In PAA entscheiden Sie, ob Sie die erweiterten Hardware-Parameter während der 
Übertragung beim Import/Export verwenden möchten. Aktivieren oder deaktivieren Sie 
dazu im Plugin "Import/Export PCS 7" in der Kontrollgruppe "Filter" die Option "Projekt > 
Hardware > Erweiterte Parameter". Siehe auch Kapitel Austausch der HW-Konfiguration 
(Seite 170).

● In der XML-Steuerdatei "AIaS7ExtHWParameter.xml" definieren Sie, welche Hardware-
Parameter am Datenaustausch teilnehmen. 
 Diese Datei liegt im Verzeichnis "Program Files (x86)\SIEMENS\STEP7\S7DATA
\AIS7AD".
In dieser XML-Datei ist für jeden Hardware-Parameter ein Eintrag vorhanden, der mit dem 
Ausdruck "<HWParameter name" beginnt. In diesem Eintrag befindet sich der Ausdruck 
"used", über den der Datenaustausch dieses Hardware-Parameters gesteuert wird. 

– Wenn der Ausdruck "used="1"" ist, ist der Datenaustausch dieses Hardware-
Parameters aktiviert. 

– Wenn der Ausdruck "used="0"" ist, ist der Datenaustausch dieses Hardware-
Parameters deaktiviert.

Hinweis
Funktionsumfang

Die erweiterten Hardware-Parameter sind in PAA nur an den in der Datenbank ausgelieferten 
Baugruppen verfügbar. Das ist in PAA an der Registerkarte "Automation erweitert" sichtbar. Es 
werden zudem keine erweiterten Parameter an F-Baugruppen unterstützt.
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Hinweis
Standardwerte beim Export

Bei Verwendung der erweiterten Hardwareparameter werden die Standardwerte nicht für das 
Attribut gesetzt. Wenn Sie die Standardwerte aus PCS 7 verwenden möchten, führen Sie einen 
Import aus PCS 7 durch.

Hinweis
Keine automatische Konsistenzprüfung bei der Hardwarekonfiguration  

In PAA wird keine Konsistenzprüfung der eingestellten HW Parameter durchgeführt. Dies hat 
zur Folge, dass Konfigurationen übertragen werden können, die im SIMATIC HW Konfigurator 
inkonsistent sind.

Hinweis
Inkonsistenzen bei der Zuordnung von Kanälen  

In PAA stehen die Limits für Kanal 0 (Kanalgruppe 0-1) richtig in Kanal 0.
Für Kanal 2 (Kanalgruppe 2-3) entgegen der Zuordnung in PCS 7 in PAA an Kanal 1. Die Limits 
an Kanal 1 werden nach PCS 7 in Kanal 2 (Kanalgruppe 2-3) übertragen.

13.11 Software-Engineering im Navigator

13.11.1 Hinweise zur technologischen Hierarchie

Voraussetzung
● Die Projektvorgabe für PCS 7 ist verwendet.

Siehe Kapitel Planungsprojekt öffnen (Seite 22).

● Die DCS Struktur ist angelegt.
Siehe Kapitel DCS-Struktur anlegen (Seite 22).

Engineering in PAA
13.11 Software-Engineering im Navigator

Plant Automation Accelerator 3.0 SP1
134 Bedienhandbuch, 08/2019, A5E46351212-AB



PAA-Struktur im Vergleich mit der technologischen Hierarchie in PCS 7
In PCS 7 kann die technologische Hierarchie bis zu 8 Ebenen enthalten. In diesem Beispiel 
wird eine 4-stufige technologische Hierarchie verwendet: 

① Werk
Bestandteil der technologischen Hierarchie.

② Anlage
Bestandteil der technologischen Hierarchie.

③ Teilanlage
Bestandteil der technologischen Hierarchie.

④ Ordner
COMOS-spezifisches Strukturelement.

⑤ Position
Bestandteil der technologischen Hierarchie.

⑥ COMOS-Messstelle

Siehe auch
Optional: Messstellen anlegen und konfigurieren (Seite 136)

13.11.2 Mit Kanalanforderungen arbeiten

Voraussetzung
● Das Hardware-Engineering ist durchgeführt.

Siehe auch Kapitel Hardware-Engineering über Engineering-Aufgaben bearbeiten 
(Seite 118).

● Die DCS Struktur ist angelegt.
Siehe auch Kapitel DCS-Struktur anlegen (Seite 22).
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● Mindestens eine Instanz eine Einzelsteuereinheit wurde in der DCS Struktur angelegt.

● Die Instanz der Einzelsteuereinheit enthält ein Signal. 
Wenn Sie die Signale über das Plugin "Excel Import" angelegt haben, sind die Signale 
bereits verknüpft.

Vorgehen
1. Selektieren Sie im Navigator die Instanz der Einzelsteuereinheit in der DCS Struktur.

2. Navigieren Sie unterhalb des Signals unter der Instanz der Einzelsteuereinheit zur 
Kanalanforderung.

3. Öffnen Sie die Eigenschaften der Kanalanforderung.

4. Implementieren Sie die Kanalanforderung zum I/O Kanal.

13.11.3 Optional: Messstellen anlegen und konfigurieren

Voraussetzung
● Die technologische Hierarchie ist bekannt.

Siehe Kapitel Hinweise zur technologischen Hierarchie (Seite 134).

● Im Navigator wird die Registerkarte "Anlagen" angezeigt.

Messstellen anlegen und konfigurieren
Weiterführende Informationen zum Anlegen und Konfigurieren von Messstellen finden Sie im 
Handbuch "EI&C Bedienung", Stichwort "Basic Engineering". 

Im Einzelnen sind folgende Arbeitsschritte erforderlich:

1. Ordner "A50 EI&C" selektieren.

2. Position anlegen.

3. Messstelle anlegen.

4. Keine Funktionsvorlage verwenden.

5. Unterhalb der Funktion den Ordner "A20 Signalplanung" selektieren.

6. Signale anlegen.

7. Für jedes Signal die Kanalanforderung "Kanalanforderungen für Steuerung" anlegen. 
Diese Kanalanforderung dient dazu, das Signal mit dem DP Slave zu verknüpfen.

Siehe auch
Optional: Hardware und Software verknüpfen: Kanäle implementieren (Seite 137)
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13.11.4 Optional: Hardware und Software verknüpfen: Kanäle implementieren

Voraussetzung
● Das Hardware-Engineering ist durchgeführt.

Siehe Kapitel Hardware-Engineering über Engineering-Aufgaben bearbeiten (Seite 118).

● Die Messstellen sind angelegt und konfiguriert.
Siehe Kapitel Optional: Messstellen anlegen und konfigurieren (Seite 136).

Vorgehen
1. Selektieren Sie im Navigator auf der Registerkarte "Anlagen" im Ordner "A50 EI&C > A20 

Signalplanung" das Signal.

2. Öffnen Sie die Eigenschaften des Signals.

3. Selektieren Sie im Navigator die Registerkarte "Orte".

4. Selektieren Sie unterhalb der dezentralen Peripherie eine Peripheriebaugruppe.

5. Ziehen Sie einen Kanal des Schnittstellenmoduls per Drag&Drop aus dem Navigator in das 
Feld "Implementierung" in den Eigenschaften der Kanalanforderung.

6. Bestätigen Sie Ihre Eingaben.

Kanäle massenhaft implementieren
Wenn Sie die Kanäle massenhaft implementieren möchten, verwenden Sie das Plugin "Excel 
Import". Siehe auch Kapitel Ziel des Excel-Imports (Seite 71).

Siehe auch
Software-Engineering per Engineering-Aufgaben bearbeiten (Seite 137)

13.12 Software-Engineering per Engineering-Aufgaben bearbeiten

13.12.1 Engineering-Aufgaben

Zielsetzung
Mithilfe einer Engineering-Aufgabe wird eine Einzelsteuereinheit aus einer Vorlage generiert 
und wie folgt unter einer Position angelegt. 

Weiterführende Informationen zu diesem Thema finden Sie im Handbuch "EI&C Bedienung", 
Stichwort "Engineering-Aufgaben verwenden".
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Siehe auch
Registerkarte "SW-Schnittstelle" einblenden und Aufgaben anlegen (Seite 138)

13.12.2 Registerkarte "SW-Schnittstelle" einblenden und Aufgaben anlegen

Voraussetzung
● Das Software-Engineering ist durchgeführt.

Siehe Kapitel Software-Engineering im Navigator (Seite 134).

● Im Navigator wird die Registerkarte "Anlagen" angezeigt.

Registerkarte "SW-Schnittstelle" einblenden 
1. Selektieren Sie im Navigator auf der Registerkarte "Anlagen" einen Ordner der DCS 

Struktur. 

2. Öffnen Sie die Eigenschaften des Ordners.

3. Selektieren Sie die Registerkarte "Aufgaben".

4. Wenn die Registerkarte "SW-Schnittstelle" nicht vorhanden ist, schließen Sie das Fenster 
mit den Ordnereigenschaften.

5. Wählen Sie im Kontextmenü "Neu > "CMT-Vorlage" aus.

6. Öffnen Sie die Eigenschaften des Ordners.
Die Registerkarte "SW-Schnittstelle" wird geöffnet.

Aufgaben prüfen und anlegen
1. Selektieren Sie die Registerkarte "Aufgaben > SW-Schnittstelle".

2. Überprüfen Sie, ob folgende Engineering-Aufgabe verfügbar ist:

– "Zugewiesene Station"

3. Erstellen Sie die fehlende Aufgabe über das Kontextmenü "Neu".

Siehe auch
Einzelsteuereinheitstyp der DCS Struktur zuordnen (Seite 139)

Einzelsteuereinheitstyp einer Funktion zuordnen (Seite 140)

Engineering-Aufgaben (Seite 137)
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13.12.3 Einzelsteuereinheitstyp der DCS Struktur zuordnen

Voraussetzung
● Das Hardware-Engineering ist durchgeführt.

Siehe Kapitel Hardware-Engineering über Engineering-Aufgaben bearbeiten (Seite 118).

● Die Registerkarte "SW-Schnittstelle" eines Ordners der DCS Struktur wird angezeigt und 
die Aufgaben sind angelegt.
Siehe Kapitel Registerkarte "SW-Schnittstelle" einblenden und Aufgaben anlegen 
(Seite 138).

● Im Navigator wird die Registerkarte "Anlagen" angezeigt.

Aufgabe konfigurieren und ausführen
1. Selektieren Sie im Navigator den Knoten "Kopiervorlagen".

2. Selektieren Sie das folgende Objekt:
"@Template > @PCS 7 > Template-Container > CMTs Einzelsteuereinheits-Typen".

3. Selektieren Sie im Ordner "CMTs" die Kopiervorlage einer Einzelsteuereinheit.

4. Ziehen Sie die Kopiervorlage per Drag&Drop aus dem Navigator in das Feld "Zielobjekt" in 
der Zeile "Einzelsteuereinheit einkopieren" .

5. Klicken Sie in der Menüleiste der Registerkarte "SW-Schnittstelle" auf den Pfeil der 
Schaltfläche "Ausführen".

6. Wählen Sie den Eintrag "Ausführen (selektierte)".

7. Bestätigen Sie Ihre Eingaben.
Ausgeführte Aufgaben werden in der Spalte "Status" mit einer grünen Ampel 
gekennzeichnet.

Ergebnis
● Die einkopierte Einzelsteuereinheit wird in der Navigatorstruktur unterhalb des Ordners der 

DCS Struktur angezeigt. Siehe auch Kapitel Hinweise zur technologischen Hierarchie 
(Seite 134).

● Unterhalb der einkopierten Einzelsteuereinheit gibt es eine Verknüpfungstabelle. Siehe 
auch Kapitel Verknüpfungstabelle der Signalbezeichnungen konfigurieren (Seite 161).

Siehe auch
Einzelsteuereinheitstyp einer Funktion zuordnen (Seite 140)
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13.12.4 Einzelsteuereinheitstyp einer Funktion zuordnen

Voraussetzung
● Das Hardware-Engineering ist durchgeführt.

Siehe Kapitel Hardware-Engineering über Engineering-Aufgaben bearbeiten (Seite 118).

● Die Registerkarte "SW-Schnittstelle" einer Funktion wird angezeigt und die Aufgaben sind 
angelegt.
Siehe Kapitel Registerkarte "SW-Schnittstelle" einblenden und Aufgaben anlegen 
(Seite 138).

● Im Navigator wird die Registerkarte "Anlagen" angezeigt.

Vorgehen
1. Ordnen Sie die Einzelsteuereinheit einer Funktion zu.

Siehe auch Kapitel Einzelsteuereinheitstyp der DCS Struktur zuordnen (Seite 139).

2. Bestätigen Sie Ihre Eingaben.
Ausgeführte Aufgaben werden in der Spalte "Status" mit einer grünen Ampel 
gekennzeichnet.

Ergebnis
● Die einkopierte Einzelsteuereinheit wird in der Navigatorstruktur unterhalb der Funktion 

angezeigt. Siehe dazu die Übersicht in Hinweise zur technologischen Hierarchie 
(Seite 134).

● Unterhalb der einkopierten Einzelsteuereinheit gibt es eine Verknüpfungstabelle. Die 
Verknüpfungstabelle wird vom Administrator bearbeitet. Siehe auch 
Kapitel Verknüpfungstabelle der Signalbezeichnungen konfigurieren (Seite 161).

13.12.5 Einzelsteuereinheitstyp massenhaft der DCS Struktur zuordnen

Voraussetzung
● Das Hardware-Engineering ist durchgeführt.

Siehe Kapitel Hardware-Engineering über Engineering-Aufgaben bearbeiten (Seite 118).

● Im Navigator wird die Registerkarte "Anlagen" angezeigt.

Massenbearbeitung von Aufgaben 
1. Selektieren Sie einen Ordner der technischen Hierarchie in der DCS Struktur.

2. Öffnen Sie die Eigenschaften des Ordners.

3. Selektieren Sie die Registerkarte "Aufgaben".
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4. Stellen Sie sicher, dass die Registerkarte "SW-Schnittstelle" angezeigt wird und die 
Aufgaben angelegt sind.
Siehe Kapitel Registerkarte "SW-Schnittstelle" einblenden und Aufgaben anlegen 
(Seite 138).

5. Selektieren Sie die Registerkarte "SW-Schnittstelle" und gehen Sie vor, wie hier 
beschrieben:
Einzelsteuereinheitstyp der DCS Struktur zuordnen (Seite 139) 
Die Aufgabe erfasst alle Einzelsteuereinheitstypen unterhalb des selektierten Ordners.

13.13 Plugin "Baugruppen Updater"

13.13.1 Typ-Verwendungen aktualisieren

Einleitung
Mit dem Plugin "Baugruppen Updater" übernehmen Sie Änderungen der Typen an bereits 
angelegten Instanzen von Technischen Einrichtungen (EMs), Einzelsteuereinheiten (CMs) 
und Funktionen. Dabei haben Sie die Möglichkeit, die Änderungen in eine Arbeitsschicht zu 
speichern.

Voraussetzung
Sie haben bereits Instanzen von CMs, EMs und Funktionen angelegt. 

In der Auswahlliste "Eigenschaftenzuordnung PCS 7" sind Attribute definiert, die nicht 
überschrieben werden sollen. Siehe auch Kapitel Auswahlliste "X01N00020 Assembly 
Updater Eigenschaftenzuordnung PCS 7" (Seite 207).

Vorgehen
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > Baugruppen Updater".

2. Ziehen Sie per Drag&Drop den geänderten Typ aus dem Knoten "Kopiervorlagen" im 
Navigator in das Feld "Aktualisierte Vorlage".

3. Klicken Sie in der Menüleiste des Plugin auf die Schaltfläche "Aktualisieren".
In der Kontrollgruppe "Strukturunterschiede" wird ein Baum mit der Vorlage angezeigt.

4. Selektieren Sie in der Tabelle der Kontrollgruppe "Verwendungen in Projekten" einen 
Eintrag.

– Der Vorlagenbaum in der Kontrollgruppe "Strukturunterschiede" wird eingefärbt. Die 
Farben signalisieren, wie die selektierte Verwendung von der Vorlage abweicht. Dabei 
gelten die Farbvorgaben der Legende.

– Objekte, die in der Verwendung nicht geändert wurden, werden im Vorlagenbaum nicht 
angezeigt. Um sie einzublenden, aktivieren Sie die Option "Unveränderte Objekte 
anzeigen".
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5. Um die angezeigten Änderungen der Typen an die Instanzen zu übernehmen, klicken Sie 
auf die Schaltfläche "Aktualisierung".
Ein Dialog öffnet sich. 

6. Optional: Wählen Sie eine der folgenden Möglichkeiten:

– Um die Änderungen in eine neue Arbeitsschicht zu speichern, aktivieren Sie die Option 
"Arbeitsschicht anlegen" und geben Sie der Arbeitsschicht einen Namen.

– Um die vorhandenen Verknüpfungstabellen an den Instanzen mit der 
Verknüpfungstabelle des Typen zu überschreiben, aktivieren Sie die Option 
"Verknüpfungstabelle überschreiben". 

7. Bestätigen Sie Ihre Eingaben.

Unterlagerte Einzelsteuereinheit aktualisieren
Um Änderungen an einer unterlagerten Einzelsteuereinheit an die Instanzen einer 
Technischen Einrichtung (Typ) zu übernehmen, gehen Sie folgendermaßen vor:

1. Öffnen Sie das Plugin.

2. Ziehen Sie per Drag&Drop die geänderte unterlagerte Einzelsteuereinheit aus dem Knoten 
"Kopiervorlagen" im Navigator in das Feld "Aktualisierte Vorlage".

3. Aktualisieren Sie nach der zuvor beschriebenen Vorgehensweise die Verwendung der 
unterlagerten Einzelsteuereinheit.

4. Bestätigen Sie Ihre Eingaben.

5. Ziehen Sie per Drag&Drop die aktualisierte Einzelsteuereinheit (Typ) aus dem Knoten 
"Kopiervorlagen" im Navigator in das Feld "Aktualisierte Vorlage".

6. Aktualisieren Sie nach der zuvor beschriebenen Vorgehensweise die Instanzen der 
Einzelsteuereinheit (Typ).

13.13.2 Verwendungen / Instanzen aktualisieren

Ausgangslage
Eine Kopiervorlage, die in Ihrem Planungsprojekt verwendet wird, wurde geändert

Zielsetzung
Die von der Kopiervorlage abgeleiteten Verwendungen sollen die Änderungen übernehmen. 
Für die Projektierung wichtige Daten aus den alten Objekten können im Planungsprojekt 
beibehalten oder überschrieben werden. 

Sie haben die Möglichkeit zur besseren Kontrolle der Auswirkungen die resultierenden 
Änderungen zunächst in einer Arbeitsschicht durchzuführen.
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Voraussetzungen
Sie haben Leserechte im Knoten "@Template".

Vorgehen
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > Kopiervorlagen > 

Baugruppen Updater":

2. Navigieren Sie im Knoten "@Template" zu dem Vorlagenobjekt – dem Objekt, unter dem die 
Kopiervorlage liegt.

3. Ziehen Sie das Kopiervorlagenobjekt in das Feld "Aktualisierte Kopiervorlage".
Änderungen, die relevant sind für eine Aktualisierung der Instanzen werden automatisch 
ausgewertet und angezeigt. Zu jeder Instanz wird der Eigentümer der Engineering Aufgabe 
angezeigt, der die Instanz erzeugt hat.

4. Klicken Sie auf die Schaltfläche "Aktualisieren".

5. Bestätigen Sie Ihre Eingaben.

Siehe auch Kapitel Typ-Verwendungen aktualisieren (Seite 141).

Regeln für den Abgleich ändern
Der Anwender kann die Regeln ändern, wenn die Daten in der Instanz überschrieben werden 
sollen. Siehe auch Kapitel Auswahlliste "X01N00020 Assembly Updater 
Eigenschaftenzuordnung PCS 7" (Seite 207).

13.13.3 Aktualisieren von CM unterhalb von EM/EMT

Einleitung
Die CMs und die Objekte darunter, die unterhalb von EM/EMT angelegt wurden, können im 
Baugruppen Updater aktualisiert werden. Der Baugruppen Updater kann auch zum 
Aktualisieren von EM-Instanzen und Objekten darunter verwendet werden.

Voraussetzung
● CMs und einige Objekte sind unterhalb der EMT angelegt Siehe auch 

Kapitel Einzelsteuereinheiten anlegen (Seite 32).

● CMs sind mit Hilfe eines vorhandenen CMT unterhalb von EMT angelegt

● CMs und ihre Objekte bearbeiten

● EM-Instanzen sind angelegt
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Aktualisierung neu angelegter CMs unter EM 
1. Öffnen Sie das Plugin "Baugruppen Updater".

2. Ziehen Sie den EMT in das Feld "Aktualisierte Vorlage" im Plugin.

3. Klicken Sie in der Menüleiste des Plugins auf die Schaltfläche "Aktualisieren"; die Instanzen 
des EMT werden in der Spalte "Strukturunterschiede" angezeigt.

4. Klicken Sie auf die Schaltfläche "Aktualisieren". 
Die Änderungen in der CM werden aktualisiert und stehen in der EM-Instanz zur Verfügung.

Hinweis

Nur die neuen Objekte werden aktualisiert, d. h. Signale, Parameter oder Meldungen. 
Änderungen der Objekteigenschaften wie des Namensattributs werden nach der 
Aktualisierung nicht in die EM-Instanz übertragen.

Aus einem vorhandenen CMT erstellte CM unterhalb von EMT aktualisieren
1. Bearbeiten Sie den CMT.

2. Ziehen Sie den CMT in den Baugruppen Updater, um die CMs unterhalb von EMT zu 
aktualisieren.

Hinweis

Die CM-Instanzen unterhalb der EM-Instanzen sind nicht sichtbar. Nur CM-Instanzen in der 
Bibliothek unterhalb von EMT / Aggregierte CMT oder CM-Instanzen in der DCS-Struktur 
sind sichtbar.

3. Klicken Sie auf "Aktualisieren". 
Die Änderungen der CMT werden aktualisiert und stehen im EMT (und auch in CM-
Instanzen in der DCS-Struktur, wenn der CMT hier instanziiert wurde) zur Verfügung.

4. Ziehen Sie den EMT in den Baugruppen Updater, um die EM zu aktualisieren.

Hinweis

Obige Schritte sind zwingend erforderlich, um die EM-Instanzen richtig zu aktualisieren.

Eine als Grundanforderung definierte CM in der EM-Instanz aktualisieren
Ist eine CM als "Grundanforderung" definiert, sind die folgenden Punkte zu beachten:

● CMs und untergeordnete Objekte werden nicht in die Instanz kopiert

● Änderungen der zugeordneten CM in der Zuordnung der EM-Instanz werden bei der 
Aktualisierung nicht überschrieben

● Änderungen der zugeordneten CM in der Zuordnung des EMT werden nicht in die Instanz 
übertragen

– Der Benutzer muss die zugeordnete CM in der Zuordnung der EM-Instanz manuell auf 
die gültige CM ändern
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Eine nicht als Grundanforderung definierte CM in der EM-Instanz aktualisieren
Ist eine CM nicht als "Grundanforderung" definiert, sind die folgenden Punkte zu beachten:

● Untergeordnete Objekte werden in die Instanz kopiert

● Für die Aktualisierung der CMs unter der EM-Instanz sollte die CM unterhalb des EMT 
zuerst aktualisiert werden, dann erst die EM-Instanzen

● Änderungen der zugeordneten CM in der EMT-Zuordnung werden in die Instanz übertragen

Hinweis
Zuordnung von Einzelsteuereinheiten

Die Aktualisierung in "Zuordnung von Einzelsteuereinheiten" wird für die folgenden zwei 
Anwendungsfälle behandelt:
● Grundanforderung im EMT zugeordnet

Das Attribut "Zugeordnete Einzelsteuereinheit" wird bei der Aktualisierung nicht 
berücksichtigt und das Attribut wird nicht aktualisiert.

● Keine Grundanforderung zugeordnet (in CM-Instanz unter EMT kopiert)
Das Attribut "Zugeordnete Einzelsteuereinheit" wird bei der Aktualisierung berücksichtigt. 
Bei einer Änderung des EMT wird das Attribut aktualisiert.

13.13.4 Legende
Kernaussage

Farbe Bedeutung
Grau Keine Änderungen
Schwarz Geänderte Unterobjekte
Blau Geändert
Grün Bei der Instanz nicht verfügbar
Rot In der Vorlage nicht verfügbar

13.13.5 Variantenverwaltung
Die Aktualisierung von Varianten wurde neu hinzugefügt und funktioniert über den 
Baugruppenupdater.

Nachdem der Baugruppenupdater beendet ist, wird beim Öffnen des Funktionsplans die 
grafische Darstellung der CMs entsprechend aktualisiert.

Der Abgleich von CMT und Variante funktioniert technisch so:

● Alle an der Variante werden am CMT hinzugefügt wenn nicht schon vorhanden

● Vorhandene Objekte bleiben bestehen und behalten auch Hinzugefügte Werte, es sei denn 
die Variante bringt andere mit, dann werden die Werte überschrieben.

● Objekte am CMT, die an der Variante nicht mehr vorhanden sind werden gelöscht
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● Alle hinzugefügten Funktionen in der Variante werden zu den Instanzen hinzugefügt. 

● Wenn einige Funktionen im Typ gelöscht werden, werden sie auch in den Instanzen 
gelöscht. 

Hinweis
Nicht aktualisierbare Objekte am CMT

Werte von Signalen und Parametern sowie Kommentare werden nicht aktualisiert
Typen überschreiben im Falle eines Konflikts den Status der Instanz.

13.14 Symboltabellen verwenden

13.14.1 Symboltabelle

Änderungsoptionen
Es ist jetzt möglich folgende Änderungen vorzunehmen:

● Auswahl der angezeigten TH im Symbolnamen

● Manuelle Eingabe von Status, Symbol (Y00A00505), Adresse (Y00A00182), Datentyp 
(Y00A00517), Kommentar ((Y00A00011)) und Signal Bezeichner ((Y00A00566))

● Verknüpfung von Symbolen mit Hardwaresignalen

● Generieren von Standardparametern für Pre- und Suffixe

Aktualisierung
Durch die neue Benamungsmechanik ist ein manuelles Updaten der Symboltabelle 
erforderlich. Dieses geschieht zur Steigerung der Performanz nicht automatisiert.

Export der Hardwareinformationen
Über eine Abfrage ist es möglich, die Liste der Symbole samt Ihrer Hardwareinformationen zu 
exportieren und zu drucken.
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Synchronisierung der Attribute
● Wenn die Symbolnamen in der Symboltabelle editiert werden, werden die Daten an den IO-

Kanal übertragen, wenn der IO-Kanal implementiert ist.

● Wenn der Kommentar bearbeit wird in der Symboltabelle, werden die Daten auf den realen 
Kanal übertragen, auf die Anforderung Kanalobjekt und an die Signalbeschreibung.

● Wenn die Daten in der Spalte Symbol oder Kommentar gelöscht werden, werden die 
geerbten Daten vom Channel-Request dargestellt, wenn der IO-Kanal implementiert ist. 
Wenn IO-Kanal nicht umgesetzt wurde, dann wird das Löschen nur das Feld leeren.

13.14.2 Symbolische Adressen in eine Symboltabelle importieren
Sie können die symbolischen Adressen auch aus einer im Dateisystem abgelegten 
Symboltabelle in die Symboltabelle importieren.

Vorgehen
1. Wählen Sie im Kontextmenü der Symboltabelle den Befehl "Symboltabelle > Symboltabelle 

importieren".

2. Wählen Sie im Dateisystem die Symboltabelle, aus der Sie die symbolischen Adressen 
importieren wollen.

Siehe auch
Symboltabelle aktualisieren (Seite 147)

13.14.3 Symboltabelle aktualisieren

Vorgehen
Um alle symbolischen Adressen in der Symboltabelle zu aktualisieren, wählen Sie im 
Kontextmenü der Symboltabelle unterhalb der Station den Befehl "Symboltabelle > 
Symboltabelle aktualisieren".

Ergebnis
Die symbolischen Adressen werden in die Symboltabelle geschrieben.

Engineering in PAA
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13.15 Engineering im Funktionsplan

13.15.1 Einzelsteuereinheit auf dem Funktionsplan bearbeiten

Voraussetzung
● Der Funktionsplan ist geöffnet.

● Die Einzelsteuereinheit wurde bereits beim Import oder beim Anlegen im Plugin "Typ-
Konfigurator" automatisch auf dem Funktionsplan platziert.
Siehe Kapitel Einzelsteuereinheiten und Technische Einrichtungen importieren (Seite 181) 
und Kapitel Einzelsteuereinheiten anlegen (Seite 32).

Vorgehen 
1. Wählen Sie eine der folgenden Möglichkeiten:

– Wenn Sie mit der DCS Struktur arbeiten, selektieren Sie unterhalb der 
Einzelsteuereinheit ein Signal.

– Wenn Sie mit der Anlagenstruktur arbeiten, wählen Sie unter einer Position ein Signal 
aus.
Öffnen Sie unter der Messstelle den Ordner "A20 Signalplanung".
Wählen Sie im Ordner "A20 Signalplanung" ein Signal.

2. Ziehen Sie das Signal per Drag&Drop auf den Funktionsplan.
Das Signal ist in einem früheren Arbeitsschritt auf die Kanäle implementiert worden. Siehe 
Kapitel Optional: Hardware und Software verknüpfen: Kanäle implementieren (Seite 137). 
Wenn der Datentyp des Signals mit dem Datentyp des Baustein-Anschlusses nicht 
zusammenpasst, wird keine Verbindung erstellt. Weiterführende Informationen zu diesem 
Thema finden Sie im Handbuch "Logical", Stichwort "Verbindungsarten bei 
Bausteinanschlüssen" und Stichwort "Erlaubte Anschlusstypen-Kombinationen".

3. Platzieren Sie generische Bausteine auf dem Funktionsplan.
Weiterführende Informationen zu diesem Thema finden Sie im Handbuch "Logical", 
Stichwort "Bausteine verbinden".
Die generischen Bausteine OR, AND und XOR stehen im Menü des Funktionsplans zur 
Verfügung. Sie haben die Möglichkeit, weitere Bausteine zu verwenden und in das Menü 
einzubinden. Zum Beispiel NOT. Die Stammobjekte finden Sie hier: "@30 > M40 > A50 > 
A10 > A10 > A10 > A10 > A10 > A40 Bitweise".

4. Verbinden Sie alle Objekte auf dem Funktionsplan.

Hinweis
Signale direkt mit dem Baustein verbinden

Verbinden Sie das Hardware-Signal immer direkt mit dem Eingang des platzierten 
Bausteins. Nur solche Verbindungskonfigurationen werden nach PCS 7 exportiert. 

Folgendes Vorgehen wird nicht unterstützt: Hardware-Signal erst mit einem generischen 
Baustein verbinden und anschließend den generischen Baustein mit dem Baustein 
verbinden.

Engineering in PAA
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Ergebnis
Die platzierten Objekte können exportiert werden. Siehe Kapitel Export von PAA nach PCS 7 
(Seite 175).

Siehe auch
Logik auf Funktionsplänen bearbeiten (Seite 150)

13.15.2 Technische Einrichtungen auf dem Funktionsplan bearbeiten

Voraussetzung
● Der Funktionsplan ist geöffnet.

● Die Technische Einrichtung wurde bereits beim Import oder beim Anlegen im Plugin "Typ-
Konfigurator" automatisch auf dem Funktionsplan platziert.
Siehe Kapitel Einzelsteuereinheiten und Technische Einrichtungen importieren (Seite 181) 
und Kapitel Technische Einrichtung (Typ) anlegen (Seite 49).

Vorgehen 
1. Doppelklicken Sie auf den Namen oder die Beschreibung des zu bearbeitenden EM/EMT-

Symbols.

2. Klicken Sie auf den Wert eines zu bearbeitenden Parameters.

3. Um die EM mit einer anderen EM oder CM zu verschalten, ziehen Sie den jeweiligen 
Parameter in den Funktionsplan und verschalten Sie ihn mit dem Partner-Parameter.

4. Ziehen Sie die Funktionsbausteine per Drag&Drop auf den Funktionsplan.

5. Verbinden Sie alle Objekte auf dem Funktionsplan.

Ergebnis
Die platzierten Objekte können exportiert werden.

Anlegen einer externen Verbindung zu einem Kennlinienparameter
1. Öffnen Sie das Plugin "Typ-Konfigurator".

2. Navigieren Sie zu der spezifischen Kennlinie und legen Sie über das Kontextmenü einen 
neuen Parameter an.

3. Klicken Sie im geöffneten Funktionsplan der EM auf "Aktualisieren", um den neuen 
Parameter anzuzeigen.

4. Ziehen Sie den Parameter per Drag&Drop an die Stelle im Funktionsplan, an der sich der 
Verbindungspartner befindet.

Engineering in PAA
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5. Verbinden Sie den Parameter.

6. Die neue Verbindung wird im EMT angezeigt, sobald der Funktionsplan geöffnet wird.

Siehe auch
Optional: Hardware und Software verknüpfen: Kanäle implementieren (Seite 137)

Export von PAA nach PCS 7 (Seite 175)

13.15.3 Verwenden von CM unterhalb von EM/EMT im Funktionsplan

Einleitung
Die unterhalb von EM/EMT angelegten CMs können im Funktionsplan verwendet werden. CMs 
können neu angelegt oder über vorhandene CMT angelegt werden.

Anwendungsfälle
Eine angelegte und nicht als Grundvoraussetzung definierte CM wird im Funktionsplan als 
getrennter Baustein angezeigt und kann als normale CM im Funktionsplan verwendet werden.

Eine als Grundvoraussetzung definierte CM wird nicht im Funktionsplan angezeigt.

Die Zuordnungen der Einzelsteuereinheit unterhalb von EM/EMT werden nicht im 
Funktionsplan angezeigt.

Siehe auch Kapitel Einzelsteuereinheit auf dem Funktionsplan bearbeiten (Seite 148).

13.15.4 Logik auf Funktionsplänen bearbeiten

Voraussetzungen
● Eine Einzelsteuereinheit wurde auf einem Funktionsplan bearbeitet. 

Siehe auch Kapitel Einzelsteuereinheit auf dem Funktionsplan bearbeiten (Seite 148).

Verwendung von Bausteinen
Sie können folgende generische Bausteine verwenden:

● UND

● ODER

● XOR

● NICHT

Engineering in PAA
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Sie haben die Möglichkeit weitere Bausteine zu verwenden. Dazu müssen die Bausteine in 
PCS 7 als Standardfunktion definiert sein. Beachten Sie Folgendes:

● Der Name der Standardfunktion in PCS 7 entspricht dem Kennzeichen des Bausteins in 
PAA.

● Der Name der Bausteinanschlüsse in PCS 7 entspricht dem Kennzeichen der 
Bausteinanschlüsse in PAA.

Siehe auch
Beispiel einer Interlock-Logik auf Funktionsplänen (Seite 151)

13.15.5 Beispiel einer Interlock-Logik auf Funktionsplänen

Voraussetzungen
● Eine Interlock-Logik ist auf Funktionsplänen erstellt.

Siehe Kapitel Logik auf Funktionsplänen bearbeiten (Seite 150).

Beispiel 
Das folgende Beispiel zeigt, wie die Bausteine verschaltet sind. Ziehen Sie einen Parameter 
der Funktion aus dem Navigator-Baum in den Funktionsplan und verschalten Sie ihn direkt mit 
der CM. 

Wie im nachfolgenden Beispiel zu sehen, wird der Parameter der Funktion auf der rechten 
Seite mit der CM (MonAn) verbunden und darunter wird die Funktion mit dem Parameter von 
"MonAn" in einem anderen Funktionsplan einer anderen CM (MonAn#DeltaCalc) verschaltet.

Engineering in PAA
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13.15.6 Zwischen verschalteten Parametern/Signalen navigieren
Sie können im Funktionsplan zwischen verschalteten Parametern/Signalen navigieren und in 
Erfahrung bringen, wo sich der Partner des verschalteten Parameters mit der 
Steckplatznummer im Dokument befindet. Es ist auch möglich, zwischen den verschalteten 
Parametern/Signalen verschiedener Funktionspläne zu navigieren.
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Voraussetzung
● Paramater einer CM (oder Funktion) ist mit einem Paramater einer anderen CM (oder 

Funktion) verschaltet

● Parameter von einer CM ist mit einem Signal einer anderen CM verschaltet

● Parameter von einer CM ist mit einem Parameter an zwei verschiedenen CMs verschaltet  

Vorgehen
1. Öffnen Sie die Funktionspläne der angelegten CMs.

2. Klicken Sie mit der rechten Maustaste und wählen Sie "Navigieren > Dokumente > (Partner-
Funktionsplan mit Steckplatznummer)".

3. Die Navigation zeigt den Partner im Dokument mit der Steckplatznummer an (aktuelles 
Dokument oder ein anderes).

Hinweis

Basierend auf den verschalteten Parametern zeigt das Kontextmenü die entsprechenden 
verschalteten Partner an. 

Wenn bei einem Funktionsplan zwei Parameter mit einem Parameter der anderen CM 
verschaltet sind, werden zwei verschaltete Partner angezeigt.

4. Klicken Sie auf den Partner. Daraufhin wird der Funktionsplan des verschalteten 
Parameters geöffnet und das ausgewählte Objekt ist eine CM (oder Funktion) und wird mit 
der Steckplatznummer angezeigt.

13.16 Messbereiche festlegen

Signale
Die Kapitelkarte des CM-Signals wird zu einem neuen Attribut "Messbereich".

Wenn eine Einheit eingestellt wird, kann der Messbereich durch die Mapping-Tabelle aus der 
Messfunktion festgelegt werden.

Siehe "Attribute > Automation Interface < Signalkonfiguration > Messbereich".

Datenbankname Y00A00404

Parameter
Es ist auch möglich, eine Einheit für einen Parameter festzulegen.

Wenn der Wert und das Gerät von PCS 7 übertragen werden, müssen Sie sich vergewissern, 
dass der Wechsel der Einheit den Übertragungswert nicht verändert.

Siehe "Paramater Konfiguration > Messbereich"

Engineering in PAA
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13.17 Verschieben von TH
Das Verschieben von Objekten und Hierarchien wie PH, CMT wird jetzt exakt zwischen PCS 7 
und PAA synchronisiert.

Dies führt darüber hinaus nicht zu einer Markierung der TH im Datentransferdialog als "neu".

In PAA: Die Elemente können per Drag&Drop verschoben werden.

In PCS 7: Beispiel

● Bestehende CM-Instanz ist mit der zugehörigen CM-Instanz in einem PAA-Projekt verknüpft

● Verschieben der CM-Instanz in PCS 7 an einen anderen Speicherort (Drag&Drop mit 
Umschalttaste)

● Hinweis: Der andere Standort kann auch ein anderes Projekt in PCS 7 sein. In diesem Fall 
zeigt die Datenübertragung das Objekt als gelöscht aus dem Quellprojekt in PCS 7 an 
(solange eine Datenübertragung für ein komplettes Multi-Projekt nicht verfügbar ist)

● Der Benutzer löst eine Übertragung der Daten nach PAA aus.

● Dies führt in PAA zu einer verschobenen CM-Instanz, wobei alle untergeordneten Objekte 
in dieser CM-Instanz ebenfalls verschoben werden.

● Der Datentransferdialog zeigt nicht neue oder gelöschte Objekte, sondern nur verschobene 
Objekte an.

● Dies gilt umgekehrt auch für die Richtung von PAA nach PCS 7.

13.18 Mit Negationen arbeiten

Hinweis
Negation ist in PCS 7 nur an Eingängen möglich

Negationen stehen in PCS 7 nur an verschalteten Eingängen zur Verfügung. Das Attribut 
"Negation" ist nur bei Eingangsparametern/-signalen vom Datentyp "BOOL" möglich und ist bei 
Ausgangsparametern/-signalen deaktiviert. Bei Eingangsparametern/-signalen bezieht sich 
das Attribut "Negation" auf die Parameterverschaltung bzw. das Signal.

Negationen können an Eingangsparametern und Eingangssignalen zwischen PAA und PCS 7 
ausgetauscht werden. Wenn "PCS 7" in der Liste "Modus Funktionsplan" ausgewählt ist, 
können Negationen nur an den zulässigen Parametern und Signalen erstellt werden.

Voraussetzung
● Ein Funktionsplan ist geöffnet. 

● In den Eigenschaften des Funktionsplans ist auf der Registerkarte "Attribute > 
Systemdaten" in der Kontrollgruppe "Einstellungen" in der Liste "Modus Funktionsplan" der 
Eintrag "PCS 7" selektiert.

● Verbindungen an Eingangsparametern/Eingangssignalen sind verfügbar.
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Vorgehen
1. Wählen Sie eine Verbindung aus.

2. Die Verbindung wird magentafarben dargestellt.

3. Wählen Sie im Kontextmenü den Eintrag "Einstellungen > Signal negiert".

4. Bestätigen Sie Ihre Eingaben.

Beispiel

Siehe auch
Referenzen verwenden (Seite 45)
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Plugin "Verbindungsmanager" 14
14.1 Anlegen und Bearbeiten einer großen Anzahl von Verbindungen

Einleitung
Um massenhaft Verbindungen oder Referenzen anzulegen, verwenden Sie das Plugin 
"Verbindungsmanager". Siehe auch Kapitel Referenzen verwenden (Seite 45).

Voraussetzung
Sie haben CMs/EMs oder Funktionen mit Steuervariablen angelegt, an denen Ein- und 
Ausgänge existieren.

Die CMs/EMs oder Funktionen sind auf einem Funktionsplan platziert.

Vorgehen
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > 

Verbindungsmanager".
Das Plugin "Verbindungsmanager" öffnet sich.

2. Wählen Sie in der Menüleiste des Plugin in der Liste "Verbindungstyp" den gewünschten 
Eintrag.
Standardmäßig ist hier der Eintrag "Textuelle Referenz" ausgewählt.

3. Optional: Filtern Sie in der Menüleiste des Plugin nach Eingängen oder Ausgängen.

4. Ziehen das gewünschte Objekt in das Feld "Startobjekt", zum Beispiel das Werk.
Die Auswertung startet automatisch. Alle unter dem Startobjekt vorhandenen 
Steuervariablen werden entsprechend der Filtereinstellungen aufgelistet.

5. Um einen aufgelisteten Ein- oder Ausgang mit einem anderen zu verknüpfen, ziehen Sie 
den gewünschten Ein- oder Ausgang per Drag&Drop aus dem Navigator in die Spalte "Ziel".
Sie haben die Möglichkeit, mehrere Objekte aus dem Navigator auf mehrere gelistete Ein- 
und Ausgänge zu ziehen. Wenn ein Objekt aus dem Navigator einen falschen Datentyp hat, 
können Sie die Objekte nicht droppen.

6. Optional: Um einem Ausgang mehrere Verknüpfungen zuzuweisen, ziehen Sie das Objekt 
aus dem Navigator in die Spalte "Hinzufügen" des Ausgangs.
Die zusätzliche Verknüpfung wird in einer neuen Reihe angelegt.

7. Bestätigen Sie Ihre Eingaben.

Bearbeiten der Verbindungen 
Massendaten-Projektierung ist über die Optionen "Text kopieren/Text einfügen" im Plugin 
"Verbindungsmanager" und in Excel möglich. Für die Verbindungen kann in der Spalte "Ziel" 
im Plugin der "Verbindungstyp" in "Verbindung" geändert werden.
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Vorgehen
1. Öffnen Sie das Plugin "Verbindungsmanager".

2. Ziehen Sie das gewünschte Objekt per Drag&Drop in das Feld "Startobjekt".

3. Ändern Sie in der Menüleiste des Plugins den "Verbindungstyp" in "Verbindung".

4. Geben Sie in der Spalte "Ziel" über die Funktionen "Text kopieren"/"Text einfügen" und 
"Bearbeiten (F2)" im Kontextmenü den relevanten Verbindungspartner an (zum Beispiel 
"DCS.TH01.F4712.F4712.I.PV_AH_Act").
Sie können mehrere Ausgaben einer Excel-Tabelle kopieren und in die Spalte "Ziel" 
einfügen.

5. Klicken Sie auf "Übernehmen" und bestätigen Sie Ihre Einträge.

6. Die Spalte "Status" gibt den Verbindungsstatus als "Verbunden" oder "Nicht verbunden" an.
Der Status basiert darauf, ob die Verbindungen angelegt sind oder nicht.

Anlegen von Verbindungen von EM-Instanzen
Der "Verbindungsmanager" ermöglicht die Verbindung mit EM-Instanzen mit den folgenden 
Objekten:

● Alle Parameter "Kennlinie" in Ordner "Kennlinie"

● Parameter unterhalb von EM

● Parameter unterhalb von CMs unter EM (neu angelegt im Plugin "Typ-Konfigurator")

14.2 Verbindungstyp
Die folgende Tabelle beschreibt die verfügbaren Optionen in den verschiedenen 
Verbindungstypen des Plugins "Verbindungsmanager":

Plugin "Verbindungsmanager"
14.2 Verbindungstyp
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Verbindungstyp Beschreibung Bearbeitungsmöglich‐
keiten

Farbe (im 
Funktions‐
plan)

Syntax in Spalte "Ziel" Filter

Textuelle Referenz Beide Parameter 
in technologischen 
EA, aber einer da‐
von noch nicht ver‐
fügbar 
[grün – grüne Ver‐
bindung]

● Zeichenkette in 
Spalte "Ziel" 
schreiben

● Text kopieren/
einfügen in Spalte 
"Ziel"

● I/O "IN": 
Ausgangsparamet
er in Spalte "Ziel" 
ziehen

● I/O "OUT": 
Eingangsparamet
er in Spalte 
"Hinzufügen" 
ziehen; mehrfach 
möglich

Gelb <PCS7 Projektname>
\TH01\TH02\CM\SubCM.Para‐
meter 
(Beispiel: PCS7_Prj\Factory
\Area4\Level1\ V41\V.LockAct"

● Eingan
g 

● Ausga
ng 

● Alle

Globale Datenrefe‐
renz

Parameter in tech‐
nologischen EA > 
Datenbaustein-Va‐
riablen 
[grün – DB-Verbin‐
dung]
 
(Der DB muss in 
PCS 7 definiert 
werden, bevor die 
Verbindung expor‐
tiert wird)

● Zeichenkette in 
Spalte "Ziel" 
schreiben

● Text kopieren/
einfügen in Spalte 
"Ziel"

● I/O "IN": 
Ausgangsparamet
er in Spalte "Ziel" 
ziehen

● I/O "OUT": 
Eingangsparamet
er in Spalte 
"Hinzufügen" 
ziehen; mehrfach 
möglich

Blau Symbolischer DB Name.Para‐
meter in DB  
(Beispiel: ProjectDB.Bool1)

● Eingan
g 

● Ausga
ng 

● Alle

Plugin "Verbindungsmanager"
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Verbindungstyp Beschreibung Bearbeitungsmöglich‐
keiten

Farbe (im 
Funktions‐
plan)

Syntax in Spalte "Ziel" Filter

Bausteinvariablen-
Referenz

Nur ein Parameter 
in den technologi‐
schen EA; der an‐
dere Parameter ist 
nur in PCS 7 
[grün–graue oder 
grau–grüne Ver‐
bindung]

● Zeichenkette in 
Spalte "Ziel" 
schreiben

● Text kopieren/
einfügen in Spalte 
"Ziel"

● I/O "IN": 
Ausgangsparamet
er in Spalte "Ziel" 
ziehen

● I/O "OUT": 
Eingangsparamet
er in Spalte 
"Hinzufügen" 
ziehen; mehrfach 
möglich

Orange <PCS7 Projektname>\
\TH01\TH02\\CM\SubCM.Pa‐
rameter 
(Beispiel: PCS7_Prj\\Factory
\Area4\Level1\\ V41\V.LockAct"

● Eingan
g 

● Ausga
ng 

● Alle

Verbindung Parameter in tech‐
nologischen EA 
und beide verfüg‐
bar  
[grün – grüne Ver‐
bindung]

● Zeichenkette in 
Spalte "Ziel" 
schreiben

● Text kopieren/
einfügen in Spalte 
"Ziel"

● I/O "IN": 
Ausgangsparamet
er in Spalte "Ziel" 
ziehen

Keine Far‐
be

DCS.TH01.TH02.CM Templa‐
te.CM.SubCM.Parameter 
(Beispiel: DCS.Facto‐
ry.Area4.F4711.F4711.I.PV_A
H_Act)

Nur Ein‐
gang

Plugin "Verbindungsmanager"
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Attribute von PAA und PCS 7 verknüpfen 15
15.1 Verknüpfungstabelle der Signalbezeichnungen konfigurieren

Voraussetzung
● Die Verwaltung der Einzelsteuereinheitstypen ist durchgeführt.

Die Kopiervorlagen der Einzelsteuereinheitstypen sind erstellt.
Siehe Kapitel Verwaltung von Einzelsteuereinheitstypen (Seite 31).

● Eine Einzelsteuereinheit ist einkopiert.

● Im Navigator wird die Registerkarte "Anlagen" angezeigt.

Zielsetzung
Die Verknüpfungstabelle bearbeiten Sie in den Planungsdaten. Dazu bearbeiten Sie 
exemplarisch die Verknüpfungstabelle an einem CM. Danach speichern Sie die 
Verknüpfungstabelle in den Kopiervorlagen. Sie steht dann bei allen CMs dieses Typs zur 
Verfügung. 

Verknüpfungstabelle aufrufen 
1. Selektieren Sie im Navigator die Registerkarte "Anlagen".

2. Navigieren Sie in der DCS Struktur zu der einkopierten Einzelsteuereinheit unterhalb eines 
Ordners.

3. Öffnen Sie die Eigenschaften der Einzelsteuereinheit.

4. Selektieren Sie die Registerkarte "Attribute > Automation Interface". 

5. Klicken Sie auf die Schaltfläche "Öffne Verknüpfungstabelle". 

Schritt 1: PCS 7-Attribute sammeln
1. Halten Sie die Verknüpfungstabelle weiterhin offen.

2. Erweitern Sie die Struktur unterhalb der im obigen Schritt verwendeten Einzelsteuereinheit.
Es sind nur Attribute erlaubt, die unterhalb der Einzelsteuereinheit liegen, für die die 
Verknüpfungstabelle geöffnet wurde. Verwenden Sie gemäß dem Beispiel in dieser 
Dokumentation die folgenden Attribute:

– Einzelsteuereinheit, Registerkarte "Automation Interface": "Name" 

– Signal unter der Einzelsteuereinheit, Registerkarte "Automation Interface": 
"Signalname"
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3. Ziehen Sie diese Attribute per Drag&Drop aus dem Navigator in die Spalte "Attribut".

4. Doppelklicken Sie für jedes verwendete Attribut in die Spalte "Verknüpfungstyp" und 
wählen Sie den Listeneintrag "Voll dynamisch".
Die Option "Voll dynamisch" bewirkt, dass alle Eigenschaften des verknüpften Attributs 
abgeglichen werden.

Schritt 2: PAA-Attribute zuordnen
1. Halten Sie die Verknüpfungstabelle weiterhin offen.

2. Selektieren Sie unterhalb derselben Position wie im Schritt vorher eine Messstelle.
Eine Verknüpfung über Unit Pointer existiert.
Ein Beispiel für eine Zuordnung finden Sie in Kapitel Beispiel einer Zuordnung (Seite 164). 

3. Ziehen Sie diese Attribute per Drag&Drop aus dem Navigator in die Spalte "Quellobjekt".

4. Doppelklicken Sie in die Spalte "Eigenschaft" und wählen Sie "DisplayValue" zur Anzeige 
des Werts.

5. Überprüfen Sie die übergebene Eigenschaft in der Spalte "Wert".

6. Um die Zuordnungen zu speichern, klicken Sie auf die Schaltfläche "Übernehmen".

Optional: Zuordnen von PAA-Attributen per Navigationsassistent
Alternativ können Sie das Quellobjekt im Navigationsassistenten auswählen.

Siehe Kapitel Navigationsassistent verwenden (Seite 163).
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Siehe auch
Verknüpfungstabelle als Kopiervorlage übernehmen (Seite 164)

Referenz zur Verknüpfungstabelle (Seite 202)

15.2 Navigationsassistent verwenden

Voraussetzung
Die Verknüpfungstabelle der Signalbezeichnungen ist geöffnet.

Siehe Kapitel Verknüpfungstabelle der Signalbezeichnungen konfigurieren (Seite 161).

Vorgehen
Wenn Sie die Position des Quellobjekts im Anlagenbaum nicht kennen, verwenden Sie den 
Navigationsassistenten.

1. Öffnen Sie die Eigenschaften einer Einzelsteuereinheit.

2. Selektieren Sie die Registerkarte "Attribute > Automation Interface".

3. Klicken Sie auf die Schaltfläche "Öffne Verknüpfungstabelle".

4. Doppelklicken Sie in der Verknüpfungstabelle in die gewünschte Zelle der Spalte 
"Quellobjekt".
Der Navigationsassistent wird geöffnet. Als Startobjekt wird die aktuell gewählte 
Einzelsteuereinheit eingetragen.

5. Um das Zielobjekt schrittweise zu bestimmen, gehen Sie folgendermaßen vor:

– Doppelklicken Sie in der rechten Tabelle auf einen Eintrag in der Spalte "Objekt".
Das gewählte Objekt wird in die Spalte "Schritt" der linken Tabelle übernommen.

– Um unterhalb des letzten Schritts einen weiteren Schritt anzulegen, selektieren Sie den 
letzten Schritt in der linken Tabelle und doppelklicken Sie in der rechten Tabelle auf das 
gewünschte Objekt.

– Um einen Schritt in der linken Tabelle zu entfernen, wählen Sie im Kontextmenü der zu 
löschenden Zeile den Befehl "Zeile entfernen".

6. Bestätigen Sie Ihre Eingaben.

Weiterführende Informationen zu diesem Thema finden Sie im Handbuch "COMOS Platform 
Administration", Stichwort "Berechnungsart: Navigationsbibliothek erweitert".

Siehe auch
Beispiel einer Zuordnung (Seite 164)

Referenz zum Navigationsassistent (Seite 204)
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15.3 Beispiel einer Zuordnung

Voraussetzung
● Die Verknüpfungstabelle der Signalbezeichnungen ist geöffnet. 

Siehe Kapitel Verknüpfungstabelle der Signalbezeichnungen konfigurieren (Seite 161).

Vorgehen
Gemäß dem Beispiel in dieser Dokumentation gilt folgende Zuordnung:

PCS 7 Attribut, Registerkarte "Y30T00001 Automation Inter‐
face"

PAA-Attribut

Name des Signals: 
Attribut "Name Signalname"

Messstelle, Ordner "A20 Signalplanung", Eigenschaften des 
Signals:
Registerkarte "Y00T00027 Signaldaten", Attribut 
"Y00A00555 Signalbezeichnung"
Verknüpft über Unit Pointer

Name der Einzelsteuereinheit: 
Attribut "Name Name"

Position:
Registerkarte "Y30T00001 Automation Interface", Attribut 
"Name Hierarchiename"
Verknüpft über Unit Pointer

Siehe auch
Verknüpfungstabelle als Kopiervorlage übernehmen (Seite 164)

15.4 Verknüpfungstabelle als Kopiervorlage übernehmen

Voraussetzung
● Die Verknüpfungstabelle der Signalbezeichnungen ist konfiguriert.

Siehe Kapitel Verknüpfungstabelle der Signalbezeichnungen konfigurieren (Seite 161).

● Im Navigator wird die Registerkarte "Anlagen" angezeigt.

Zielsetzung
Die Verknüpfungstabelle wird in den Kopiervorlagen gespeichert und steht dann bei allen 
Einzelsteuereinheiten dieses Typs zur Verfügung. 
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Verknüpfungstabelle aufrufen 
1. Navigieren Sie in der Anlagenstruktur zu der einkopierten Einzelsteuereinheit unterhalb 

einer Position.

2. Selektieren Sie in den Eigenschaften der Einzelsteuereinheit die Registerkarte "Attribute > 
Automation Interface".

3. Klicken Sie auf die Schaltfläche "Öffne Verknüpfungstabelle".

4. Bearbeiten Sie die Verknüpfungstabelle gemäß diesen Hinweisen:
Referenz zur Verknüpfungstabelle (Seite 202) 

Verknüpfungstabelle zurückspeichern
Um die Zuordnungen in den Einzelsteuereinheitstyp zurückzuspeichern, gehen Sie 
folgendermaßen vor:

1. Öffnen Sie die fertig zugeordnete Verknüpfungstabelle einer Einzelsteuereinheit.

2. Um die Zuordnungen in die Kopiervorlage des verwendeten Einzelsteuereinheitstyps 
zurückzuspeichern, klicken Sie in der oberen Funktionsleiste auf die Schaltfläche "In 
Vorlage übernehmen".

3. Bestätigen Sie Ihre Eingaben.

Wenn Sie die Zuordnungen in der Vorlage überprüfen wollen, öffnen Sie die 
Verknüpfungstabelle des Einzelsteuereinheitstyps in folgendem Ordner:

"@Template Kopiervorlagen > @PCS 7 > Bibliotheksordner"
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Austausch von Daten und HW-Konfigurationen 
zwischen PCS 7 und PAA 16
16.1 Austausch digital signierter XML-Dateien

Hinweis
Sicherheit beim Datenaustausch über XML-Format 
● Zugriff auf das Übertragungsmedium/Übertragungsverzeichnis:

Bei Einsatz des indirekten Datenaustauschs über das XML-Format zwischen PAA und PCS 
7 müssen Sie darauf achten, dass das Übertragungsmedium bzw. das 
Übertragungsverzeichnis der XML-Dateien nur berechtigten Personen zugänglich ist.

● Digital signierte XML-Dateien:
Um den Ursprung und die Integrität der XML-Daten zu beschreiben, können Sie die XML-
Datei beim Datenaustausch im XML-Format digital signieren. Das entspricht den 
Anforderungen des PCS 7–Sicherheitskonzepts. 
Über die Prüfung der digitalen Signatur wird sichergestellt, dass die XML-Datei auf dem 
Übertragungsmedium nicht geändert wurde.  
Die digitale Signatur der XML-Datei ist standardmäßig deaktiviert. Ein Aktivieren der 
digitalen Signatur ist empfehlenswert.
Siehe auch Kapitel Überblick zum Datenaustausch mit PCS 7 (Seite 15).

Voraussetzung
Zum Signieren der XML-Datei müssen auf dem PC folgende Objekte vorhanden sein: 

● Das Zertifikat des signierenden Benutzers. 
Dieses Zertifikat kann von einem gewerblichen Anbieter oder durch eine "Windows Server 
Certification Authority" erstellt sein und muss in der Konsole "MMC" von Windows unter 
"Aktueller Benutzer > Zertifikate" gespeichert sein. Das entsprechende "CA"-Zertifikat 
muss in der Konsole "MMC" unter "Vertrauenswürdige Stammzertifizierungsstellen" 
gespeichert sein.
Bei diesem Zertifikat muss in den Eigenschaften im Attribut "Schlüsselverwendung" 
mindestens einer der Werte "Digitale Signatur" ("digitalSignature") oder "Unleugbarkeit" 
("nonRepudiation") gesetzt sein. 

● Der Private Key zu diesem Zertifikat. 

Vorgehensweise
Um die digitale Signatur im PCS 7-Projekt zu verwenden, aktivieren Sie im Plugin "Import / 
Export PCS 7" im Register "Export/Import" unter "Projektauswahl" die Option "XML-Signatur".
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Angewendete Standards
Es wird das asymmetrische Signaturverfahren RSA nach dem Standard "PKCS#1 (https://
www.ietf.org/rfc/rfc3447.txt)" verwendet . Die Attribute des Zertifikats sind in der 
Zertifikatdefinition unter "Internet-Link (http://www.ietf.org/rfc/rfc5280.txt)" beschrieben. 

16.2 Austausch eines PAA/PCS 7-Projekts

Vorgehensweise
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > 

Import / Export PCS 7".

2. Wählen Sie je nach Bedarf das Register "Export/Import" aus.
Siehe auch Kapitel Registerkarte "Import" (Seite 199) und Registerkarte "Export" 
(Seite 201).

3. Aktivieren Sie eine der folgenden Optionen:

– Zum Importieren/Exportieren einer PCS 7-Projektdatei wählen Sie die Option "PCS 7-
Projekt" aus.

– Zum Importieren/Exportieren einer XML-Datei wählen Sie die Option "XML-Datei" aus.
Empfehlung: Wenn Sie eine XML-Datei importieren/exportieren möchten, aktivieren Sie 
auch die Option "XML-Signatur". Siehe auch Kapitel Austausch digital signierter XML-
Dateien (Seite 167).

4. Um ein PCS 7-Projekt oder eine XML-Datei als Quelle für den Export auszuwählen, klicken 
Sie auf die Schaltfläche "..." neben dem Feld "PCS 7-Projektpfad / XML-Pfad".
Das Dialogfeld "Projektauswahl" wird geöffnet. 

5. Nehmen Sie die erforderlichen Einstellungen vor.

6. Bestätigen Sie die Eingabe.
Das Dialogfeld "Projektauswahl" wird geschlossen. 

7. Wählen Sie die Station, die Sie importieren/exportieren möchten, in der Spalte "Auswahl" 
aus.

Hinweis
Identifikation des Projekt

Die Station dient der Identifikation des Projekts. Wenn Sie das Projekt importieren/
exportieren möchten, wählen Sie auch die Station aus.

8. Aktivieren Sie die erforderlichen Optionen für die Gruppe "Filter".

9. Klicken Sie auf die Schaltfläche "Importieren" oder "Exportieren".
Das Dialogfeld "Datentransfer – Generieren/Importieren" wird geöffnet. Siehe auch 
Kapitel Hinweise zum Dialog "Datentransfer – Generieren/Importieren" (Seite 195).
Wenn Sie noch kein Projekt ausgewählt haben, wird zunächst das Dialogfeld 
"Projektauswahl" geöffnet.

10.Klicken Sie bei Import auf "Objekte von A nach B importieren" oder auf "Objekte von B nach 
A importieren". 
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Ergebnis
Das PCS 7-Projekt wird zusammen mit den ausgewählten Objekten importiert/exportiert. 
Fehler, Warnungen und Nachrichten zum Import/Export werden im Statusfenster angezeigt. 
Siehe auch Kapitel Hinweise zum Dialog "Datentransfer – Generieren/Importieren" (Seite 195).

16.3 Austausch der Technologischen Hierarchie

Ziel
Importieren/Exportieren der Technologischen Hierarchie nach PCS 7 und umgekehrt. Wenn 
bereits eine Technologische Hierarchie vorhanden ist, synchronisiert das Dialogfeld 
"Datentransfer – Generieren/Importieren" die Hierarchieordner miteinander.

Vorgehensweise
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > 

Import / Export PCS 7".

2. Wählen Sie je nach Bedarf das Register "Import" oder "Export" aus.
Siehe auch Kapitel Registerkarte "Import" (Seite 199) und Registerkarte "Export" 
(Seite 201).

3. Aktivieren Sie eine der folgenden Optionen:

– Zum Importieren/Exportieren einer PCS 7-Projektdatei wählen Sie die Option "PCS 7-
Projekt" aus.

– Zum Importieren/Exportieren einer XML-Datei wählen Sie die Option "XML-Datei" aus.
Empfehlung: Wenn Sie eine XML-Datei importieren/exportieren möchten, aktivieren Sie 
auch die Option "XML-Signatur". Siehe auch Kapitel Austausch digital signierter XML-
Dateien (Seite 167).

4. Um ein PCS 7-Projekt oder eine XML-Datei als Quelle für den Import/Export auszuwählen, 
klicken Sie auf die Schaltfläche "..." neben dem Feld "PCS 7-Projektpfad / XML-Pfad".
Das Dialogfeld "Projektauswahl" wird geöffnet.

5. Nehmen Sie die erforderlichen Einstellungen vor.

6. Bestätigen Sie die Eingabe.
Das Dialogfeld "Projektauswahl" wird geschlossen. 

7. Wählen Sie die Stationen, die Sie importieren/exportieren möchten, in der Spalte "Auswahl" 
aus.

8. Wählen Sie in der Gruppe "Filter" die Option "Projekt > Technologische Hierarchie" aus.

9. Klicken Sie auf die Schaltfläche "Importieren" oder "Exportieren".
Das Dialogfeld "Datentransfer – Generieren/Importieren" wird geöffnet. Siehe auch 
Kapitel Hinweise zum Dialog "Datentransfer – Generieren/Importieren" (Seite 195).

10.Klicken Sie bei Import auf "Objekte von A nach B importieren" oder auf "Objekte von B nach 
A importieren". 

11.Klicken Sie auf die Schaltfläche "Schließen", um das Dialogfeld "Datentransfer – 
Generieren/Importieren" zu schließen.
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Ergebnis
Die Technologische Hierarchie wird aus PCS 7 importiert oder nach PCS 7 exportiert, 
basierend auf dem Import/Export-Vorgang in PAA.

16.4 Austausch der HW-Konfiguration

Ziel
So importieren/exportieren Sie die HW-Konfigurationen aus PCS 7/PAA.

Vorgehensweise
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > 

Import / Export PCS 7".

2. Wählen Sie je nach Bedarf das Register "Import" oder "Export" aus.
Siehe auch Kapitel Registerkarte "Import" (Seite 199) und Registerkarte "Export" 
(Seite 201).

3. Um ein PCS 7-Projekt oder eine XML-Datei als Quelle für den Import/Export auszuwählen, 
klicken Sie auf die Schaltfläche "..." neben dem Feld "PCS 7-Projektpfad / XML-Pfad".
Empfehlung: Wenn Sie eine XML-Datei importieren/exportieren möchten, aktivieren Sie 
auch die Option "XML-Signatur". Siehe auch Kapitel Austausch digital signierter XML-
Dateien (Seite 167).
Das Dialogfeld "Projektauswahl" wird geöffnet.

4. Nehmen Sie die erforderlichen Einstellungen vor.

5. Bestätigen Sie die Eingabe.
Das Dialogfeld "Projektauswahl" wird geschlossen.

6.  Wählen Sie zu importierende/exportierende Quellstation in der Liste aus.

Hinweis

Wenn die zu importierende Station auf PAA-Seite bereits in der Liste vorhanden ist, achten 
Sie darauf, dass diese Station ausgewählt ist. Ist sie nicht ausgewählt, wird die Station ein 
zweites Mal erstellt.

7. Wählen Sie in der Gruppe "Filter" die Option "Projekt > Hardware" aus.

8. Wenn Sie auch die Hardwareparameter importieren/exportieren möchten, aktivieren Sie 
die Option "Projekt > Hardware > Erweiterte Parameter".
Siehe auch Kapitel Erweiterte Hardware-Parameter (Seite 133).
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9. Klicken Sie auf die Schaltfläche "Importieren" oder "Exportieren".
Das Dialogfeld "Datentransfer – Generieren/Importieren" wird geöffnet. Siehe auch 
Kapitel Hinweise zum Dialog "Datentransfer – Generieren/Importieren" (Seite 195).

Hinweis
Keine volle Synchronisation in Automation Interface

PC-Stationen und andere Geräte, die nicht mit der Hardware-Konfiguration konfiguriert 
werden können, werden derzeit nicht über das Automation Interface synchronisiert. Stellen 
Sie sicher, dass diese Geräte nicht im Dialogfeld "Datentransfer – Generieren/Importieren" 
ausgewählt werden. Wenn in Ausnahmefällen Fehlermeldungen auch für andere Geräte 
angezeigt werden, wenden Sie sich bitte an den Support.

10.Klicken Sie bei Import auf das Symbol "Objekte von A nach B importieren" oder auf das 
Symbol "Objekte von B nach A importieren".

Ergebnis
Die Hardware wird in das aktuelle PAA-Projekt oder PCS 7-Projekt importiert/exportiert.

Wenn Sie beim Importieren der Hardwareoptionen in PAA die Option "Erweiterte Parameter" 
aktiviert haben, wird das Register "Attribute > Erweiterte Automatisierung" erstellt. Die 
erweiterten Hardwareparameter werden in diesem Register gespeichert.

16.5 Austausch der CFU mit PA-Slaves

Voraussetzungen
Die Compact Field Unit (CFU) mit PA-Slaves ist in einem PCS 7- oder PAA-Projekt erstellt.

Siehe auch Kapitel Anlegen des Kompaktfeldgeräts (CFU) (Seite 113).

Vorgehensweise
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > 

Import / Export PCS 7".

2. Wählen Sie je nach Bedarf das Register "Import" oder "Export" aus.
Siehe auch Kapitel Austausch der HW-Konfiguration (Seite 170) und Austausch eines PAA/
PCS 7-Projekts (Seite 168).

Ergebnis
Die CFU mit PA-Slaves wird in das aktuelle PAA- oder PCS 7-Projekt importiert/exportiert.
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16.6 Austausch von ET 200SP-Modulen

Voraussetzungen
Das PCS 7- oder PAA-Projekt wurde mit ET 200SP erstellt.

Dabei sind folgende Konfigurationen möglich:

● ET 200SP mit PROFIBUS-Interfacemodul

● ET 200SP mit PROFINET-Interfacemodul

Vorgehensweise
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7-Schnittstelle > 

Import / Export PCS 7".

2. Wählen Sie je nach Bedarf das Register "Import" oder "Export" aus.
Siehe auch Kapitel Austausch eines PAA/PCS 7-Projekts (Seite 168) und Austausch der 
HW-Konfiguration (Seite 170).

Hinweis

Um ein Projekt mit ET 200SP von PAA nach PCS 7 zu übertragen, ist es nicht nötig, Base Units 
anzulegen.

Ergebnis
Das Objekt ET 200SP wird in das aktuelle PAA- oder PCS 7-Projekt importiert/exportiert und 
die Struktur wird einschließlich der Busmodule angelegt.

16.7 Austausch von ET 200SP HA-Modulen

Voraussetzungen
Das PCS 7- oder PAA-Projekt wurde mit ET 200SP HA erstellt.

Dabei sind folgende Konfigurationen möglich:

● ET 200SP HA mit einzelnem PROFINET-Interfacemodul

● ET 200SP HA mit redundantem PROFINET-Interfacemodul

● ET 200SP HA mit redundantem Peripheriemodul

● ET 200SP HA mit E/A-Modul für Klemmenblock doppelter Breite

● ET 200SP HA mit E/A-Modul für Potentialgruppe
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Hinweis

ET 200SP HA kann ohne Konfigurationsplan, EI&C-Symbol, Assembly Plan und externe 
Eigenschaften importiert werden.

Vorgehensweise
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > 

Import / Export PCS 7".

2. Wählen Sie je nach Bedarf das Register "Import" oder "Export" aus.
Siehe auch Kapitel Austausch der HW-Konfiguration (Seite 170) und Austausch eines PAA/
PCS 7-Projekts (Seite 168).

Ergebnis
Die Hardware wird in das aktuelle PAA- oder PCS 7-Projekt importiert/exportiert.

16.8 Austausch von ET 200PA SMART-Modulen

Voraussetzungen
Das PCS 7- oder PAA-Projekt wurde mit ET 200PA SMART erstellt. 

Dabei sind folgende Konfigurationen möglich:

● ET 200PA SMART mit einzelnem PROFIBUS-Interfacemodul

● ET 200PA SMART mit redundantem PROFIBUS-Interfacemodul

Vorgehensweise
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > 

Import / Export PCS 7".

2. Wählen Sie je nach Bedarf das Register "Import" oder "Export" aus.
Siehe auch Kapitel Austausch der HW-Konfiguration (Seite 170) und Austausch eines PAA/
PCS 7-Projekts (Seite 168).

Hinweis

Um ein Projekt mit ET 200PA SMART von PAA nach PCS 7 zu übertragen, ist es nicht nötig, 
Bus- und Terminalmodule anzulegen.
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Ergebnis
Die Hardware wird in das aktuelle PAA- oder PCS 7-Projekt importiert/exportiert und die neue 
physische Struktur wird einschließlich der Busmodule und Profilschiene angelegt.

16.9 Austausch von ET 200iSP-Modulen

Voraussetzungen
Das PCS 7- oder PAA-Projekt wurde mit ET 200iSP erstellt.

Dabei sind folgende Konfigurationen möglich:

● ET 200iSP mit einzelnem PROFIBUS-Interfacemodul

● ET 200iSP mit redundantem PROFIBUS-Interfacemodul

Quintessenz
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > 

Import / Export PCS 7".

2. Wählen Sie die Registerkarte "Import" aus.
Siehe auch Kapitel Austausch der HW-Konfiguration (Seite 170) und Austausch eines PAA/
PCS 7-Projekts (Seite 168).

Hinweis

Um ein Projekt mit ET 200iSP von PAA nach PCS 7 zu übertragen, ist es nicht nötig, Bus- und 
Terminalmodule anzulegen.

Ergebnis
Die Hardware wird in das aktuelle PAA- oder PCS 7-Projekt importiert/exportiert und die neue 
physische Struktur wird einschließlich der Busmodule, Terminalmodule und Profilschiene 
angelegt.
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Export von PAA nach PCS 7 17
17.1 Selektiver Transfer

Um spezielle TH-Ordner oder CM/EM-Instanzen zu übertragen, gehen Sie wie folgt vor:

1. Öffnen Sie den Dialog "Import/Export".

2. Suchen Sie das Feld "Gezielter Transfer > Ausgewählte PH/CM/EM".

3. Wählen Sie mehrere Instanzen oder Ordner in der DCS-Struktur aus.
Erlaubte Typen sind: Hierarchieordner, CM/EM-Vorlage / ACM-Vorlage und CM/EM-
Instanzen.

4. Übertragen Sie diese per Drag&Drop.

5. Beachten Sie, dass die Filteroptionen automatisch angepasst werden. Wählen Sie ggf. 
andere.

6. Starten Sie den Export mit der Schaltfläche "Export".

Ergebnis
Der Export kann als Direktexport (PCS 7-Projekt) oder in eine XML-Datei durchgeführt werden.

17.2 Transfer der S7 Einheit
Der Benutzer kann den technologischen Namen einer Einheit in einer CM-Instanz in PAA 
eingeben.

Diese Einheit wird in den entsprechenden ganzzahligen Wert automatisch übertragen (nach 
IEC 61158) beim Transfer nach PCS 7.  

Siehe auch
Unterer Skalierwert / Oberer Skalierwert / Einheit (Seite 38)

17.3 Instanzen exportieren

Voraussetzungen
Die technologische Hierarchie wird aus PAA exportiert und mit der technologischen Hierarchie 
aus PCS 7 synchronisiert.

Siehe Kapitel Austausch der Technologischen Hierarchie (Seite 169).
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Vorgehen
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > 

Import / Export PCS 7".

2. Selektieren Sie die Registerkarte "Export".
Siehe auch Kapitel Registerkarte "Export" (Seite 201).

3. Wählen Sie eine der folgenden Möglichkeiten:

– Um eine PCS 7-Projektdatei zu exportieren, selektieren Sie die Option "PCS 7-Projekt".

– Um eine XML-Datei zu exportieren, selektieren Sie die Option "XML-Datei".
Empfehlung: Wenn Sie eine XML-Datei exportieren, aktivieren Sie auch die Option 
"XML-Signatur". Siehe auch Kapitel Austausch digital signierter XML-Dateien 
(Seite 167).

4. Um ein PCS 7-Projekt oder eine XML-Datei als Quelle für den Export auszuwählen, klicken 
Sie neben dem Feld "PCS 7 Projektpfad / XML-Pfad" auf die Schaltfläche "...".
Der Dialog "Projektauswahl" wird geöffnet. 

5. Nehmen Sie die gewünschten Einstellungen vor.
Bestätigen Sie Ihre Eingaben.

6. Der Dialog "Projektauswahl" wird geschlossen.

7. Aktivieren Sie in der Kontrollgruppe "Filter" die Option "Projekt > CM/EM Instanzen".
Die Option "Technologische Hierarchie" wird automatisch aktiviert, weil Instanzen nur 
zusammen mit der Technologischen Hierarchie exportiert werden können.

8. Um den Export zu starten, klicken Sie auf die Schaltfläche "Export".
Der Dialog "Datentransfer - Generieren/Importieren" wird geöffnet. Siehe auch 
Kapitel Hinweise zum Dialog "Datentransfer – Generieren/Importieren" (Seite 195).

9. Klicken Sie auf die Schaltfläche "Objekte importieren von A nach B". 

10.Bestätigen Sie Ihre Eingaben.

17.4 Typen exportieren

Vorgehen
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > 

Import / Export PCS 7".

2. Selektieren Sie die Registerkarte "Export".
Siehe auch Kapitel Registerkarte "Export" (Seite 201).

3. Um ein PCS 7-Projekt oder eine XML-Datei als Quelle für den Export auszuwählen, klicken 
Sie neben dem Feld "PCS 7 Projektpfad / XML-Pfad" auf die Schaltfläche "...".
Empfehlung: Wenn Sie eine XML-Datei exportieren, aktivieren Sie auch die Option "XML-
Signatur". Siehe auch Kapitel Austausch digital signierter XML-Dateien (Seite 167).
Der Dialog "Projektauswahl" wird geöffnet.

4. Nehmen Sie die gewünschten Einstellungen vor.

5. Bestätigen Sie Ihre Eingaben.
Der Dialog "Projektauswahl" wird geschlossen. 

Export von PAA nach PCS 7
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6. Aktivieren Sie in der Kontrollgruppe "Filter" die Option "Bibliothek > CM/EM Typen".
Aufzählungen, Befehle und Status, Funktionen und Meldeklassen werden wie Typen 
behandelt. 

7. Klicken Sie auf die Schaltfläche "Export".
Der Dialog "Datentransfer - Generieren/Importieren" wird geöffnet. Siehe auch 
Kapitel Hinweise zum Dialog "Datentransfer – Generieren/Importieren" (Seite 195).

8. Klicken Sie auf die Schaltfläche "Objekte importieren von A nach B".

Ergebnis
Die Typen einschließlich der Funktionen und Objekte unter EMTs werden exportiert. Ordnen 
Sie in PCS 7 anschließend die Bausteine, Bausteinkontakte, Bausteinmeldungen etc. zu.

Export von PAA nach PCS 7
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Import von PCS 7 nach PAA 18
18.1 IO Kanal Implementierung

Wenn ein Signal sowohl in der DCS Struktur als auch in der Anlagenstruktur vorhanden ist, 
kann PAA keine Unterscheidung treffen.

Um das Signal gezielt in eine der Strukturen zu importieren, gehen Sie wie folgt vor:

Vorgehen
1. Öffnen Sie den Dialog "Import / Export PCS 7".

2. Wählen Sie die Registerkarte "Import" aus.

3. Wählen Sie Option "PCS 7-Projekt" im Bereich "Projektauswahl".

4. Wählen Sie das PCS 7-Projekt in Feld "PCS 7 Projektpfad / XML-Pfad" aus.

5. Wählen Sie die CM-/EM-Instanzen unter "Projekt" im Bereich "Filter" aus.

6. Im Bereich "Zielstruktur für Signalplanung" wählen Sie entweder Option "DCS" oder "Unit".

7. Klicken Sie auf "Importieren".

Ergebnis
Je nach der gewählten Zielstruktur werden die IO-Kanäle entweder für eine DCS- oder eine 
Anlagenstruktur implementiert.

Hinweis

Für die Implementierung der IO-Kanäle in einer Anlagenstruktur wird eine konfigurierte 
Zuordnungstabelle benötigt. Weitere Informationen über die Konfigurierung von 
Zuordnungstabellen, siehe Kapitel Attribute von PAA und PCS 7 verknüpfen (Seite 161).

18.2 Hardware Transfer
Neu ist ein vollständiger Satz von Hardware Komponenten für den Datenaustausch mit PCS 7 
über den Datentransferdialog.

Aus einem vollständig projektierten PCS 7-Projekt können sämtliche HW Komponenten 
übertragen werden, die für PCS 7 V8.x und höher freigegeben sind.

Alle Hardwarekomponenten in PAA werden in den Ordner "UnspecifiedHW" verschoben.

Beim Rückimport nach PCS 7 werden die HW-Komponenten in PCS 7 HW Config abgelegt.

Über die rechte Maustaste können alle für die eingestellte PCS 7-Version freigegebenen HW-
Komponenten angelegt werden. 
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Unterstützt werden folgende Geräte:

● Profinet 

● Profibus PA 

● GSD/GSDML-Datenaustausch

● Intelligent field devices PA/DP (Micromaster, Sinamics (DriveES), Simocode)

18.3 Attribute von CM
Bei der Datenübertragung wird nun auch das Attribut "Version" von CM berücksichtigt.

18.4 PCS 7 Bibliotheken in COMOS verwalten
Es können nun mehrere Bibliotheken in PAA importiert werden.

1. Import einer PCS 7 Bibliothek an einen spezifischen Ort in COMOS 

2. Import weiterer Bibliotheken 

3. Festlegen der Masterbibliothek (wird beim Datenaustausch genutzt)

Alle Bibliotheken werden in COMOS dann am spezifischen Ort abgelegt aber hierarchisch 
geordnet. 

Standardmäßig entspricht der Name der Bibliothek in PAA dem PCS 7-Projektnamen.

Bibliotheken bearbeiten im Typ-Konfigurator
Sie haben die Möglichkeit folgender Aktionen im Typ-Konfigurator:

Spalte "Bibliothek"

● Anlegen von CMT, Aufzählungen und Funktionen

● Aktualisieren der Elemente

● Verschieben und Ändern der Elemente

Spalte "Struktur"

● Anpassen der Struktur durch Drag&Drop 

● Erstellen von Varianten von CMT

18.5 Auswirkungen des Imports der Technologischen Hierarchie

Voraussetzung
● Die technologische Hierarchie aus PCS 7 wurde importiert.

Siehe Kapitel Austausch der Technologischen Hierarchie (Seite 169).

Import von PCS 7 nach PAA
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Auswirkungen des Abgleichs auf bestehende Hierarchieordner
● Option "Im Ziel löschen": Ausgeschaltet

Hierarchieordner werden nicht gelöscht. Bereits vorhandene Hierarchieordner werden nicht 
doppelt angelegt.

Auswirkungen des Abgleichs neuer Hierarchieordner aus PCS 7
Hierarchieordner aus PCS 7, die in PAA nicht vorhanden sind, werden in die technologische 
Hierarchie des Knotens "DCS Struktur" hinzugefügt.

18.6 Einzelsteuereinheiten und Technische Einrichtungen importieren

Voraussetzungen
Um Einzelsteuereinheiten und Technische Einrichtungen in PAA zu importieren, müssen 
folgende Informationen für jede Einzelsteuereinheit und jede Technische Einrichtung in PCS 7 
vorhanden sein:

● Technologische Hierarchie

● Typ der Einzelsteuereinheit

● Typ der Technischen Einrichtung

● Verwendete Parameter und Signale

● Der Typ der Einzelsteuereinheit und der Typ der Technischen Einrichtung müssen in PAA 
bereits vorhanden sein.

Hinweis
Geänderte Varianten importieren

In den folgenden Fällen können die geänderten Varianten importiert werden:
● Import von CM-Variante mit hinzugefügten optionalen Bausteinen, CMT-Variante ist in PAA 

vorhanden
● Import von CM-Variante mit hinzugefügten optionalen Bausteinen, CMT-Variante ist nicht 

in PAA vorhanden
● Import von CM-Variante mit entfernten optionalen Bausteinen, CMT-Variante ist in PAA 

vorhanden
● Import von CM-Variante mit entfernten optionalen Bausteinen, CMT-Variante ist nicht in 

PAA vorhanden

Vorgehen
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > 

Import / Export PCS 7".

2. Selektieren Sie die Registerkarte "Import".
Siehe auch Kapitel Registerkarte "Import" (Seite 199).

Import von PCS 7 nach PAA
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3. Um ein PCS 7-Projekt oder eine XML-Datei als Quelle für den Import auszuwählen, klicken 
Sie neben dem Feld "PCS 7 Projektpfad / XML-Pfad" auf die Schaltfläche "...".
Empfehlung: Wenn Sie eine XML-Datei exportieren, aktivieren Sie auch die Option "XML-
Signatur". Der Import erwartet, dass eine signierte XML-Datei übergeben wird. Siehe auch 
Kapitel Austausch digital signierter XML-Dateien (Seite 167).

4. Aktivieren Sie in der Kontrollgruppe "Filter" die Option "CM/EM Instanzen".

5. Klicken Sie auf die Schaltfläche "Import".
Der Dialog "Datentransfer – Generieren/Importieren" wird geöffnet. Siehe auch 
Kapitel Hinweise zum Dialog "Datentransfer – Generieren/Importieren" (Seite 195).

6. Klicken Sie auf die Schaltfläche "Objekte importieren von B nach A".

Hinweis
Import der Signalattribute oberer/unterer Skalierungswert, Einheit

In der Voreinstellung ist die Option "Signalattribute oberer/unterer Skalierungswert, Einheit" in 
der Gruppe "Filter" ausgewählt, wenn Sie das Plugin "Import / Export" öffnen. Wenn Sie diese 
Attribute nicht importieren möchten, wählen Sie diese Option ab.

Ergebnis
Die Einzelsteuereinheiten und Technischen Einrichtungen werden in das aktuelle PAA-Projekt 
importiert.

Siehe auch
Einzelsteuereinheitstypen importieren (Seite 35)

18.7 Importieren von EM/EMT aus PCS 7 ohne Ablaufkette

Zielsetzung
Die angelegten/bearbeiteten EMs/EMTs und die Logik in PCS 7 kann importiert und in PAA 
verwendet werden.

Siehe auch Kapitel Technische Einrichtungen auf dem Funktionsplan bearbeiten (Seite 149).

Die folgenden Objekte können aus PCS 7 in PAA importiert werden:

● Eigene EM/EMT-Parameter 

● Mit EM/EMT-Parametern verschaltete Parameter

● Signale (eigene und verschaltete)

● Meldungen 

● Zuordnungen von Einzelsteuereinheiten

● Einzelsteuereinheiten

Import von PCS 7 nach PAA
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● Funktionen

● Ablaufplanung (standardmäßig angelegt)

● Kennlinien

● Kennlinienordner für verschiedene Arten von Kennlinien

● Alle Kennlinienparameter

Die folgenden Objekte von in PCS 7 angelegten EMTs werden nicht in PAA unterstützt:

● Ablaufkette

● EM (EM unterhalb von EMT)

● Technische Funktionen

● Varianten von EMs

18.8 ET 200M von PCS 7 in PAA importieren

Voraussetzungen
Das PCS 7-Projekt mit ET 200M ist angelegt.

Siehe auch Abschnitt Anlegen von Bundles beim Anlegen der ET 200M-Station in Kapitel ET 
200-Stationen mit dem HW-Konfigurationswerkzeug konfigurieren (Seite 125).

Die folgenden Konfigurationen sind möglich:

● ET 200M mit einzelnem PROFIBUS-Interfacemodul

● ET 200M mit redundantem PROFIBUS-Interfacemodul

● ET200M mit PROFINET-Interfacemodul

Vorgehen
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > 

Import / Export PCS 7".

2. Wählen Sie die Registerkarte "Import".
Siehe auch Kapitel Austausch der HW-Konfiguration (Seite 170).

Ergebnis
Die Hardware wird in das aktuelle PAA-Projekt importiert. Die physikalische Struktur wird 
einschließlich Busmodulen und Profilschiene angelegt.

Import von PCS 7 nach PAA
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Plugin für NE 150-Import 19
19.1 NE 150-Import

Einführung
Das Plugin "NE 150-Import" dient zum Importieren der Daten aus den NE 150-Dateien und der 
entsprechenden Mapping-Datei in einem Excel-Format. Die NE 150-Importkomponente liest 
die NE 150-Dateien (entweder XML oder AML), und Hierarchieordner und CM-Instanzen 
können in PAA importiert werden. Die Werte aus der NE150-Datei mit einer entsprechenden 
Zuordnung in der Excel-Bibliotheksdatei werden in PAA importiert. Später werden die Daten im 
PAA verwendet und über das Automation Interface in PCS 7 oder XML exportiert.

Voraussetzungen
● Ein Planungsprojekt ist geöffnet.

● NE 150-Datei (XML oder AML)

● Bibliotheksdatei (BPCMT_Lib_NE150_V1.0 xlsx / xls)
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Vorgehensweise
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > NE 

150-Import".
Oder: 
Klicken Sie auf das Symbol "NE 150-Import" in der Symbolleiste, wie im nachfolgenden Bild 
gezeigt.

2. Die DCS-Struktur ist standardmäßig im Feld "Zielobjekt" ausgewählt, Sie können auch die 
TH-Ordner mit der Maus unter die DCS-Struktur ziehen.

Hinweis

In PCS 7 gibt es einen Grenzwert von 8 Hierarchieebenen, doch in PAA gibt es keinen 
Grenzwert für die Hierarchieebenen.

Plugin für NE 150-Import
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3. Klicken Sie auf die Schaltfläche "...", um die "NE 150-Datei" und die "Bibliotheksdatei" 
auszuwählen.

Hinweis

Die Bibliotheksdatei finden Sie im NE 150-Ordner im Pfad "C:\Programme\Siemens\PCS 7 
Plant Automation Accelerator\V3.0.1\NE150.

4. Deaktivieren Sie die Option "In neue Arbeitsschicht importieren", um die Datei in die 
bestehende Arbeitsschicht zu importieren. Standardmäßig ist die Option aktiviert.

5. Klicken Sie auf "Importieren".
Fehler, Warnungen und Nachrichten zum Import werden im Statusfenster angezeigt. So 
erfährt der Anwender den Status, alle Fehler oder Warnungen während der Ausführung.

Hinweis

Die Schaltfläche "Importieren" ist erst aktiviert, wenn beide Dateien, NE 150 und Bibliothek, 
ausgewählt sind.

Hinweis
● Existiert bereits ein Hierarchieobjekt mit dem gleichen Namen, wird kein Hierarchieobjekt 

angelegt, sondern es wird das vorhandene Objekt verwendet und die Attribute werden 
importiert.

● Wenn die CM-Instanz mit dem gleichen Namen bereits existiert, wird keine neue CM-
Instanz angelegt. In diesem Fall wird die vorhandene CM-Instanz verwendet und die 
Attribute werden trotzdem importiert.

● Alle Attributfelder sind "optional" und der Import wird trotzdem fortgesetzt, auch wenn ein 
Attribut fehlt.

Plugin für NE 150-Import
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Ergebnis
Sobald der Import abgeschlossen ist, wird die NE 150-Struktur einschließlich der 
Hierarchieobjekte, CM-Instanzen und Attribute unter der DCS-Struktur angelegt wie im 
nachfolgenden Beispielbild dargestellt.

Plugin für NE 150-Import
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Mit Reports arbeiten 20
20.1 Signalverbindungen auf Funktionsplan

Beim Öffnen des Funktionsplans wird die Verbindung zwischen Einzelsteuereinheitsignal und 
Signal der angeschlossenen Anlage angezeigt.

Es ist möglich, zum IO-Kanal zu navigieren, der mit der Kanalanforderung des Signals 
implementiert wird.

Siehe auch Kapitel Mit Negationen arbeiten (Seite 154).

Hinweis

Führen Sie vor dem Druck oder PDF-Export von Funktionsplänen zunächst die Auswertung 
der Berichte durch. 

Dies geschieht im Menü "Dokumente > Auswerten". Platzieren Sie das Objekt per Drag&Drop 
im Feld "Objekt(e) starten", selektieren Sie alle Funktionspläne und klicken Sie auf 
"Ausführen". Im Hintergrund werden alle Funktionspläne geöffnet, alle relevanten Parameter- 
und Signalobjekte platziert und verbunden und die Funktionspläne wieder geschlossen.  
Danach sind Sie sicher, dass im Bericht alle relevanten Informationen verfügbar sind.

20.2 Assembly Plan

Voraussetzung
● Sie haben eine AS-Station vom Typ SIMATIC 400 angelegt.

● Sie haben dezentrale Peripherie vom Typ ET 200M oder ET 200iSP oder ET 200SP HA 
oder ET 200PA SMART oder ET 200SP angelegt.

Nutzen
Der Assembly Plan zeigt die Profilschiene mit den einzelnen Komponenten und wertet 
Zusatzinformationen aus, wie zum Beispiel die Verlustleistung. 

Konfiguration
Um die Tabelle "Verlustleistung" und die "Details" auf dem Assembly Plan auszublenden, 
deaktivieren Sie die Optionen im Register "Attribute > Design" in den Eigenschaften des 
Berichts. 
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Verwenden des Assembly Plan
Der Assembly Plan wird automatisch unterhalb der Station angelegt, wenn das "HW-
Konfigurationswerkzeug" verwendet wird. Der Assembly Plan kann auch angelegt werden, 
indem Sie mit der rechten Maustaste auf den Slave klicken. Wenn die Konfiguration geändert 
wird, aktualisieren Sie den Assembly Plan, um die Aktualisierungen anzuzeigen.

20.3 E/A-Bericht

Voraussetzung
● Im Navigator ist die Registerkarte "Orte" selektiert.

● Ein Schaltschrank ist angelegt.

Nutzen
Unter dem Schaltschrank erzeugen Sie den E/A-Bericht. Der Report gibt eine Übersicht über 
verwendete und freie Kanäle pro Schrank.

Konfiguration
In den Eigenschaften des Reports konfigurieren Sie auf der Registerkarte "Attribute > Design", 
wie die Kanäle auf dem Report dargestellt werden. Sie haben die Möglichkeit beide Optionen 
miteinander zu kombinieren oder keine Option zu selektieren.

Option Beschreibung
"Gruppiert" Die aktivierte Option bewirkt, dass die Objekte 

nach ihrer MLFB sortiert angezeigt werden. Sie 
erhalten eine Übersicht über die Anzahl gleicher 
Objekte.

"Detailliert" Die aktivierte Option bewirkt, dass die Objekte 
nach dem Eigentümer sortiert angezeigt werden.

20.4 Stückliste

Voraussetzung
● Im Navigator ist die Registerkarte "Orte" selektiert.

● Ein Schaltschrank ist angelegt.

Mit Reports arbeiten
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Nutzen
Unterhalb des Schranks legen Sie die Stückliste an. Die Stückliste gibt eine Übersicht über alle 
bestellrelevanten Objekte. 

● Stückliste mit Bundles
Enthält Bundle MLFBs, die jeweils eine Sammlung von Objekten beinhalten.

● Stückliste ohne Bundles
Enthält keine Bundle MLFBs. Alle Objekte werden separat aufgelistet.

Konfiguration
In den Eigenschaften des Reports konfigurieren Sie auf der Registerkarte "Attribute > Design", 
wie die Objekte auf dem Report dargestellt werden. Sie haben die Möglichkeit beide Optionen 
miteinander zu kombinieren oder keine Option zu selektieren.

Option Beschreibung
"Gruppiert" Die aktivierte Option bewirkt, dass die Objekte 

nach ihrer MLFB sortiert angezeigt werden. Sie 
erhalten eine Übersicht über die Anzahl gleicher 
Objekte.

"Detailliert" Die aktivierte Option bewirkt, dass die Objekte 
nach dem Eigentümer sortiert angezeigt werden.

20.5 Configuration plan

Einleitung
Der Projektierungsplan zeigt eine Übersicht der Anlagenkonfiguration. Die 
Netzwerkkonfiguration der S7 400- und ET 200-Slaves wird mit Hilfe der Anschlüsse der 
Ortsobjekte im Projektierungsplan angelegt.

Voraussetzung
● Im Navigator ist die Registerkarte "Orte" selektiert.

● Ein Schaltschrank ist angelegt.

Hinweis

Die alten Projektierungspläne werden in der neuen PAA-Version nicht mehr unterstützt.

Nutzen
Sie erstellen den Projektierungsplan unter dem Schaltschrank.  Er zeigt eine grobe Struktur der 
Anlage einschließlich aller Hardwarekomponenten und aller Linien- und Ringbusse.

Mit Reports arbeiten
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Folgende Objekte werden angezeigt:

● S7 400 Stationen

● ET 200 Stationen

● Workstations 

● Anlagenbus

● Terminalbus

Platzieren Sie die gewünschten Objekte per Drag&Drop auf dem Configuration Plan und 
verbinden Sie diese.

Allgemeine Funktionalitäten für Slaves
Die neuen intelligenten und dynamischen Symbole für die Slaves ET 200M (DP und PN), ET 
200PA SMART (DP), ET 200iSP (nur DP), ET 200SP HA (nur PN) und ET 200SP (DP und PN, 
keine R1-Redundanz) haben die folgenden Funktionalitäten:

● Interfacemodule können ausgewählt und zu ihrem Objekt kann navigiert werden
Klicken Sie mit der rechten Maustaste auf das Interfacemodul > "Navigieren" > "Objekt".

● Bei PROFIBUS und Ethernet können die Anschlüsse unter dem IM dynamisch erfasst und 
angezeigt werden
Wenn dem Slave ein zweites IM hinzugefügt oder daraus entfernt wird, ändern sich die 
Anschlüsse dynamisch

● An jedem Anschluss wird eine Identifikation für den Subtyp (Grün bei Ethernet und Lila bei 
PROFIBUS) angegeben.
Eine Verbindung kann nur für den gleichen Subtyp hergestellt werden.

● Die Kennung des Slave wird angezeigt und kann bearbeitet werden.

● Der Assembly Plan des Slave kann über die COMOS-Standardfunktion geöffnet werden.
Klicken Sie mit der rechten Maustaste auf den Slave > "Navigieren" > "Dokumente unten" 
> "Assembly Plan".

Hinweis
● Für den ET 200SP Slave ist der Assembly Plan nicht verfügbar
● Für ET 200iSP werden standardmäßig zwei Netzteile angezeigt, unabhängig von der Art 

der Stromversorgung (einzeln oder redundant)

Hinweis

E/A sind nur statische Bilder und nicht die genaue Konfiguration.

Mit Reports arbeiten
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Allgemeine Funktionalitäten für SIMATIC S7 400 Stationen
Die neuen intelligenten und dynamischen Symbole für die S7-400 Stationen haben die 
folgenden Funktionalitäten:

● CPU / CP können ausgewählt und zu ihrem Objekt kann navigiert werden
Klicken Sie mit der rechten Maustaste auf CPU / CP > "Navigieren" > "Objekt".

● Bei PROFIBUS und Ethernet können die Anschlüsse unter dem CPU / CP dynamisch 
erfasst und angezeigt werden
Wenn der Station ein zweiter CP hinzugefügt oder daraus entfernt wird, ändern sich die 
Symbole dynamisch.

● Die Kennung der Station wird angezeigt und kann bearbeitet werden

● Der Assembly Plan der Station kann über die COMOS-Standardfunktion geöffnet werden
Klicken Sie mit der rechten Maustaste auf die Stationskennung > "Navigieren" > 
"Dokumente unten" > "Assembly Plan".

Hinweis

Peripheriebaugruppen werden im Projektierungsplan der Station nicht angezeigt. Es werden 
nur PS-/CPU-/CP-Stationen angezeigt.

An jedem Anschluss wird eine Identifikation für den Subtyp (Grün bei Ethernet und Lila bei 
PROFIBUS) angegeben. Verbindungen können nur für den gleichen Subtyp hergestellt 
werden.

Die Größe der Einzelstation ist dynamisch. Auf der anderen Seite ist die Größe der 
redundanten Station festgelegt, selbst wenn keine CPs angeordnet werden.

Hinweis

In ein und demselben Projektierungsplan wird das Symbol für die mehrfache Anordnung der 
gleichen Station bzw. des gleichen Slave nicht angezeigt.

20.6 Konfigurierbare Symbole
Das Anpassen der Symbole auf einem Funktionsplan ist jetzt möglich. Angepasst werden 
können:

● Reihenfolge der Anschlüsse

● Bezeichnung der Anschlüsse 

● Position der Anschlüsse

● Blockname

● Icon 

Logikbausteine werden der runtime Gruppe automatisch zugeordnet.

Hier werden auch alle Funktionen der Einzelsteuereinheit (CM) angezeigt.

Die Beziehung zwischen der CM und den Funktionen basiert auf den Eingangsverbindungen.

Mit Reports arbeiten
20.6 Konfigurierbare Symbole
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Wenn an der Randleiste nicht ausreichen Platz zur Darstellung der Eingangs – oder 
Ausgangssignale zur Verfügung steht, wird automatisch ein Überlaufblatt erstellt. Auf diesem 
Überlaufblatt wird eine gegraute Volldarstellung der Bausteine auf dem Plan mit den Signalen 
der Randverschaltung, die nicht auf das erste Blatt gepasst haben, dargestellt.

20.7 Computer Datenblatt

Voraussetzung
● Im Navigator ist die Registerkarte "Orte" selektiert.

● Eine Workstation ist angelegt.

Nutzen
Unterhalb der Workstation legen Sie das Computer Datenblatt an. Das Datenblatt gibt eine 
Übersicht über die Konfiguration der Workstation. Ausgewertet werden Informationen zu 
folgenden Bereichen:

● Beschaffung 

● Installation 

● Hardware

● Sonstige Einstellungen

● Software

● Lizenzen

Konfiguration
Das Computer Datenblatt wertet die Registerkarten "Attribute > Computer Information" und 
"Attribute > Software" der Workstation aus. Die Informationen zu den Lizenzen stammen aus 
dem Ordner "Lizenzen", der im Navigator parallel zur Workstation liegt.

Sie haben die Möglichkeit die Informationen direkt im Computer Datenblatt einzutragen. Die 
Attribute der Workstation werden automatisch geändert.

Auf der Registerkarte "Attribute > Software" der Workstation importieren Sie eine CSV-Datei 
oder tragen die Informationen direkt in die Liste ein.

Mit Reports arbeiten
20.7 Computer Datenblatt
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Referenz 21
21.1 Hinweise zum Dialog "Datentransfer – Generieren/Importieren"

Zielsetzung
Der Dialog "Datentransfer – Generieren/Importieren" ist die Oberfläche des Automation 
Interface. Über diesen Dialog werden die Engineering-Daten sowohl im Planungsprojekt als 
auch im Stammprojekt importiert. 

Protokolldatei
Alle Ereignisse während des Datentransfers werden im Statusfenster protokolliert. Am oberen 
Rand des Statusfensters stellen Sie ein, welche Systemmeldungen ausgegeben werden:

● "Fehler"
Zeigt Fehler an. Wenn Fehler vorhanden sind, kann der Import/Export nicht durchgeführt 
werden.

● "Warnungen"
Zeigt Hinweise zu Fehlern an, die zwar einen Import/Export zulassen, die aber zu einem 
unerwünschten Ergebnis führen können.

● "Nachrichten"
Protokolliert den Import- / Exportvorgang. 

Die Einträge im Statusfenster sind kontextsensitiv. Wenn Sie den Eintrag im Statusfenster per 
Doppelklick aktivieren, springt die Selektion im Quelltext an die entsprechende Stelle.

Option "Im Ziel löschen"
Die aktivierte Option bewirkt:

● Im Rahmen des Imports existieren zu löschende Objekte:

– Die Objekte existieren in PAA, aber nicht in der Importdatei. 

– Im Dialog "Datentransfer – Generieren/Importieren" sind diese Objekte blau gefärbt. 

Kein vollständiger Abgleich im Automation Interface
PC Stationen und andere, nicht über die Hardwarekonfiguration projektierbare Geräte, werden 
derzeit nicht über das Automation Interface abgeglichen. Achten Sie darauf, dass im Dialog 
"Datentransfer – Generieren/Importieren" diese Geräte nicht selektiert sind. Wenn in 
Ausnahmefällen auch bei anderen Geräten Fehlermeldungen erscheinen, wenden Sie sich an 
den Support. 

Die Eigenschaften von Status und Befehlen werden bei jedem Export nach PCS 7 
überschrieben. Dadurch sind diese im Automation Interface bei jedem Vergleich 
unterschiedlich farblich markiert.
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Hilfe zum Dialog "Datentransfer – Generieren/Importieren" aufrufen
1. Öffnen Sie den Dialog "Datentransfer – Generieren/Importieren".

2. Klicken Sie auf die Schaltfläche "Hilfe".

Siehe auch
Export von PAA nach PCS 7 (Seite 175)

Import von PCS 7 nach PAA (Seite 179)

21.2 Navigator

Registerkarte "Anlagen"
In der Registerkarte "Anlagen" projektieren Sie die Technologische Hierarchie (TH) und führen 
das Software-Engineering durch. 

Icon Registerkarte Beschreibung
"Anlagen" ● Technologische Hierarchie

Zusätzlich stehen hier folgender Knoten zur Verfügung:
● "Kopiervorlagen"

Enthält die importierte Einzelsteuereinheitenbibliothek mit den 
Einzelsteuereinheitstypen aus PCS 7. Dieser Ordner wird erst 
nach Ausführung der Funktion "Vorlagen erstellen" angelegt.

Der Knoten @Template enthält folgende Objekte:

Icon Beschreibung
Projektbibliothek
Sammelordner für Aufzählungstypen

Aufzählung

Template-Container

Sammelordner für CM-/EM-Typen

CM Typ/Varianten Sammlung

CMT Vorlage

Meldung

Signal

Sammelordner für Befehle

Befehl

EMT-Vorlage

EMT

Referenz
21.2 Navigator
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Icon Beschreibung
EP-Ablaufplanung
Zuordnung CM
Parameter

Sammelordner für Funktionen

Funktion
Sammelordner für Status

Status

DCS Struktur:

Icon Beschreibung
DCS Struktur

Hierarchieordner

Hierarchieordner mit S88-Typisierung "Anlage"

Hierarchieordner mit S88-Typisierung "Teilanlage"

Anlagenstruktur:

Icon Beschreibung
Project

DCS Struktur

Werk

Anlage

Teilanlage

A50 EI&C
Position

Registerkarte "Orte"
Auf der Registerkarte "Orte" werden die Objekte für die Hardware projektiert. 

Icon Registerkarte Beschreibung
"Orte" Projektierte Hardware

Auf dieser Registerkarte sind gemäß dem Beispiel in dieser Dokumentation folgende Objekte 
vorhanden:

Icon Beschreibung
Projekt

Werk

Referenz
21.2 Navigator
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Icon Beschreibung
Gebäude

Geschoss, Etage

Raum, Zentrale

Schrank

Station

Baugruppenträger

Stromversorgung

Kommunikation

Zentralbaugruppe

21.3 Plugin "Import / Export PCS 7"

21.3.1 Plugin "Import / Export PCS 7" aufrufen

Zielsetzung
Transfer der Engineering-Daten zwischen PCS 7 und PAA.

Vorgehen
1. Wählen Sie in der Menüleiste den Befehl "Plugins > Automation > PCS 7 Schnittstelle > 

Import / Export PCS 7".

Ergebnis
Das Plugin "Import / Export PCS 7" wird geöffnet.

Zum Transfer von Engineering-Daten stehen Ihnen folgende Registerkarten zur Verfügung:

● Registerkarte "Import"
Siehe auch Kapitel Registerkarte "Import" (Seite 199).

● Registerkarte "Export"
Siehe auch Kapitel Registerkarte "Export" (Seite 201).

Referenz
21.3 Plugin "Import / Export PCS 7"
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21.3.2 Registerkarte "Import"

Zielsetzung
Nach der Auswahl eines PCS 7-Projekts importieren Sie auf dieser Registerkarte die 
ausgewählten Objekte von PCS 7 nach PAA. 

Kontrollgruppe Kontrollelement Beschreibung
"Projektaus‐
wahl"

Option "PCS 7 Projekt" Die aktivierte Option bewirkt, dass Sie eine PCS 7-
Projektdatei importieren können.

Option "XML-Datei" Die aktivierte Option bewirkt, dass Sie eine XML-Da‐
tei importieren können.

Option "XML Signatur" Die aktivierte Option bewirkt, dass PAA die selektierte 
XML-Datei nach einer digitalen Signatur durchsucht. 
Siehe auch Kapitel Austausch digital signierter XML-
Dateien (Seite 167).

Liste "PCS 7 Projektpfad / 
XML-Pfad"

In dieser Liste wählen Sie das Zielprojekt aus.
Pro Windows-Benutzer werden bis zu 10 PCS 7- oder 
XML-Projekte angezeigt. Die Projekte werden im Be‐
nutzer-Ordner gespeichert: <Benutzer> > AppData > 
Local > <Options-datei>

Schaltfläche "Wähle ein Pro‐
jekt"

Je nach gewählter Option öffnen Sie über diese 
Schaltfläche das Fenster "Projektauswahl" oder das 
Fenster "Öffnen":

"Filter > Projekt" Option "Technologische Hie‐
rarchie"

Berücksichtigt im gewählten Quellprojekt folgende 
Objekte: 
● Alle PCS 7-Objekte der Technologischen 

Hierarchie
Nach dem Import werden die Objekte im Knoten 
"DCS-Struktur" erzeugt. 

Option "CM/EM-Instanzen" Berücksichtigt im gewählten Quellprojekt folgende 
Objekte: 
● Alle PCS 7-Instanzen
Nach dem Import werden die Objekte im Knoten 
"@Template" erzeugt.

Option "Hardware" Berücksichtigt im gewählten Quellprojekt folgende 
Objekte: 
● Alle Hardware-Objekte aus PCS 7
Nach dem Import werden die Objekte im Knoten 
"DCS-Struktur" erzeugt.

Option "Erweiterte Parame‐
ter"

Berücksichtigt im gewählten Quellprojekt folgende 
Objekte
● Alle Hardware-Objekte aus PCS 7
● Die erweiterten Hardware-Parameter der Objekte
 Siehe auch Kapitel Erweiterte Hardware-Parameter 
(Seite 133).
Nach dem Import wird an den Hardware-Objekten die 
Registerkarte "Attribute > Automation erweitert" an‐
gezeigt.

Referenz
21.3 Plugin "Import / Export PCS 7"
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Kontrollgruppe Kontrollelement Beschreibung
"Filter > Biblio‐
thek"

Option "CM/EM Typen" Berücksichtigt im gewählten Quellprojekt folgende 
Objekte: 
● Alle PCS 7-Typen
Nach dem Import werden die Objekte folgenderma‐
ßen angelegt:
● Knoten "Kopiervorlagen": "PCS 7 Kopiervorlage > 

PCS 7 Lib Bibliotheksordner"
Option "Aufzählungen" Berücksichtigt im gewählten Quellprojekt folgende 

Objekte
● Alle Aufzählungen aus PCS 7
 Siehe auch Kapitel Verwaltung von Aufzählungen 
(Seite 61).

Option "Meldeklassen" Berücksichtigt im gewählten Quellprojekt folgende 
Objekte:
● Alle Meldungen im Knoten "Projekt"

Option "Befehle & Status" Berücksichtigt im gewählten Quellprojekt folgende 
Objekte:
● Die Befehls- und Statusbibliothek aus PCS 7.
 

Option "Funktionen" Berücksichtigt im gewählten Quellprojekt folgende 
Objekte
● Alle Funktionen aus PCS 7
Siehe auch Kapitel Funktionen erzeugen (Seite 28).

"Filter > Sonsti‐
ges"

Option "Signalattribute obe‐
rer, unterer Skalierungswert, 
Einheit"

Berücksichtigt im gewählten Quellprojekt folgende 
Objekte:
● Oberer Skalierungswert
● Unterer Skalierungswert
● Einheit

 Schaltfläche "Import" Startet den Import
"Gezielter 
Transfer"

"Ausgewählte PH/CM/EM" Ermöglicht selektiven Transfer einzelner Ebenen.

"Filter:" Tabelle "Filter:" Zeigt Fehler, Warnungen und Nachrichten an

Siehe auch
Einzelsteuereinheitstypen importieren (Seite 35)

Einzelsteuereinheiten und Technische Einrichtungen importieren (Seite 181)

Plugin "Import / Export PCS 7" aufrufen (Seite 198)

Referenz
21.3 Plugin "Import / Export PCS 7"
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21.3.3 Registerkarte "Export"
Auf dieser Registerkarte exportieren Sie die ausgewählten Objekte von PAA nach PCS 7.

Kontrollgruppe Kontrollelement Beschreibung
"Projektaus‐
wahl"

Option "PCS 7 Projekt" Die aktivierte Option bewirkt, dass Sie eine PCS 7-Pro‐
jektdatei importieren können.

Option "XML-Datei" Die aktivierte Option bewirkt, dass Sie eine XML-Datei 
importieren können.

Option "XML Signatur" Die aktivierte Option bewirkt, dass die selektierte XML-
Datei digital signiert wird. Siehe auch Kapitel Austausch 
digital signierter XML-Dateien (Seite 167).

Feld "PCS 7 Projektpfad/ 
XML-Pfad"

Zeigt die für den Import ausgewählte Datei an. 
In dieser Liste wählen Sie das Zielprojekt aus.
 Pro Windows-Benutzer werden bis zu 10 PCS 7- oder 
XML-Projekte angezeigt. Die Projekte werden im Benut‐
zer-Ordner gespeichert: <Benutzer> > AppData > Local 
> <Options-datei>

Schaltfläche "Wähle ein 
Projekt"

Je nach gewählter Option öffnen Sie über diese Schalt‐
fläche das Fenster "Projektauswahl" oder das Fenster 
"Öffnen":

Tabelle Wählen Sie in der Spalte "Auswahl" die Stationen, die 
am Export teilnehmen sollen.

"Filter > Projekt" Option "Technologische 
Hierarchie"

Berücksichtigt im gewählten Quellprojekt folgende Ob‐
jekte: 
● Alle Objekte der Technologischen Hierarchie im 

Knoten "Projekt > PV Technologische Sicht"
Siehe auch Kapitel Austausch der Technologischen 
Hierarchie (Seite 169).

Option "CM/EM-Instan‐
zen"

Berücksichtigt im gewählten Quellprojekt folgende Ob‐
jekte: 
● Alle Instanzen im Knoten "Projekt > PV 

Technologische Sicht" 
Siehe auch Kapitel Instanzen exportieren 
(Seite 175).

Option "Hardware" Berücksichtigt im gewählten Quellprojekt folgende Ob‐
jekte: 
● Alle Hardware-Objekte im Knoten "Projekt"

Siehe auch Kapitel Austausch der HW-Konfiguration 
(Seite 170).

Option "Erweiterter Para‐
meter"

Berücksichtigt im gewählten Quellprojekt folgende Ob‐
jekte: 
● Alle Hardware-Objekte im Knoten "Projekt"
● Die erweiterten Hardware-Parameter der Hardware-

Objekte
Siehe auch Kapitel Erweiterte Hardware-Parameter 
(Seite 133).

Referenz
21.3 Plugin "Import / Export PCS 7"
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Kontrollgruppe Kontrollelement Beschreibung
"Filter > Biblio‐
thek"

Option "CM/EM Typen" Berücksichtigt im gewählten Quellprojekt folgende Ob‐
jekte: 
● Alle Typen im Knoten "Projekt > PV Technologische 

Sicht"
Option "Aufzählungen" Berücksichtigt im gewählten Quellprojekt folgende Ob‐

jekte:
● Alle Aufzählungen im Knoten "Projekt"
Siehe auch Kapitel Verwaltung von Aufzählungen (Sei‐
te 61).

Option "Meldeklassen" Berücksichtigt im gewählten Quellprojekt folgende Ob‐
jekte:
● Alle Meldungen im Knoten "Projekt"

Option "Befehle & Status" Berücksichtigt im gewählten Quellprojekt folgende Ob‐
jekte:
● Die Befehls- und Statusbibliothek 
 

Option "Funktionen" Berücksichtigt im gewählten Quellprojekt folgende Ob‐
jekte:
● Alle Funktionen im Knoten "Projekt"
Siehe auch Kapitel Funktionen erzeugen (Seite 28).

"Filter > Sonsti‐
ges"

Option "Signalattribute 
oberer, unterer Skalie‐
rungswert, Einheit"

Berücksichtigt im gewählten Quellprojekt folgende Ob‐
jekte:
● Oberer Skalierungswert
● Unterer Skalierungswert
● Einheit

 Schaltfläche "Export" Startet den Export 
"Gezielter 
Transfer"

"Ausgewählte 
PH/CM/EM"

Ermöglicht selektiven Transfer einzelner Ebenen.

"Filter:" Tabelle "Filter:" Zeigt Fehler, Warnungen und Nachrichten an

Siehe auch
Plugin "Import / Export PCS 7" aufrufen (Seite 198)

21.4 Referenz zur Verknüpfungstabelle

Zielsetzung
Sie können den eingefügten PCS 7-Einzelsteuereinheiten in der Verknüpfungstabelle PAA-
Attribute zuweisen. 

Referenz
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Verknüpfungstabelle aufrufen
1. Öffnen Sie die Eigenschaften einer Einzelsteuereinheit. 

2. Selektieren Sie die Registerkarte "Attribute > Automation Interface". 

3. Klicken Sie auf die Schaltfläche "Öffne Verknüpfungstabelle".

Design
Weiterführende Informationen zu diesem Thema finden Sie im Handbuch "COMOS Platform 
Administration", Stichwort "Verknüpfungstabelle konfigurieren".

Kontrollelement Beschreibung
Schaltfläche "In Vorlage über‐
nehmen"

Speichert die Zuordnungen in der Kopiervorlage des verwendeten 
Einzelsteuereinheitstyps

Spalte "Attribut" Attribut, in das die Information übertragen wird
Spalte "Beschreibung" Beschreibung des gesetzten Zielattributs
Spalte "Verknüpfungstyp" Um den Verknüpfungstyp zu ändern, doppelklicken Sie in diese 

Spalte und wählen Sie den gewünschten Typ in der Liste.
● "Statisch"

Bei einer statischen Verknüpfung wird der verknüpfte Wert nicht 
sofort verwendet. Sie lösen die Verwendung manuell aus. Eine 
statische Verknüpfung dient nur als Vergleichsbasis. Der Inhalt 
wird nicht übernommen.

● "Dynamisch"
Bei einer dynamischen Verknüpfung wird der Inhalt automatisch 
vom Quellobjekt ins Attribut übernommen. 

● "Voll dynamisch" (empfohlen)
Alle Eigenschaften der verknüpften Attribute werden 
automatisch in beide Richtungen übernommen. 

Spalte "Quellobjekt" Objekt, von dem die Information ausgelesen wird
Das Objekt kann wie folgt gesetzt werden:
● Per Drag&Drop aus dem Navigator
● Im Navigationsassistent

Siehe auch Kapitel Referenz zum Navigationsassistent 
(Seite 204).

Spalte "Eigenschaft" Enthält die Eigenschaft, die ausgelesen wird
Wenn erforderlich, doppelklicken Sie in diese Spalte und wählen Sie 
eine andere Eigenschaft in der Liste.

Spalte "Wert" Enthält eine Voransicht, welche Information übertragen wird

Siehe auch
Verknüpfungstabelle der Signalbezeichnungen konfigurieren (Seite 161)

Verknüpfungstabelle als Kopiervorlage übernehmen (Seite 164)

Referenz
21.4 Referenz zur Verknüpfungstabelle

Plant Automation Accelerator 3.0 SP1
Bedienhandbuch, 08/2019, A5E46351212-AB 203



21.5 Referenz zum Navigationsassistent
Wenn Sie die Position des Quellobjekts im Anlagenbaum nicht kennen, verwenden Sie den 
Navigationsassistenten. 

Weiterführende Informationen zu diesem Thema finden Sie im Handbuch "COMOS Platform 
Administration", Stichwort "Kontextmenü "Eigenschaften": Registerkarte "Objektberechnung"".

Siehe auch
Navigationsassistent verwenden (Seite 163)

21.6 Referenz Plugin "Typ-Konfigurator"

Menüleiste

Icon Tooltipp Beschreibung
"Aktualisieren“ Über diese Schaltfläche aktualisieren Sie die 

Ansicht im Plugin.
"Erzeuge Befehls- und Statusbiblio‐
thek"

Über diese Schaltfläche legen Sie initial die 
Befehls- und Statusbibliothek an. Siehe auch 
Kapitel Globale Befehls- und Statusbiblio‐
thek erzeugen (Seite 25).

"Funktionen" Über diese Schaltfläche blenden Sie die Liste 
aller standardmäßig verfügbaren Funktionen 
ein. Siehe auch Kapitel Funktionen erzeugen 
(Seite 28).

"Grafische Eigenschaften" Anpassen der Schrift auf Reports.

"Variantenübersicht" Zeigt unterschiedliche Varianten von CMT.

"Nachrichtensystem konfigurieren" Anpassen von Nachrichten / Meldungen

Referenz
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Spalte "Funktionen"
Wenn Sie in der Menüleiste auf die Schaltfläche "Funktionen" klicken, wird diese Spalte 
eingeblendet.

Icon Tooltipp Beschreibung
"Alle wählen" Über diese Schaltfläche selektieren Sie alle 

aufgelisteten Funktionen.
"Alle abwählen" Über diese Schaltfläche deselektieren Sie 

alle selektierten Funktionen.
"Funktionen generieren" Über diese Schaltfläche generieren Sie die 

selektierten Funktionen. Sie werden im Na‐
vigator im Knoten "@Template > @PCS 7 > 
Template-Container > Functions" angelegt 
und in der Spalte "Typen-Bibliothek" ange‐
zeigt.

Spalte "Typen-Bibliothek"

Icon Tooltipp Beschreibung
"Neues Objekt einfügen" Über diese Schaltfläche legen Sie neue Ein‐

zelsteuereinheitstypen, Aufzählungen und 
Funktionen an. Siehe auch Kapitel Einzel‐
steuereinheitstypen anlegen (Seite 31), Kapi‐
tel Globale Befehls- und Statusbibliothek er‐
zeugen (Seite 25), Kapitel Aufzählungstypen 
anlegen (Seite 61) und Kapitel Funktionen er‐
zeugen (Seite 28).

"Kopieren" Über diese Schaltfläche kopieren Sie den se‐
lektierten Typ in den Zwischenspeicher. Sie‐
he auch Kapitel Einzelsteuereinheitstypen 
anlegen (Seite 31).

"Einfügen" Über diese Schaltfläche fügen Sie den Typ 
aus dem Zwischenspeicher ein.

"Löschen" Über diese Schaltfläche löschen Sie den se‐
lektierten Typ. Siehe auch Kapitel Einzelsteu‐
ereinheitstypen anlegen (Seite 31).

"Filter" Über diese Schaltfläche filtern Sie die Anzei‐
ge der Spalte "Typ-Bibliothek". Aktivieren Sie 
die Schaltfläche für die Art von Typ, die Sie 
anzeigen möchten.

Referenz
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Spalte "Typ-Struktur"

Icon Tooltipp Beschreibung
"Alles aufklappen" Über diese Schaltfläche klappen Sie die gesamte unterlagerte 

Struktur des selektierten Typen auf.
"Alles zuklappen" Über diese Schaltfläche klappen Sie die gesamte unterlagerte 

Struktur des selektierten Typen zu.
"Kopieren" Über diese Schaltfläche kopieren Sie das selektierte Objekt in den 

Zwischenspeicher.
"Einfügen" Über diese Schaltfläche fügen Sie das in den Zwischenspeicher 

kopierte Objekt ein.
"Löschen" Über diese Schaltfläche löschen Sie das selektierte Objekt inklu‐

sive der unterlagerten Objekte. Wenn Sie den Typ selektieren, ist 
die Schaltfläche nicht aktiv.

"Schrittkette bearbeiten" Über diese Schaltfläche öffnen Sie die selektierte Schrittkette zum 
Bearbeiten auf dem Funktionsplan. Diese Schaltfläche ist nur ak‐
tiv, wenn Sie eine Initial Schrittkette selektiert haben.

Spalte "Typ-Attribute"

Icon Tooltipp Beschreibung
"Filter" Über diese Schaltfläche filtern Sie die Anzeige der unterlagerten Objekte 

des selektierten Typs.
"Neues Objekt 
einfügen"

Über diese Schaltfläche legen Sie massenhaft Merkmale an. Pro Klick wird 
ein Merkmal angelegt. Diese Schaltfläche ist aktiv, wenn Sie in der Spalte 
"Typ-Struktur" den Ordner eines Merkmals selektiert haben. 

Schaltflächen

Schaltfläche Beschreibung
"OK" Über diese Schaltfläche werden die angelegten EMTs gespeichert. Das Plugin "Typ Konfigurator" wird 

nach dem Betätigen geschlossen.
"Abbrechen" Änderungen, die in der Oberfläche gemacht wurden, werden nicht gespeichert und das Plugin "Typ Kon‐

figurator" wird nach dem Betätigen geschlossen.
"Übernehmen" Änderungen, die in der Oberfläche gemacht wurden werden gespeichert. Das Plugin "Typ Konfigurator" 

bleibt nach dem Betätigen geöffnet.

21.7 Referenz Plugin "Excel-Import"

Kontrollelement Beschreibung
Feld "Zielobjekt" In diesem Feld wird das Objekts des Navigators angezeigt, in dem die im‐

portierten Objekte gespeichert werden.
Schaltfläche "Excel-Datei" Mit dieser Schaltfläche wird die Datei mit der Signaliste ausgewählt. 
Schaltfläche "Bibliotheksdatei" Mit dieser Schaltfläche wird die Bibliotheksdatei (BPCMT_Lib_V1.0) ausge‐

wählt.

Referenz
21.7 Referenz Plugin "Excel-Import"
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Kontrollelement Beschreibung
Liste "Arbeitsblatt" Diese Liste zeigt an, welches Arbeitsblatt der Signalliste importiert wird.
Feld "Titelzeile" In diesem Feld wird der Titel (Name) der Spalten in der Excel-Datei zur aus‐

gewählten Zeile angezeigt.
Feld "Startzeile" Dieses Feld zeigt an, in welcher Zeile der Import der Signalliste beginnt.
Bereich "Spaltenzuordnung" In diesem Bereich wird die Baumstruktur verschiedener Objekte wie TH, CM, 

HW, Signal und Parameter angezeigt.
Option "In Arbeitsschicht importieren" Ist diese Option aktiviert, wird mit dem Import eine neue Arbeitsschicht an‐

gelegt.
Option "Zielstruktur für Signalplanung" Die aktivierte Option bewirkt, dass beim Import die CM Signale zu den I/O 

Kanälen implementiert werden.
Schaltfläche "Import" Über diese Schaltfläche starten Sie den Import.
Bereich "Filter" Im Filterbereich werden Fehler, Warnungen und Meldungen für die import‐

ierten Objekte angezeigt.

21.8 Auswahlliste "X01N00020 Assembly Updater 
Eigenschaftenzuordnung PCS 7"

Anwendungsbereich
Diese Liste enthält Attribute, die im Plugin "Baugruppen Updater" berücksichtigt und bei der 
Aktualisierung ausgeschlossen werden.

Knoten
Auswahllisten > Y10 > X01 > A10 > X01N00020 Assembly Updater Eigenschaftenzuordnung 
PCS 7 

Benutzerdefinierte Attribute, die nicht an der Instanz aktualisiert werden sollen
● Name (Abkürzung: @N)

● Label (Abkürzung: @L)

● Description (Abkürzung: @D)

● CDevice (Abkürzung: @C)

● MappingTableXML (Abkürzung: @M)

● BackpointerSpecificationsWithLinkObjectAndName (Abkürzung: @BS). Beispiel 
"@BS:Y00T00093.Y00A00159"

● Alle Attribute (wenn LinkOjects existieren, werden diese genommen, ansonsten Values). 
Beispiel "Y00T00093.Y00A00159"

Die Abkürzungen beziehen sich auf die VSUI Notation.

Referenz
21.8 Auswahlliste "X01N00020 Assembly Updater Eigenschaftenzuordnung PCS 7"
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Attribute, die niemals an der Instanz überschrieben werden
● Connector (ConnectedWith, Connector Attribute)

● Backpointer

● DocObjs

● Owner

● Unit

● Location

● Implementation

Aufbau

Spalte Beschreibung
"Name" In diese Spalte tragen Sie einen Namen nach folgendem 

Schema ein: A+ 3 Zahlen in Zehnerschritten hochgezählt. 
Zum Beispiel: "A010"
Standard: "A010"

"Beschreibung" In diese Spalte tragen Sie die Beschreibung des Objekts ein, 
dessen Attribute ausgewertet werden. Zum Beispiel: "Action"
Standard: "Default"

"Wert 1" In diese Spalte tragen Sie die hierarchische oder funktionale 
Klassifizierung des Stammobjekts ein. Benutzerklassifizie‐
rungen sind erlaubt. Zum Beispiel: "C1: M00.A010.A040"
Standards: "Default"

"Wert 2" Geben Sie die Attribute ein, die nicht an der Instanz über‐
schrieben werden sollen. Zum Beispiel: 
"@N;@L;@D;Y00T00001.Y00A03136"
Standard: "@N;@L;@D"

Das Plugin "Baugruppen aktualisieren" prüft zuerst, ob für das Objekt eine Klassifizierung in 
der Auswahlliste hinterlegt ist. Wenn das Plugin keine Klassifizierung findet, wird auf die 
Standarddefinition zurückgegriffen.

Referenz
21.8 Auswahlliste "X01N00020 Assembly Updater Eigenschaftenzuordnung PCS 7"
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Glossar

Abfragen
Abfragen suchen nach Objekten eines bestimmten Systemtyps. Das Suchergebnis wird in 
einem Objekt-Browser angezeigt.

Administrator
Der Administrator hat die höchste Sicherheitsstufe und somit alle Berechtigungen. Kritische 
Funktionen wie die Benutzerverwaltung oder Datenbankanpassungen sind nur 
Administratoren zugänglich.

Aggregierter CMT
Aggregierter Einzelsteuereinheitstyp

Alias-Bezeichnungen
Alternative Bezeichnungen, die in der Engineering-Ansicht festgelegt werden können.

Allgemeine Daten
Eigenschaften eines Objekts, die im Allgemeinen über einen langen Zeitraum konstant 
bleiben, z. B. der Name oder die Bezeichnung.

Anlage/Teilanlage
Gruppe funktional verbundener technischer Module und die oberste logische Gruppierung, die 
für den Benutzer im technischen Bereich wichtig ist. 

Anlagen sind hierarchisch strukturiert, was bedeutet, dass sie untergeordnete Anlagen haben 
oder zu einer übergeordneten Einheit wie einer Anlage oder einem Projekt gehören können. 
Anlagen werden in der Registerkarte gleichen Namens im Navigator in der Engineering-
Ansicht erstellt.

Anlagenbus
Die folgenden Komponenten kommunizieren auf dem Anlagenbus:  Server (OS, Route 
Control) und Automatisierungssysteme (AS) AS zu AS (SIMATIC-Verbindungen).

AS
Automatisierungssystem (AS), das aus Stromversorgung, CPU und einer 
Kommunikationsbaugruppe besteht.

Plant Automation Accelerator 3.0 SP1
Bedienhandbuch, 08/2019, A5E46351212-AB 209



Aufzählungen
Hierbei handelt es sich um einem bestimmten Parameter zugeordnete Werte.

Automation Interface
Das Automation Interface ist eine eigenständige, standardisierte Schnittstelle zum Austausch 
von Engineering-Daten. Die Oberfläche zum Automation Interface hat den Dialogtitel 
"Datentransfer – Generieren/Importieren".

Baugruppen Updater
Dies ist ein Plugin, mit dem die in PCS 7 oder im Plugin "Typ-Konfigurator" an einem CMT 
(Einzelsteuereinheitstyp) oder dessen Varianten vorgenommenen Änderungen aktualisiert 
werden.

Baustein
Ein Baustein dient zum gesammelten Erstellen mehrerer Elemente. Ein Stammobjekt mit der 
Erstellungsoption "Baustein" kann nicht als Planungsobjekt selbst erstellt werden. Es 
repräsentiert die einzelnen Elemente lediglich.

Bausteinvariablen
Bausteinvariablen sind die Attribute, die Bausteinen zusätzliche Eigenschaften zuweisen.

Benutzer
Im Gegensatz zum Administrator haben Benutzer nur begrenzte Zugriffsrechte.

Benutzerverwaltung
Bereich in PAA, in dem die Benutzerrechte festgelegt und die Arbeitsbereiche bestimmt 
werden.

Bezeichnung
Neben Namen sind Bezeichnungen das zweithäufigste Mittel zur eindeutigen Identifikation von 
Objekten.

Blockablaufdiagramm
Synonym für Blockfließbild (PFB). 

Berichtstyp in der FEED-Lösung für Verfahrenstechnik in einem zweidimensionalen Raum. 
Enthält eine Teilanlage und einen Bilanzstrom als seine Hauptkomponenten. Wegen seines 
maximalen Abstraktionsgrads befindet sich der PFB normalerweise zu Beginn der 
Verfahrenstechnik.
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BPCMT
Best Practice Einzelsteuereinheitstyp

CFU
Compact Field Unit = Kompaktfeldgerät

CIL
COMOS Integration Layer (PCS 7).

CM
Control Module = Einzelsteuereinheit

CMT
Control Module Type = Einzelsteuereinheitstyp 

CVS
Abkürzung für Cache Validation Service. 

Datenbanksynchronisation zur Gewährleistung, dass alle Kunden immer auf die neuesten 
Informationen in der COMOS-Datenbank zugreifen.

Datenaustausch
Der Datenaustausch ist der Vorgang des Datentransfers und der Datensynchronisation 
zwischen PAA und PCS 7. 

Datenbank
Die Datenbank enthält die vordefinierten Objekte und Komponenten. Während des 
Anlagenbaus werden sämtliche Engineering-Daten in der Datenbank gespeichert und 
verwaltet. 

Datentransfer
Dies ist der Vorgang für den Transfer von Daten zwischen PCS 7 und PAA. Die Daten können 
bidirektional übertragen und abgeglichen werden.

Dezentrale Peripherie
Die dezentrale Peripherie ist ein Pool von Geräten, aus dem Sie das erforderliche IO-Modul 
auswählen können.
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Direkter Datenaustausch:
Datenaustausch zwischen PAA und PCS 7, wenn PAA und PCS 7 beide auf demselben PC 
installiert sind.

Eigenschaften
Allgemeiner Begriff für sämtliche außerhalb eines Objekts sichtbaren Merkmale und 
Informationen. Die externen Beziehungen stellen eine Ausnahme dar. Sie werden in 
Sammlungen verwaltet.

EM
Equipment Module = Technische Einrichtung

EMT
Equipment Module Type = Technische Einrichtung (Typ)

Export
Kopieren der Projektdaten in eine andere Datenbank. Klicken Sie in der Projektverwaltung mit 
der rechten Maustaste auf ein Projekt und wählen Sie "Exportieren".

Funktionen
Begriff aus der MSR-Umgebung. Beschreibt die Mess- und Steuerfunktion und die 
Verarbeitungsfunktionen der relevanten Position. Der Begriff ist äquivalent zur "Messfunktion" 
im P&ID-Schema.

Funktionsbaustein
Logische Verknüpfungen zu Funktionsplänen, z. B. UND/ODER-Tore.

Funktionsplan
Ein Blockschaltbild, in dem die Signale über Funktionsbausteine logisch miteinander verknüpft 
und auf Steuereinheiten erstellt werden können.

Globale Datenreferenz
In COMOS erstellte Referenzen zum Verbinden von Einzelsteuereinheiten mit 
Datenbausteinen.

Globale Vorlagen
Globale Vorlagen befinden sich im Vorlagenzweig des Stammprojekts. 
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Globale Vorlagen können in allen Planungsprojekten verwendet werden, die mit dem 
Stammprojekt verknüpft sind.

GSD
General Station Description

GSDML
General Station Description Markup Language

Hardwarekonfigurations-Tool
Dies ist ein Plugin für die Konfiguration des WS Bundle. 

Kanalanforderung
Die Kanalanforderung dient dazu, das Signal mit dem Ein-/Ausgabekanal zu verknüpfen.

Knoten
Objekte sind in COMOS über eindeutige und vollständige Beziehungen verbunden. Die auf 
diese Weise gebildete Struktur wird gelegentlich als "Baum" oder "Netzwerk" bezeichnet. 
Wenn Sie die Datenstruktur als Netzwerk betrachten, sind die einzelnen Objekte die Knoten 
des Netzwerks.

Lokale Vorlagen
Lokale Vorlagen befinden sich im Vorlagenzweig eines Planungsprojekts. Sie sind nur im 
jeweiligen Planungsobjekt verfügbar.

Meldeklasse
Meldungen eines bestimmten Typs.

Meldungen
Ein Meldesystem dient dazu, sporadisch im Prozess auftretende Ereignisse über Meldungen 
an zentraler Stelle chronologisch zu signalisieren und zu archivieren. 

Messstelle
Die Messstelle ist ein ressourcenneutrales Objekt. Die Messstellt dient der Verbindung der 
PLC-Projektierwelt (STEP 7, CFC usw.) mit der OS-Projektierwelt (PCS 7 OS). Sie enthält 
Informationen über den Ort, an dem sie zur Laufzeit existiert (z. B. die Netzwerkadresse und 
den Speicherbereich im PLC) und auch Informationen über spezifische OS-relevante 
Eigenschaften. 
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Navigator
Der Navigator ist in COMOS das Fenster auf der linken Seite, das in drei Bereiche unterteilt ist: 

● Bereich zum Wechseln zwischen Projekten und Arbeitsschichten 

● Strukturbereich 

● Detailbereich 

Der Strukturbereich ist in mehrere Registerkarten unterteilt. Hier können Sie die Projektdaten 
in Objektbäumen verwalten.

Neuzuweisung von Typen
Dies ist ein Plugin für die Neuzuweisung von Einzelsteuereinheitstypen zu den 
Einzelsteuereinheiten.

Objekte
Daten sind stets in Objekte gekapselt.

Objektsymbol
Jedes Objekt hat ein Symbol. Es dient zum Anzeigen des Objekts im Navigator, in Abfragen 
oder in anderen Benutzeroberflächen.

Ort
Ort oder Einbauposition eines technischen Betriebsmittels. Gelegentlich ist auch die 
funktionale Zuordnung gemeint.

PAA
PCS 7 Plant Automation Accelerator

Planungsobjekt
Planungsobjekte werden von Stammobjekten abgeleitet und verkörpern ein konkretes Objekt 
im Planungsprozess. Planungsobjekte erben alle Eigenschaften ihres Stammobjekts und 
haben auch konkrete Informationen zu den besonderen Werten und charakteristischen 
Merkmalen der Stammdaten.

Planungsprojekt
Ein Planungsprojekt ist die Summe der technischen, logischen und sonstigen Daten, die 
während der konkreten Implementierung eines Projekts vom Benutzer eingegeben werden. 
Ein Projekt bildet die oberste logische Gruppierung, die ein Benutzer zum Erreichen der Ziele 
für praktisch hält.
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Plugin
Eine geschlossene funktionale Komponente, die getrennt geladen oder ersetzt werden kann. 
Plugins werden in COMOS über die Menüleiste "Plugins" gestartet. Diese Technologie steht für 
funktionale Komponenten zur Verfügung, die häufig ersetzt werden müssen.

Projekt
PAA arbeitet projektbasiert, was bedeutet, dass alle Daten in Projekten verwaltet werden. 
Jedes Projekt ist ein unabhängiges Objekt, das viele ↗Eigentümersammlungen hat, die die zu 
diesem Projekt gehörenden Planungsobjekte und Dokumente enthält.

Register
Registerkarten sortieren Informationen. Um Sie anzuzeigen, klicken Sie mit der Maus auf das 
Register.

Registerkarte "Attribut"
Attribute können mit Hilfe der Registerkarte "Attribute" erfasst und sortiert werden.

Rolle
Eine Rolle umfasst unterschiedliche Rechte. Wenn einem Benutzer eine Rolle zugeordnet 
wird, gelten diese Rechte für den Benutzer.

Sammlung
Beschreibt sämtliche Beziehungen eines Objekts zu anderen Objekten. Beispielsweise 
können Sie über eine Sammlung abfragen, welche Planungsobjekte sich auf ein bestimmtes 
Stammobjekt beziehen oder welche Steckverbinder verfügbar sind und wie diese zugeordnet 
sind. Eine Sammlung ist ein sortierter Satz von Objekten, die mit einer einheitlichen Syntax 
adressiert werden können.

SFC
Ein SFC repräsentiert eine Ablaufsteuerung, die als eigenständige Steuerung im 
Automatisierungssystem abläuft. Im SFC existiert neben dem Objekttyp "SFC-Plan" auch der 
Objekttyp "SFC-Typ".

Signal
Ein Signal bezeichnet die Informationseinheit, die in Funktionsplänen oder Signalflussplänen 
weiter verarbeitet wird, z. B. "EIN" oder "AUS". Es stellt den Eingang und Ausgang der 
Steuerungstechnologie dar.
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Stammobjekt
Stammobjekte sind die grundlegenden Beschreibungen von Geräten, Prozeduren und Plänen. 
Sie beschreiben nicht nur die technischen Eigenschaften, sondern enthalten außerdem 
verwaltungsrelevante, prozedurspezifische und kostenbezogene Informationen. 
Stammobjekte bilden die Basis für das Prototyping.

Stammprojekt
Ein Stammprojekt ist ein Basisprojekt, das als Bibliothek für Engineering-Projekte dient, indem 
es die Stammobjekte bereitstellt. Aufgrund der in ihnen vorbereiteten Eigenschaften und 
Informationen bilden Stammobjekte die standardisierten Prototypen für Planungsobjekte.

Sub-CM
Unterlagerte Einzelsteuereinheit

Symbole
Symbole sind individuelle, grafische Darstellungen von Objekten in Berichten. Ein Objekt kann 
für verschiedene Diagrammtypen verschiedene Symbole haben.

Symbolische Adresse
Eine symbolische Adresse ist ein symbolischer Name mit dem folgenden besonderen 
Merkmal: Eine symbolische Adresse ist von der Technologischen Hierarchie abgeleitet und ist 
somit von der Hardware abhängig.

Symbolischer Name
Ein symbolischer Name ist ein Platzhalter für eine eindeutige Benennung, die zu einem 
späteren Zeitpunkt beispielsweise einer Adresse zugeordnet werden soll. Symbolische Namen 
sind häufig beschreibend.

Symbolleiste
Eine Anzahl von Schaltflächen, mit denen Funktionen gestartet werden können, die auch über 
ein Menü aufgerufen werden könnten.

Terminalbus
Über den Terminalbus kommunizieren folgende Komponenten: Server/Clients (OS, BATCH, 
Route Control) und die Engineering Station (ES).

TH
Die Technologische Hierarchie definiert den logischen Ablauf einer Anlage.
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Typkonfigurator
Dies ist ein Plugin für die Bearbeitung von Bibliotheken, Strukturen und auch zur Festlegung 
von Attributen.

Verbindungen
Planungsobjekte sind über Steckverbinder miteinander verschaltet. 

Es gibt zwei Arten von Verbindungen: 

● Verbindungen ohne Objekte 

● Objektbasierte Verbindungen

Verbindungsmanager
Dies ist ein Plugin, um großen Mengen von Verbindungen oder Referenzen zu erstellen.

Verriegelungslogik
Die Verriegelungslogik ist die Logik, die für eine Funktion verwendet wird, die den Zustand von 
zwei Mechanismen oder Funktionen voneinander abhängig macht.
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